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Preface

This guide describes how to install and configure Oracle Utilities Extractors and Schema and 
Oracle Utilities Analytics Dashboards v2.5.1, including:

• Audience

• Prerequisite Knowledge

• Related Documents

• Conventions

• Acronyms

Audience
This guide is intended for anyone interested in the process of installing, upgrading, or configuring 
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards v2.5.1.

Prerequisite Knowledge
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards use several 
technologies. You should have knowledge of the following before configuring and administering 
Oracle Utilities Analytics:

• Oracle Data Warehouse concepts:

http://docs.oracle.com/cd/E11882_01/server.112/e25554/toc.htm

• Oracle Warehouse Builder:

http://docs.oracle.com/cd/E11882_01/owb.112/e10581/toc.htm

• Oracle Data Integrator:

http://docs.oracle.com/cd/E21764_01/integrate.1111/e12641/overview.htm

• Oracle GoldenGate:

http://docs.oracle.com/cd/E35209_01/doc.1121/e29397.pdf

• Oracle WebLogic Server:

http://docs.oracle.com/cd/E15051_01/wls/docs103/pdf.html

• Oracle Business Intelligence Enterprise Edition:

http://docs.oracle.com/cd/E28280_01/bi.1111/e10544/toc.htm
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Related Documents
For more information, refer to the following documents in the Oracle Utilities Analytics 
documentation library:

• Oracle Utilities Analytics User's Guide

• Oracle Utilities Analytics Administration Guide

• Oracle Utilities Analytics Quick Install Guide

• Oracle Utilities Analytics Release Notes

• Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics, and 
Credit & Collections Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Distribution Analytics and Outage Analytics 
Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Work and Asset Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Operational Device Analytics Metric Reference 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping 
Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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Acronyms
The list of acronyms used in this guide is as explained below: 

• APEX: Oracle Application Express

• CC&B: Oracle Utilities Customer Care and Billing

• CDC: Changed Data Capture 

• ELT: Extraction, Loading and Transformation

• ETL: Extraction, Transformation, and Loading

• MDM: Oracle Utilities Meter Data Management

• MWM: Oracle Utilities Mobile Workforce Management

• NMS: Oracle Utilities Network Management System

• OBIEE: Oracle Business Intelligence Enterprise Edition

• ODI: Oracle Data Integrator

• ODM: Oracle Utilities Operational Device Management

• OGG: Oracle GoldenGate

• OUA: Oracle Utilities Analytics

• OWB: Oracle Warehouse Builder

• WAM: Oracle Utilities Work and Asset Management
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Chapter 1 
 Introduction 

This chapter provides an overview of the installation of Oracle Utilities Analytics. This includes: 

• About Oracle Utilities Extractors and Schema and Oracle Utilities Analytics 
Dashboards

• About Oracle Utilities Analytics Installation

• What’s New in Oracle Utilities Analytics v2.5.1

About Oracle Utilities Extractors and Schema and Oracle Utilities 
Analytics Dashboards

Oracle Utilities Extractors and Schema provides out of the box extraction and transformation, 
and loads data from the source application to the data warehouse. Oracle Warehouse Builder is 
used to validate and load the data to the data warehouse. 

The extraction, transformation and load processes have started to move to Oracle GoldenGate 
(OGG) and Oracle Data Integrator (ODI) in the last few releases. Over the next few releases, all 
the old extractors will move from Oracle Warehouse Builder to Oracle Data Integrator.

As of now, the following products support Oracle GoldenGate and Oracle Data Integrator based 
Extract, Load and Transform (ELT):

• Oracle Utilities Network Management System (NMS)

• Oracle Utilities Customer Care & Billing (CCB)

• Oracle Utilities Operational Device Management (ODM)

The following products use Oracle Warehouse Builder based Extract, Transform and Load 
(ETL):

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

Oracle Utilities Analytics Dashboards provides out of the box reports based on Oracle Business 
Intelligence Enterprise Edition.

Note: Refer to Oracle Utilities Analytics Metric Reference Guides for comprehensive 
list of all the reports.

This guide helps you install, upgrade, configure Oracle Utilities Extractors and Schema and Oracle 
Utilities Analytics Dashboards. Unless otherwise stated, this guide refers to these two products 
together as Oracle Utilities Analytics. If any topic is specific to only one of the products, then it 
would be specifically mentioned.
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About Oracle Utilities Analytics Installation
The installation of Oracle Utilities Analytics v2.5.1 is a full installation of Oracle Utilities Analytics 
product. This means that you do not need to install any previous version Oracle Utilities Analytics 
before installing Oracle Utilities Analytics v2.5.1.

Oracle Utilities Analytics (OUA) v2.5.1 installation consists of the following components, each of 
which needs to be installed for a successful installation:

• Star schema definitions

• Extract, Load and Transform (ELT) process built on Oracle Data Integrator

Note: Oracle Utilities Network Management System, Oracle Utilities 
Operational Device Management and Oracle Utilities Customer Care and 
Billing source applications support Oracle Data Integrator based ELT 
component. 

Note: Oracle GoldenGate is utilized to capture the data and this is required 
only for Oracle Data Integrator based ELT.

• Extract, Transform and Load (ETL) process built on Oracle Warehouse Builder (OWB)

Note: Oracle Utilities Work and Asset Management, Oracle Utilities Meter 
Data Management and Oracle Utilities Mobile Workforce Management source 
applications support Oracle Warehouse Builder based ETL component.

• Pre-built analytics' dashboards based on Oracle Business Intelligence Enterprise Edition 
(OBIEE)

• Admin Tool (required for Oracle Data Integrator based ELT).

What’s New in Oracle Utilities Analytics v2.5.1
Oracle Utilities Analytics is a set of star schemas, graphic templates, and data processing programs 
that allows you to build a Business Intelligence (BI) solution to meet your organization's analytic 
requirements.

The product has started the process of migrating from Oracle Warehouse Builder based ETL to 
Oracle Data Integrator based ELT in the last few releases. This migration is planned in a phased 
manner, spanning across several releases over a period of time. During this migration cycle, ETL 
for some of the source applications will continue to use Oracle Warehouse Builder, while others 
will use Oracle Data Integrator.

In the release v2.5.1, Oracle Utilities Network Management System source application will start 
using Oracle Data Integrator (ODI) based ELT. Earlier only Oracle Utilities Operational Device 
Management and Oracle Utilities Customer Care and Billing source applications used to support 
Oracle Data Integrator based ELT component.

Note: For information about the new and enhanced products, see Oracle 
Utilities Analytics Release Notes.

Visit My Oracle Support (http://support.oracle.com) for the most recent 
service packs and patches for this release to ensure you have the most current 
version of this product.
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Chapter 2 
Installation Overview

This chapter gives a detailed overview of Oracle Utilities Analytics installation. It includes the 
following sections:

• Application Architecture

• Installation Types

• Installation Components

• Installation Scenarios

• Media Pack Components

• Supported Source Application Versions
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Application Architecture
The following diagram shows the architecture of the Oracle Utilities Analytics product when using 
Extract, Transform and Load (ETL) based on Oracle Warehouse Builder.

Note: Applicable only if you have installed Oracle Utilities Work and Asset 
Management, Oracle Utilities Mobile Workforce Management, or Oracle 
Utilities Meter Data Management.

The following diagram shows the architecture of the Oracle Utilities Analytics product when using 
Extract, Load and Transform (ELT) based on Oracle Data Integrator.

Note: Applicable only if you have installed Oracle Utilities Network 
Management System, Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing..
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Installation Types
The first step in the installation procedure is to determine the installation type based on the 
installation scenario. The following are the possible installation types:

• Initial Installation, an installation from scratch

• Upgrade, an upgrade from an earlier version to Oracle Utilities Analytics v2.5.1

• Demo Installation, an installation with pre-populated demo data

The following sections describe each of these installations in the detail. 

Initial Installation
This installation type is applicable when installing Oracle Utilities Analytics for the first time, or 
from scratch. Each of the following components should be installed during an initial installation: 

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator  
(applicable only if you have installed Oracle Utilities Network Management System, Oracle 
Utilities Operational Device Management, or Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder  
(applicable only if you have installed Oracle Utilities Work and Asset Management, Oracle 
Utilities Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Admin Tool component 
(applicable only if you use Oracle Data Integrator based ELT).

Note: Refer to the chapter 5 “Oracle Utilities Analytics Initial Installation” 
for the steps involved in installing each of the above-mentioned components.

Upgrade
This installation type is applicable when upgrading to Oracle Utilities Analytics v2.5.1 from an 
earlier version.

Note: Refer to the section Supported Upgrade Paths of the Chapter 6: 
Upgrading Oracle Utilities Analytics to find out how upgrade of your 
particular version is supported.

Each of the following components should be installed during an upgrade installation.

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator  
(applicable only if you have installed Oracle Utilities Network Management System, Oracle 
Utilities Operational Device Management, or Oracle Utilities Customer Care and Billing).

• Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
(applicable only if you have installed Oracle Utilities Work and Asset Management, Oracle 
Utilities Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Admin Tool component 
(applicable only if you use Oracle Data Integrator based ELT).

Note: Refer to the Chapter 6: Upgrading Oracle Utilities Analytics for the 
steps involved in upgrading each of the required components.
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Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Analytics Dashboards for demonstration, or training purposes. The following 
components should be installed for a demo installation:

• Oracle Utilities Analytics Demo Database component

• Oracle Utilities Analytics Dashboard components

Note: Oracle Utilities Analytics Dashboards also include the demo database 
with the pre-populated data that can be used for training or demonstration 
purposes. Refer to the Chapter 7: Demo Installation Procedure for the steps 
involved in installing each of the required components.

Installation Components
The Oracle Utilities Extractors and Schema v2.5.1 product installation consists of the following 
components:

Note: Each of the components listed below has to be installed to complete the 
Oracle Utilities Analytics installation.

• Oracle Utilities Analytics Database component containing star schemas and product 
metadata

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator (ODI)

Note: Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator should be installed on a database server. This installation is required 
only if you are installing Oracle Utilities Operational Device Extractor and 
Schema, Oracle Utilities Customer Care and Billing Extractor and Schema, or 
Oracle Utilities Network Management Extractor and Schema.

Note: Oracle GoldenGate (OGG) is utilized to capture the data and this is 
required only for Oracle Data Integrator based ELT.

• Oracle Utilities Analytics ETL components based on Oracle Warehouse Builder

Note: Oracle Utilities Analytics ETL component based on Oracle Warehouse 
Builder should be installed on a database server. This is applicable if you have 
installed extractor and schema for edge application products other than Oracle 
Utilities Network Management System, Oracle Utilities Operational Device 
Management and Oracle Utilities Customer Care and Billing.

• Oracle Utilities Analytics Admin Tool component installation

• Oracle Utilities Analytics Dashboard component and answers based on Oracle Business 
Intelligence Enterprise Edition

Note: Oracle Utilities Analytics Dashboard component should be installed on 
the server where Oracle Business Intelligence Enterprise Edition is installed.

Oracle Utilities Analytics Dashboards also include the demo database with the pre-populated 
data that can be used for training or demonstration purposes. Refer to the Chapter 7: Demo 
Installation Procedure for steps involved in installing each of the required components. 
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Installation Scenarios 
The following installation scenarios are discussed with the respective flow chart diagrams:

• Installation Scenario 1: Oracle Warehouse Builder based on ETL

In this scenario, the initial installation of ETL component is based on Oracle Warehouse 
Builder. This is supported for the following source applications:

• Oracle Utilities Work and Asset Management (WAM)

• Oracle Utilities Meter Data Management (MDM)

• Oracle Utilities Mobile Workforce Management (MWM)

• Installation Scenario 2: Oracle Data Integrator based on ELT

In this scenario, the initial installation of ELT component is based on Oracle Data Integrator 
and Oracle GoldenGate. This is supported for the following source applications:

• Oracle Utilities Network Management System (NMS)

• Oracle Utilities Operational Device Management (ODM)

• Oracle Utilities Customer Care and Billing (CC&B)

• Installation Scenario 3: ETL based on Oracle Warehouse Builder and Oracle Data 
Integrator: 

Both Oracle Warehouse Builder based ETL and Oracle Data Integrator based ELT are 
needed. This scenario is applicable when you have edge applications from both the scenarios 
mentioned above. 

• Installation Scenario 4: Upgrade

This scenario is applicable to the users who are upgrading to Oracle Utilities Analytics v2.5.1 
from an earlier released version. 

Note: See Media Pack Components for the list of components comprising 
the Oracle Utilities Analytics product. 

Note: See Supported Source Application Versions for the supported source 
application versions. 

Note: See the section Prerequisite Software of the Chapter 4: Planning the 
Oracle Utilities Analytics Installation for the list of prerequisite software 
necessary for installing each component.

Installation Scenario 1: Oracle Warehouse Builder based on ETL
This scenario provides an overview of the installation steps required if you are installing products 
those use Oracle Warehouse Builder based ETL: 

• Oracle Utilities Work and Asset Management 

• Oracle Utilities Meter Data Management 

• Oracle Utilities Mobile Workforce Management

If you are using any other edge applications, refer to the installation scenario 2 or 3, as the case 
may be.
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The following diagram shows the workflow for the initial installation for ETL components based 
on Oracle Warehouse Builder:
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Installation Scenario 2: Oracle Data Integrator based on ELT
This scenario provides an overview of the installation steps required if you are installing products 
those use Oracle Data Integrator based ELT: 

• Oracle Utilities Network Management System 

• Oracle Utilities Operational Device Management 

• Oracle Utilities Customer Care and Billing 

If you are using any other edge applications, refer to installation scenario 1 or 3, as the case may 
be.
Installation Overview 2-9 
Oracle Utilities Analytics Installation Guide



The following diagram shows the workflow for the initial installation process for the ELT 
component based on Oracle Data Integrator:
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Installation Scenario 3: ETL based on Oracle Warehouse Builder 
and Oracle Data Integrator
This scenario provides an overview of the installation steps required if you are installing ETL for 
the combination of edge applications mentioned in installation scenario 1 and 2, i.e., one or more 
edge applications from: 

• Oracle Utilities Work and Asset Management 

• Oracle Utilities Meter Data Management 

• Oracle Utilities Mobile Workforce Management 

As well as one or more from:

• Oracle Utilities Network Management System 

• Oracle Utilities Operational Device Management 

• Oracle Utilities Customer Care and Billing 
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The following diagram shows workflow for the initial installation process for the ETL 
components based on Oracle Warehouse Builder as well as Oracle Data Integrator:
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Installation Scenario 4: Upgrade 
This installation type is for the users who are upgrading from an earlier version of Oracle Utilities 
Analytics to Oracle Utilities Analytics v2.5.1. 

The following diagram shows the workflow for the upgrade process:

Media Pack Components
Oracle Utilities Analytics v2.5.1 media pack consists of the following documentation and 
installation packages:

Documentation Packages
• Oracle Utilities Analytics v2.5.1 Release Notes

• Oracle Utilities Analytics v2.5.1 Quick Install Guide

• Oracle Utilities Analytics v2.5.1 Installation Guide and Configuration Guide

• Oracle Utilities Analytics v2.5.1 User's Guide
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Installation Packages
• Oracle Utilities Analytics v2.5.1 Dashboard Component Multiplatform

• Oracle Utilities Analytics v2.5.1 ETL Component Based on OWB Multiplatform

• Oracle Utilities Analytics v2.5.1 ETL Component Based on ODI Multiplatform

• Oracle Utilities Analytics v2.5.1 Oracle Database Multiplatform

• Oracle Utilities Analytics v2.5.1 Demo Data

Supported Source Application Versions
The following are the supported source application versions: 

Source Application Version

Oracle Utilities Customer Care and Billing 2.4.0.2

Oracle Utilities Network Management System 1.12.0.1

Oracle Utilities Work and Asset Management 1.9.1.2

Oracle Utilities Meter Data Management 2.0.1.9
2.1.0.2

Oracle Utilities Mobile Workforce Management 2.1.0.5
2.2.0.0

Oracle Utilities Operational Device Management 2.0.1.2
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Chapter 3
System Requirements and Supported Platforms

This section gives an overview of the tiers on which the product is implemented and shows each 
of the operating system/server combinations that the product is supported for. It includes:

• Operating Systems and Application Servers

• Additional Notes on the Supported Platforms

Operating Systems and Application Servers
Oracle Utilities Analytics v2.5.1 installation is supported to operate on many operating system, 
application server, and database server combinations.

The following table details the minimum versions of the browser, operating system, and 
application server combinations on which Oracle Utilities Analytics v2.5.1 has been tested and 
supported: 

Browser
Operating 

System 
(Client)

Operating System
(Server) Chipset

Application 
Server

Oracle 
Business 

Intelligence 
Enterprise 

Edition 
(OBIEE)

Oracle 
Data 

Integrator 
(ODI)

Oracle 
GoldenGate Database

IE 9.x 

Firefox 24.5ESR+
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Important Note: Every new release of Oracle Utilities Analytics is tested 
against the latest versions of the required software, such as Oracle Business 
Intelligence Enterprise Edition, Oracle Data Integrator, Oracle GoldenGate, 
etc. However, any fourth digit change in these software versions is generally 
backward compatible, and is supported by the product. 

Important Note: Oracle Utilities Analytics supports Oracle Data Integrator 
based ELT from the source database on 11g to the target database on 11g and 
the source database on 12c to the target database on 12c. It means that the 
source database and the target database versions must match.

Important Note: The patch 19152142 needs to be installed on top of Oracle 
GoldenGate v12.1.2.0.0 if the target database server is on the version 11.2.0.3 
and the patch 19152124 needs to be installed on top of Oracle GoldenGate 
v12.1.2.0.0 if the target database server is on the version 12.1.0.1.0. Installing 
these patches is mandatory for Oracle Utilities Analytics v2.5.1. These patches 
are only needed for the Oracle GoldenGate installation on the target server. 
These patches should NOT be installed on the Oracle GoldenGate installation 
on the source server.

Important Note: Oracle Warehouse Builder is installed as a part of Oracle 
Database Enterprise Edition Server 11.2.0.3. If you are using Oracle Database 
Enterprise Edition Server 12.1.0.1.0, standalone software for Oracle 
Warehouse Builder should be installed separately.

Important Note: The patch 16568042 needs to be installed on top of the 
standalone installation of Oracle Warehouse Builder in order to use Oracle 
Warehouse Builder software with Oracle Database Server 12.1.0.1.0.

Important Note: Oracle Warehouse Builder based ETL is not supported on 
Solaris and AIX operating systems with Oracle Database Server 12.1.0.1.0.

You must have the following software listed out below:

• Oracle Business Intelligence Enterprise Edition (OBIEE) is required for Oracle Utilities 
Analytics Dashboards. 

• Oracle Data Integrator, Oracle GoldenGate, Oracle WebLogic and Oracle Application 
Express are required for Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator. 

Additional Notes on the Supported Platforms
The following topics are discussed in this section: 

• Oracle Unbreakable Enterprise Kernel

• Oracle Database Server

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle Unbreakable Enterprise Kernel
Oracle Utilities Analytics v2.5.1 is supported on Oracle Unbreakable Enterprise Kernel.
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Oracle Database Server 
Oracle Utilities Analytics v2.5.1 is supported on Oracle Database Enterprise Edition Server 
11.2.0.3 /or 12.1.0.1.0 on any of the operating systems listed above.

Note: Oracle Utilities Analytics version v2.5.1 is supported on Oracle 
Database Server Standard Edition 11.2.0.3 /or 12.1.0.1.0 only when using 
ELT component based on Oracle Data Integrator.

Oracle VM Support
Oracle Utilities Analytics v2.5.1 is supported on Oracle VM Server for x86 2.2.2 for the supported 
releases of Oracle Linux and Microsoft Windows operating systems.

Oracle Support Policy on VMWare
Refer to the knowledge base article ID 249212.1 on My Oracle Support for Oracle's support 
policy on VMWare.

https://support.oracle.com
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Chapter 4 
Planning the Oracle Utilities Analytics 

Installation

This chapter provides information about planning Oracle Utilities Analytics (OUA) installation 
v2.5.1, including:

• Prerequisite Software

• Installation Checklist

Note: In order to perform successful installation of the product, you must have 
experience of working on, or installing the following products:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Warehouse Builder

• Oracle Data Integrator

• Oracle GoldenGate

• Oracle Application Express feature of Oracle database

Note: Refer to the corresponding installation guide of these products before 
installing Oracle Utilities Analytics.

Prerequisite Software
For installing Oracle Utilities Analytics v2.5.1, a few prerequisite software products need to be 
downloaded and installed. Download and install these software products as per the instructions 
provided in the respective installation documents.

Note: Ensure that the same Operating System (OS) user is used to install all 
software prerequisites and Oracle Utilities Analytics components.

The following sections describe the prerequisite software requirement Oracle Utilities Analytics:

• Prerequisite Software for Oracle Utilities Analytics Database Component

• Prerequisite Software for Oracle Utilities Analytics ELT Component based on Oracle 
Data Integrator

• Prerequisite Software for Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder

• Prerequisite Software for Oracle Utilities Analytics Dashboard Component

• Prerequisite Software for Oracle Utilities Analytics Admin Tool Component
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Prerequisite Software for Oracle Utilities Analytics Database Component
The prerequisite software for Oracle Utilities Analytics database component is as described below:

• Oracle Database Server Enterprise Edition 11.2.0.3 / or 12.1.0.1.0: This is required for 
installing the database component of the Oracle Utilities Analytics

Note: Oracle Utilities Analytics v2.5.1 is supported on Oracle Database 
Server Standard Edition 11.2.0.3 / or 12.1.0.1.0 only when using ELT 
component based on Oracle Data Integrator.

Prerequisite Software for Oracle Utilities Analytics ELT Component based on 
Oracle Data Integrator

Note: Applicable only if you have installed Oracle Utilities Network 
Management System, Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing.

The prerequisite software products for Oracle Utilities Analytics ELT component based on Oracle 
Data Integrator (ODI) are listed below. These software products should be installed on the 
database server:

•  JDK 1.6.0 (20 -35)

• Oracle Database Server Enterprise Edition 12.1.0.1.0/or 11.2.0.3, or Oracle Database Server 
Standard Edition 12.1.0.1.0/ or 11.2.0.3

• Oracle WebLogic 10.3.6

• Oracle Data Integrator 11.1.1.6 with Java EE

Note: While installing Oracle Data Integrator, do not create any repositories. 
Select Skip Repository Configuration option.

Note: While installing Oracle Data Integrator, select the Developer 
Installation and Java EE Installation options in the Select Installation 
Type step.

• Oracle GoldenGate 12.1.2.0.0 on the source application database server and the target 
database server  
This can be downloaded from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com).

Prerequisite Software for Oracle Utilities Analytics ETL Component based on 
Oracle Warehouse Builder

Note: Applicable only if you have installed any one of the edge applications 
,such as Oracle Utilities Work and Asset Management, Oracle Utilities Mobile 
Workforce Management, or Oracle Utilities Meter Data Management.

The prerequisite software products for Oracle Utilities Analytics ETL based on Oracle Warehouse 
Builder component are as follows:

• JDK 1.6.0 (20-35) is required for running the File Processor daemon

• Oracle Database Server Enterprise Edition 11.2.0.3 with Oracle Warehouse Builder 11.2.0.3 
or Oracle Database Server Enterprise Edition 12.1.0.1.0 with standalone Oracle Warehouse 
Builder installation. The patch 16568042 needs to be installed on top of the standalone 
installation of Oracle Warehouse Builder in order to use Oracle Warehouse Builder software 
with Oracle Database Server 12.1.0.1.0.
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Prerequisite Software for Oracle Utilities Analytics Dashboard Component
The prerequisite software for Oracle Utilities Analytics Dashboard component is as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 with the Enterprise Install 
option.

Note: Install the Oracle 11.2.0.3 / or 12.1.0.1.0 client if Oracle Business 
Intelligence Enterprise Edition software is not installed on the database 
server. If Oracle Business Intelligence Enterprise Edition software is 
installed, then there is no need to install the Oracle client.

Note: After Oracle Business Intelligence Enterprise Edition installation, save a 
snapshot of the last page of Oracle Business Intelligence Enterprise Edition 
installation having details of BI Oracle Home, Instance Home, etc. These 
values will be used during the Oracle Utilities Analytics installation.

Prerequisite Software for Oracle Utilities Analytics Admin Tool Component
Note: Applicable only if you use Oracle Data Integrator based ELT.

The prerequisite software products for the Oracle Utilities Analytics Admin Tool component are 
as follows:

• Oracle Database Server Enterprise Edition 12.1.0.1.0 /or 11.2.0.3 or Oracle Database Server 
Standard Edition 12.1.0.1.0 /or 11.2.0.3

• Oracle Apex 4.2.5

Installation Checklist
The following checklist guides you through the installation process for Oracle Utilities Analytics 
v2.5.1:

The details are provided in subsequent chapters for each of the below-listed step: 

1. Determine the installation type and the installation scenario. See Media Pack Components 
to determine the installation type for your scenario. Perform the installation steps as 
applicable to your installation type.

2. Install the prerequisite software.  
See Prerequisite Software for more details.

3. Ensure that you have downloaded the Oracle Utilities Analytics components.

Note: Refer to the chapter Oracle Utilities Analytics Initial Installation for 
instructions regarding initial installation.

Note: For upgrading from an earlier version of Oracle Utilities Analytics to 
Oracle Utilities Analytics v2.5.1, refer to the chapter Upgrading Oracle 
Utilities Analytics.

Note: Refer to Demo Installation Procedure for instructions about demo 
installation. 

4. Perform the post-installation tasks and configure the application. 
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Chapter 5 
Oracle Utilities Analytics Initial Installation

This chapter provides instructions for installing Oracle Utilities Analytics v2.5.1. It includes the 
following topics: 

• Initial Installation Procedure

Note: In order to install the product successfully, it is recommended that you 
have prior experience of working on it or installing it:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Warehouse Builder

• Oracle Data Integrator

• Oracle GoldenGate

• Application Express feature of Oracle database

Note: Refer to the respective installation guide of these products before 
installing Oracle Utilities Analytics.

Initial Installation Procedure
The following topics are discussed in this section: 

• Installing Oracle Utilities Analytics Database Component

• Installing Oracle Utilities Analytics ELT Component Installation based on Oracle 
Data Integrator  
(applicable only if you have installed Oracle Utilities Network Management System, Oracle 
Utilities Operational Device Management, or Oracle Utilities Customer Care and Billing).

• Installing Oracle Utilities Analytics ETL Component based on Oracle Warehouse 
Builder 
(applicable only if you have installed Oracle Utilities Work and Asset Management, Oracle 
Utilities Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Installing Oracle Utilities Analytics Dashboard Component

• Installing the Oracle Utilities Analytics Admin Tool 
(applicable only if you use Oracle Data Integrator based ELT).
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Installing Oracle Utilities Analytics Database Component
This section describes how to install the database component of Oracle Utilities Analytics v2.5.1. 
It includes the following topics:

• Copying and Decompressing the Install Media

• Creating the Database

• Creating the Users and the Tablespaces

• Installing the RELADM Schema

• Installing the MDADM Schema

• Installing the DWADM Schema

• Configuring the Spatial Data

Copying and Decompressing the Install Media
To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.5.1 Oracle Database part (Oracle Utilities 
Analytics V2.5.1 Oracle Database Multiplatform.zip) from the Oracle Software Delivery 
Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.1Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUA-V2.5.1-Database-Multiplatform.zip using any zip 
utility.

Creating the Database
Ensure that Oracle Database Server Enterprise Edition 12.1.0.1.0 /11.2.0.3 is already installed on 
the machine in order to create the database. Use the Database Configuration Assistant 
(DBCA) utility to create the database. 

Note: Refer to Oracle database documentation to know more about the 
Database Configuration Assistant (DBCA).

For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant to create a database with the AL32UTF8 character set. Set the open 
cursor limit to 3000 and processes to 1000 at the time of the database creation.

Creating the Users and the Tablespaces
Perform the following steps for creating the required users and the tablespaces:

1. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

2. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

3. Connect to the sys user, execute the Usersgrants.sql in BI251/Scripts/Usersgrants.sql. 
This SQL provides the required grants to the users created above.
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Installing the RELADM Schema 
The RELADM schema is a metadata schema that consists of the database objects used for storing 
the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide the value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI251\RELADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that Oracle database server uses to access a table or 
to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the RELADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in the Storage.par file to tablespace name on which 
RELADM has quota.

Installation Steps
Perform the following steps to install the RELADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 11.2.0.3 +32 bit client and the Java Development 
Kit Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the 
Oracle client is updated with the entry for the target database to connect to the 
target database.

1. Run the CDXDBI.exe from ..\BI251\RELADM\Install-Upgrade. Run the utility from the 
command prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.

• The password for the system user account in the database (in silent mode).
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• The name of the owner of the database schema: RELADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI251\RELADM\Jarfiles>.

• The password for the user (in silent mode): <RELADM user password>.

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including: 

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide value: MDADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package).

• Java Home (for example: C:\Java\jdk1.6.0_20).
Oracle Utilities Analytics Initial Installation 5-24 
Oracle Utilities Analytics Installation Guide



Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI251\MDADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If the database does not have CISTS_01 tablespace or the 
MDADM user does not have quota on CISTS_01 tablespace, you must 
edit the tablespace name in the Storage.par file to the tablespace name 
on which the MDADM has quota.

Installation Steps
Perform the following steps to install the MDADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 11.2.0.3 + 32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

1. Run the CDXDBI.exe from ..\BI251\MDADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database:<DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: MDADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI251\MDADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
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Installing the DWADM Schema 
The DWADM schema contains the star schema objects such as facts and dimensions that contain 
all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. For example, DWADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.

• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. For example: DW_USER. The application will access the database 
as DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• The location for jar files (the Jar files are bundled with the database package).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI251\DWADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the DWADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in the Storage.par file to tablespace name on which the 
DWADM has quota.

Installation Steps
Perform the following steps to install the DWADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 11.2.0.3+32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

1. Run the CDXDBI.exe from ..\BI251\DWADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.
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• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: DWADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI251\DWADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: DWUSER.

• The Oracle user with the read-only privileges to the database schema: DWREAD.

• The Oracle database role with the read-write privileges to the database schema: 
DW_USER.

• The Oracle database role with the read-only privileges to the database schema: 
DW_READ.

2. If you choose to continue, the CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions.  
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Configuring the Spatial Data
Refer to the section Spatial Configuration for the details regarding the spatial configuration.

Installing Oracle Utilities Analytics ELT Component Installation based on 
Oracle Data Integrator 

Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ELT component that is used to install all the related 
software. Refer to the section Prerequisite Software.

Note: You must install the Oracle Utilities Analytics ELT component based on 
Oracle Data Integrator (ODI) only if you are using Oracle Utilities Network 
Management System, Oracle Utilities Operational Device Management, or 
Oracle Utilities Customer Care and Billing as the source applications.

Note: Oracle Utilities Network Management System, Oracle Utilities 
Operational Device Management, or Oracle Utilities Customer Care and Billing 
application set up is a prerequisite in order to install Oracle Data Integrator 
based ELT component. The source applications should be setup with the 
required configurations before proceeding with the Oracle Data Integrator 
based ELT component installation in order to successfully extract data from 
them, to Oracle Utilities Analytics.

Refer to the chapter Configuring Oracle Utilities Network Management 
System for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Network Management System Data Mapping Guide.
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Refer to the chapter Configuring Oracle Utilities Operational Device 
Management for Business Intelligence in Oracle Utilities Extractors and 
Schema for Oracle Utilities Operational Device Management Data Mapping Guide. 

Refer to the chapter Configuring Oracle Utilities Customer Care and 
Billing for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Customer Care and Billing Data Mapping Guide.

This section describes how to install the ELT component of Oracle Utilities Analytics. The section 
includes the following:

• Setting up Oracle GoldenGate

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Oracle Utilities Analytics ELT Component based on Oracle Data Integrator Package 
Installation Steps

• Post-installation Tasks

• Generating Security and Starting Oracle Data Integrator Scheduler

Setting up Oracle GoldenGate
Note: This section describes setup required in Oracle GoldenGate to work 
with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its 
installation document.

Note: You should install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities Network 
Management System, Oracle Utilities Operational Device Management or 
Oracle Utilities Customer Care and Billing as the source application.

Download Oracle GoldenGate 12.1.2.0.0 from the Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers. 

This section describes the following: 

• Setting up Oracle GoldenGate on the Source Database Server

• Setting up Oracle GoldenGate on the Target Database Server

Setting up Oracle GoldenGate on the Source Database Server
Perform the following steps for each source instance: 

1. Create a directory on the source database server. For example, ../Golden Gate Home.  
Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate 
home (OGG_Home) on the source database server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Open a command terminal/window, and set the source ORACLE_SID and 
ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set  LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
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3. In the Command window, change directory to the Oracle GoldenGate home directory, and 
execute the command as shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the Oracle GoldenGate prompt.

4. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

5. On the Oracle GoldenGate prompt, execute the EDIT PARAMS mgr command. 
This command opens an editor.

6. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.

Note: Make a note of the range start and end ports numbers; it will be used 
during the Oracle Utilities Analytics installation.

Note: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings such as Purge.

7. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.

8. On the Oracle GoldenGate prompt, execute the info all command to view the manager 
process is running. Exit Oracle GoldenGate by executing the Exit command.

9. Ensure that the source database is in the archivelog mode.

10. Connect to the source database as the sys user and execute the alter database add 
supplemental log data (primary key) columns command.

11. Go to the Oracle GoldenGate home (OGG_Home) directory.

12. Connect to the database as the sys user using the SQL*Plus (OGG_Home should be the 
current directory while invoking SQL*Plus). 

13. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and 
make sure to assign a tablespace to this user that is not assigned to any other user. 

Important Note: Make a note of the GoldenGate Owner Username; it will be 
used during Oracle Utilities Analytics installation.

14. Execute Grant connect,resource,dba to <GoldenGate owner user created in the step 
mentioned above>.

15. Connect to the source application ADM schema such as CISADM, and execute the below 
commands:

For Oracle Utilities Customer Care and Billing source database, execute the following 
grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above >
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Grant select on F1_BKT_CONFIG to < GoldenGate owner user created in the step 
mentioned above >

Grant select on F1_BKT_CONFIG_VAL to < GoldenGate owner user created in the 
step mentioned above >

For Oracle Utilities Operational Device Management source database, execute the 
following grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above>

Note: While executing the SQL commands in the steps 16, 17 and 18, provide 
the GoldenGate owner user if prompted for. All the scripts mentioned below 
are located in GoldenGate Home directory and must be executed after 
connecting to the sys user.

16. Run the command:  
@marker_setup.sql

17. Run the command:  
@ddl_setup.sql

18. Run the command:  
@role_setup.sql

19. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.

Setting up Oracle GoldenGate on the Target Database Server
Perform the following steps: 

1. Create a directory on the target database server. For example,  ../GoldenGateHome.  
Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate 
home (OGG_Home) on the target Oracle Utilities Analytics database server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Open a Command window and set the target ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

3. In the Command window, change the directory to the GoldenGate home directory and 
execute the command as shown below:

For Unix:

./ggsci

For Windows:

ggsci
This opens the Oracle GoldenGate prompt.

4. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.
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5. On the Oracle GoldenGate prompt, execute the EDIT PARAMS mgr command. This 
opens an editor.

6. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note: Make sure the mentioned port range (7830-7880) is not in use. If they 
are in use, provide another available port range.

Note: Make a note of the range start and end ports numbers; it will be used 
during the Oracle Utilities Analytics installation.

Note: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings such as Purge. 

7. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.

8. On the Oracle GoldenGate prompt, execute the info all command to view the manager 
process is running.

9. Exit Oracle GoldenGate by executing exit command and create a directory named diroby 
inside the OGG_Home directory.

Copying and Decompressing the Install Media
The Oracle Utilities Analytics ETL component based on Oracle Utilities Analytics installation file 
is delivered in zip format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Analytics environments operated by different Oracle Utilities Administrator User 
IDs, you must complete each of the following installation steps for each administrator user ID.

1. Download the Oracle Utilities Analytics version 2.5.1 ELT component based on Oracle Data 
Integrator part (Oracle Utilities Analytics V2.5.1ETL component based on ODI 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics Administrator User ID.

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

4. Unzip Oracle Utilities Analytics V2.5.1ETL component based on ODI 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.5.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.ODI.V2.5.1-MultiPlatform.jar 

Note: It is recommended to have Java JDK installed on the machine used to 
(un)jar the Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator installation package. Install the JDK that supports the platform to 
use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named “BI.ODI.V2.5.1” is created. It contains installation software for the Oracle 
Utilities Analytics ELT component based on Oracle Data Integrator.
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Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.ODI.V2.5.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of the existing environment.

Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Package Installation Steps

Follow these steps to install the Oracle Utilities Analytics package applications after performing 
the steps to deploy the ELT component objects as described in the section above:

• Prerequisite Software

• Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator

Prerequisite Software
Before installing the Oracle Data Integrator package, ensure that you have already installed the 
below-mentioned software products. These software products should be installed on the database 
server. Also, note the locations of these software products:

• JDK 1.6 update 20 to 35 (JAVA_HOME) on the database server

• Oracle Database Home (ORACLE _HOME)

• Oracle WebLogic 10.3.6 (WL_HOME)

• Oracle Data Integrator 11.1.1.6 with Java EE Installation (ODI_HOME)

• Oracle GoldenGate 12.1.2.0.0 software on the source database server and the target database 
server (OGG_HOME)

Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator
Follow the below instructions to install the Oracle Utilities Analytics ELT component based on 
Oracle Data Integrator: 

1. Change the current directory to <TEMPDIR>/ BI.ODI.V2.5.1.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl. It is required 
to run the installer (sample commands listed in the point 4 below).

3. Make sure that the user with which Oracle Database Enterprise Edition (or Standard Edition) 
and all other prerequisite software products were installed, is used to install the Oracle 
Utilities Analytics ELT component based on Oracle Data Integrator package.

4. Execute the following script for UNIX/Windows:
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For UNIX:

Run the following commands: 

export ORACLE_CLIENT_HOME=<ORACLE_HOME> 
export PERL_HOME=$ORACLE_CLIENT_HOME/perl 
export PATH=$PATH:$PERL_HOME/bin
ksh ./install.sh

Note: Ensure that you have the required the execute permission on install.sh 
on UNIX.

For Windows: 

Run the following commands: 

set ORACLE_CLIENT_HOME=<ORACLE_HOME> 
set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl
set  PATH=%PERL_HOME%\bin;%PATH% 
install.cmd

5. The Oracle Utilities Analytics specific menu appears.

6. Select each menu item to configure the values.  
For the detailed description of the values, refer to the Configuration Worksheet for ELT 
Component based on Oracle Data Integrator Installation.

Note: All the schema names must be entered in the upper case.

Note: For the parameter 'Target GoldenGate Shared Secret', follow the below 
instructions.

a. Go to the Oracle GoldenGate prompt and run the command:

encrypt password <password of MDADM user>, encryptkey DEFAULT

b. Copy the encrypted password returned by the above command and provide it as the 
value for the Target GoldenGate Shared Secret.

Environment Installation Options: 

1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point: 
Environment Name: 
Web Java Home Directory: 
Each item in the above list should be configured for a successful install.  
Choose any option from the menu item (1, 2 <P> Process, <X> Exit).

Environment Configuration: 

1. Environment Description 
Environment Description:

2. ODI Environment Configuration 
WEBLOGIC HOME: 
ODI HOME: 
ODI SUPERVISOR USER: SUPERVISOR 
ODI SUPERVISOR Password:  
Target Database Name: 
Target Database Host:  
Target Database Port:1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: <DWADM Password> 
ODI Master Schema Name: MASTER REPO 
ODI Master Schema Password:  
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ODI Work Schema Name: 
ODI Work Schema Password: 
ODI Master Repository ID: 601 
ODI Work Repository ID: 602 
MDADM Schema Name: MDADM 
MDADM Schema Password: <MDADM Password>

3. ODI Agent Configuration 
ODI Weblogic Agent Host: 
ODI Weblogic Agent Port:

4. Target GoldenGate Configuration 
Target GoldenGate Manager Port 
Target GoldenGate Dynamic Mininum Port: 
Target GoldenGate Dynamic Maximum Port: 
Target GoldenGate Algorithm: 
Target GoldenGate Encryptkey: 
Target GoldenGate Shared Secret: 
Target Database Home: 
Target GoldenGate Home: 
Each item in the above list should be configured for a successful install.  
Choose any option (1, 2, 3, 4<P> Process, <X> Exit).

Once the parameter setup is completed, proceed with the option P. 

Once installation is finished successfully, execute the post-installation steps as described in the 
section Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying ELT Component based on Oracle Data Integrator

• Generating the Views (Global)

• Configuring the Source

• Executing the Knowledge Modules (KMs)

• Generating the Views (For Source Instance)

• Creating the WebLogic Domain for Oracle Data Integrator Agent

• Starting the WebLogic Admin Server

• Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting 
the Managed Server

Important Note: Before performing the post-installation tasks, a database 
directory ‘B1_DATA_DUMP_DIR’ should be created on the target database. 
This directory is used for logging the export import task used during the initial 
ELT load. The following is a sample SQL that creates the database directory 
pointing to the file system path /scratch/file_data:

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
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Deploying ELT Component based on Oracle Data Integrator
Follow the sequence of these steps for a successful deployment: 

For the Oracle Data Integrator deployment, the script creates the master and work repositories, 
and imports the Oracle Data Integrator metadata.

Note: The script may take several minutes to complete.

For UNIX:

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployodi.sh.

For Windows: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deployodi.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

Generating the Views (Global)
This step creates global views based on the Oracle Data Integrator metadata.

For UNIX:

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./runviewGenerator.sh.

For Windows:

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the runviewGenerator.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

Configuring the Source
Important Note: This step inserts each source instance and instance 
name into the b1_prod_instance table. This step has to be repeated for 
each source instance that is used. 

This step also creates the replication schema in the target database 
corresponding to each source application. The $SPLEBASE/bin/
obiu.properties file is read to assign the default tablespace to the replication 
user.
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By default, this file has obiu.repository.default.tablespace = CISTS_01 entry where CISTS_01 is 
tablespace name. If you want to assign this tablespace as the default tablespace to replication 
schema, make sure to create CISTS_01 tablespace in the target database if it does not exist.

Make sure to edit obiu.repository.default.tablespace parameter in the $SPLEBASE/bin /
obiu.properties file to another tablespace parameter, which exists in the database and it is 
considered as the default tablespace for the replication schema. This entry should be changed as 
follows:

obiu.repository.default.tablespace = <Name of tablespace to use>

For UNIX:

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./configureSourceDB.sh -c <Source instance> -u <Source Golden gate owner 
schema name> -p < Source Golden gate owner schema password > -s <Source Application 
Schema> -r <Source Application Drill Back URL>.

For Windows: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run configureSourceDB.cmd -c <Source instance> -u <Source Golden gate owner schema 
name> -p <Source Golden gate owner schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL>.

Where, 

• Source instance = Name for the source instance being added

For Oracle Utilities Operational Device Management source application, the valid values 
are ODM1,ODM2……..ODM9. Provide any of these values, which is already not 
configured. Make a note of these parameters; it will be used in the next deployment 
steps.

For Oracle Utilities Network Management System application, the valid values are 
NMS1,NMS2…….NMS9. Provide any of these values, which is already not configured.

For Oracle Utilities Customer Care and Billing application, the valid values are 
CCB1,CCB2…….CCB9. Provide any of these values, which is already not configured.

• Source _Schema User = <GoldenGate Owner created in Source database> For 
example: ODM01SRC.

• Source _Schema User _Password = GoldenGate Owner password.

• Source Application Schema = Source Application Schema (For example, CISADM).

• Source Application Drill Back URL = Source Application URL (http://
<Host>:<Port>/ouaf/).

This opens a source configuration menu as shown below. Select each menu item to configure the 
values.
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For the detailed description of the values, refer to the Configuration 
Worksheet for ELT Component based on Oracle Data Integrator 
Installation.

Note: For the parameter 'Source GoldenGate Shared Secret', follow the below 
instructions.

a. Go to GoldenGate prompt and run the command:

encrypt password <password of source GoldenGate owner user>, 
encryptkey DEFAULT.

b. Copy the encrypted password returned by the above command and provide it as the 
value for the Source GoldenGate Shared Secret.

Environment Configuration: 

1. Source GoldenGate Configuration 
Source Instance Name: 
Source GoldenGate Manager Port: 
Source GoldenGate Dynamic Mininum Port:  
Source GoldenGate Dynamic Maximum Port:  
Source GoldenGate Algorithm: 
Source GoldenGate Encryptkey:  
Source GoldenGate Shared Secret:  
Source Database Name: 
Source Database Host:  
Source Database Port:  
Source Database Home:  
Source GoldenGate Home: 
Each item in the above list should be configured for a successful install. 
Choose any option (1, <P> Process, <X> Exit).

Once the parameter setup is completed, proceed with the option P. 

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log file.

Executing the Knowledge Modules (KMs)
This step is run to reverse engineer the source tables, journalizing setup, and to create the 
Oracle GoldenGate scripts. This step has to be repeated for each source instance that will 
be used.

Note: The script may take several minutes to complete.

For Unix: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./initiateSetup.sh -c <Source Instance>.

Where Source instance = Instance name given to the source in the step Configuring the 
Source above. For example: ODM1.

5. The initial load process can be started now to copy data from the source database into the 
replication schema in the data warehouse. 

The list of the source tables being replicated can be found in the Data Mapping Guide.
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Note: For the source tables list, refer to Oracle Utilities Extractors and Schema 
Data Mapping Guide for Oracle Utilities Operational Device Management or Oracle 
Utilities Extractors and Schema Data Mapping Guide for Oracle Utilities Customer Care 
and Billing.

In $SPLEBASE/GGScriptsGen directory, you will find a folder starting with the instance 
name.

Go to the folder that has the name starting with the instance name.

For example: $SPLEBASE/GGScriptsGen/ODM1AA

Note: Refer to the ReadMe.txt generated in the above-mentioned directory 
for the detailed instructions on how to run the Oracle GoldenGate scripts and 
how to start the initial and the incremental loads.

Note: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and the target database servers. 

Note: During the Oracle GoldenGate script execution, you might get error 
message (ERROR: OCI Error ORA-00955: name is already used by an existing 
object (status = 955) related to the B1_CHECKPOINT table. It should be 
ignored.

Note: When using Oracle Database 12c, if the Oracle GoldenGate processes 
fails, verify the logs to check whether it is because of a DDL replication error. If 
it is due to a DDL replication error, restart the Oracle GoldenGate process 
until it succeeds.

Note: The generated Oracle GoldenGate scripts need minor modifications 
when using Oracle Automatic Storage Management (ASM). Refer to Oracle 
GoldenGate installation documentation for more details.

For Windows: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the initiateSetup.cmd -c <Source instance>.

Where Source instance = Instance name given to the source in the step Configure Source 
mentioned above. For example: ODM1

5. The initial load process can be started now to copy the data from the source database into the 
replication schema in the data warehouse. 

The list of the source tables being replicated can be found in the Data Mapping Guide.

Note: For the source tables list, refer to Oracle Utilities Extractors and Schema 
Data Mapping Guide for Oracle Utilities Operational Device Management or Oracle 
Utilities Extractors and Schema Data Mapping Guide for Oracle Utilities Customer Care 
and Billing.

In the %SPLEBASE%/GGScriptsGen directory, you will find a folder starting with the 
instance name.

Go to the folder that has name starting with the instance name.

For example: %SPLEBASE%/GGScriptsGen/ODM1AA
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Note: Refer to the ReadMe.txt generated in the above-mentioned directory 
for the detailed instructions on how to run the Oracle GoldenGate scripts and 
how to start the initial and the incremental loads.

Note: Ensure that ORACLE_SID and, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and the target database servers.

Note: During the Oracle GoldenGate script execution, you might get error 
message (ERROR: OCI Error ORA-00955: name is already used by an existing 
object (status = 955)) related to the B1_CHECKPOINT table. It should be 
ignored.

Note: When using Oracle Database 12c, if the Oracle GoldenGate processes 
fails, verify the logs to check whether it is because of a DDL replication error. If 
it is due to a DDL replication error, restart the Oracle GoldenGate process 
until it succeeds.

Note: The generated Oracle GoldenGate scripts need minor modifications 
when using Oracle Automatic Storage Management (ASM). Refer to Oracle 
GoldenGate installation documentation for more details.

Generating the Views (For Source Instance)
This step creates the views for a given source instance. These views are used for replication. This 
step needs to be executed once for each source configured.

For Unix: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the runviewGenerator.sh -c <Source Instance>.

For Windows: 

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the runviewGenerator.cmd -c <Source instance>.

Where Source instance = Instance name given to the source in the Configure Source step 
mentioned above. For example: ODM1

Note: After the completion of the Oracle Utilities Analytics deployment, if 
there are any changes done to the source configuration, the above script has to 
be executed for that source context to get them applied to Oracle Utilities 
Analytics.

Creating the WebLogic Domain for Oracle Data Integrator Agent
The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to 
complete the steps. 

Perform the following steps to bring up the WebLogic ODI Agent, which is created in the step 
Deploying ELT Component based on Oracle Data Integrator.

1. Navigate to the Oracle Data Integrator (ODI) installed location <MW_HOME>/
Oracle_ODI1\common\bin, run the below command and follow the steps to provide the 
masterschema and workschema provided in the configuration.
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For Unix: 

• Run ./Config.sh

For Windows: 

• Run Config.cmd

2. Create a new WebLogic domain. 

Click Next.

3. Generate a domain configured automatically to support the following products. Select the 
checkboxes for the below mentioned plugins. When these plugins are selected, some 
automatic plugins also get selected.

• Oracle Enterprise Manager Plugin for Oracle Data Integrator -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0

Then, click Next to proceed. 
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4. On the Specify Domain Name and Location page, complete the following: 

• Provide the domain name: odi_domain 

• Location will be default

Click Next to proceed.

5. Configure the Administrator User Name and Password for the WebLogic. 
Provide the WebLogic password.

Click Next. 

6. Configure the Server StartUp Mode and JDK:

• Select the Production Mode option.
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• Provide the JDK 1.6.0_20 

7. Configure the JDBC Component Schema. 

Select only the ODI Master Schema checkbox. Provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the ODI Master Schema checkbox.

9. Select the ODI Work Schema checkbox. Provide the below details: 

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO
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• Schema Password: WORK _REPO Password

Click Next to proceed. 

10. Test the JDBC Component Schema by selecting the Select All and the Test Connections. 

Click Next to proceed. 

11. Select the Optional Configuration:

• Select the checkboxes: 

• Administration Server
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• Managed Server, Clusters and Machines

Select Next to proceed.

12. Configure the Administration Server:

• Provide the Listening Port, which is not in use.

Click Next to proceed. 

13. Configure the Managed Servers by providing the following: 

• Name: odi_server1

• Listen Address: All Local Addresses
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• Port: <Provide the port, which is configured in the menu configuration of the 
installation step (ODI Agent Configuration > ODI WebLogic Agent Port>)

14. Configure the Cluster.  
Click Next. 

15. Configure the Machines.  
Click Next. 

16. Assign the Servers to Machines.  
Click Next.

17. On the Configuration Summary page, click Create to create the domain odi_domain. 

18.  After the domain is created, go to the domain location, create the boot.properties file for 
WebLogic login. Create the <MW_HOME>/user_projects/domains/odi_domain/
servers/AdminServer/security folder if not present. 

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties file with the below values:

• username=weblogic

• password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/
odi_server1/security folder if not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security, and then create boot.properties file with the below values:

• username=weblogic

• password=Weblogic password
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Starting the WebLogic Admin Server 
Perform the following steps: 

1. In the command shell, change the directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin.

2. Execute the startweblogic command for UNIX and Windows:

For Unix:

nohup ./startWebLogic.sh > startWebLogic.log &

For Windows: 

startWebLogic.cmd

Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting the 
Managed Server

Perform the following steps:

1. Go to <MW_HOME>/oracle_common/common/bin.

2. Execute the following command:

For Unix:

./wlst.sh

For Windows: 

wlst.cmd

3. To connect to the running Admin server, execute the following command:

connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for the Oracle Date 
Integrator Supervisor:

createCred (map="oracle.odi.credmap", key="SUPERVISOR", 
user="SUPERVISOR", password="<SUPERVISOR Password>", desc="ODI 
SUPERVISOR Credential")

5. To exit WebLogic Scripting Tool (WLST), execute the exit () command. 

To start managed server odi_server1

Perform the following steps: 

1. To start managed server odi_server1, change the directory to the WLS Home: 

<MW_HOME>/user_projects/domains/odi_domain/bin

Execute the below commands: 

For Unix: 

nohup ./startManagedWebLogic.sh  odi_server1 > 
StartManagedWeblogic.log &

For Windows: 

StartManagedWeblogic.cmd odi_server1
2. From the Oracle Data Integrator Studio, navigate to Topology > Agents> 

OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of 
configured Oracle Data Integrator Java EE agent.
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Generating Security and Starting Oracle Data Integrator Scheduler
Perform the following steps: 

1. Edit the database name with the name of your database in OraGenSec.bat and run it from 
the BI251/DWADM/Security folder.

2. Log into Oracle Data Integrator Studio and navigate to Designer > Load Plans and 
Scenarios > Framework.

3.  Right-click the B1_INITIAL_SETUP_PKG Version 001 and execute.

4. Select global as context, WLS_AGENT as logical agent, and then click OK.

5. Go to the Operator and view the logs for successful execution of the package.

6. In Oracle Data Integrator Studio, navigate to Designer > Load Plans and Scenarios > 
Framework> B1_RUN_ALL Version 001 > Scheduling.

7. Right-click scheduling and select New Scheduling option.

8. Select the source context as global, agent as WLS_AGENT and the log level as 1.

9. To specify how often the scheduler should run, navigate to the Execution Cycle tab of the 
Scheduler and select the 'Many Times' option. Set the interval between repetitions.

10. Navigate to Topology > Agents > OracleDIAgent.

11. Right-click on OracleDIAgent and click Update Schedule.

Installing Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder 

This section describes how to install the Oracle Warehouse Builder based ETL component of 
Oracle Utilities Analytics.

Note 1: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ETL component that is used to install all the related 
software. Refer to the section Prerequisite Software for Oracle Utilities 
Analytics ETL Component based on Oracle Warehouse Builder.

Note 2: You should install the Oracle Utilities Analytics ETL component 
based on Oracle Warehouse Builder (OWB) only if you are using Oracle 
Utilities Work and Asset Management, Oracle Utilities Meter Data 
Management, or Oracle Utilities Mobile Workforce Management as the source 
application.

Note 3: To use Oracle Database Server 12.1.0.1.0 with Oracle Warehouse 
Builder based ETL, install standalone Oracle Warehouse Builder software and 
apply the patch 16568042 to Oracle Warehouse Builder home. In case of 11g 
database, ORACLE_HOME and OWB_HOME are the same, but with 
12.1.0.1.0 database it requires standalone installation of Oracle Warehouse 
Builder; hence, ORACLE_HOME and OWB_HOME are different.

This section includes the following:

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Creating and Configuring the Oracle Warehouse Builder Workspace

• Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Package Installation Steps

• Post-installation Tasks
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Copying and Decompressing the Install Media
The Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder installation 
file is delivered in a zip format for both UNIX and Windows platforms. If you plan to install 
multiple Oracle Utilities Analytics environments operated by different Oracle Utilities 
Administrator User IDs, you must complete each of the following installation steps for each 
Administrator User ID.

1. Download the Oracle Utilities Analytics version 2.5.1 ETL Component based on Oracle 
Warehouse Builder part (Oracle Utilities Analytics V2.5.1ETL Component Based on OWB 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics Administrator User ID 
(default cases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

4. Unzip the zip file Oracle Utilities Analytics V2.5.1ETL Component Based on OWB 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.OWB.V2.5.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.5.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named "BI.OWB.V2.5.1" is created. It contains the installation software for the Oracle 
Utilities Analytics ETL component based on Oracle Warehouse Builder.

Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab file.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.5.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of the existing environment.
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Creating and Configuring the Oracle Warehouse Builder Workspace
This section describes how to create and configure the Oracle Warehouse Builder workspace. 

Before creating/configuring workspace, perform the following steps: 

1. Execute the following command to configure the workflow in the database.

For Unix:

$OWB_HOME/owb/wf/install/wfinstall.csh 

For Windows:

%OWB_HOME%/owb/wf/install/wfinstall.bat

This launches a configuration dialog in which you are asked to enter the user name and 
password. 

2. Enter OWFMGR as a user and a password for OWFMGR user.

3. Specify the TNS connect string of the database in the following format.

hostname:port:sid

To configure Oracle Warehouse Builder (OWB), perform the following steps:

1. Execute cat_owb.sql as sysdba from the <OWBHOME>/owb/UnifiedRepos directory 
if the database version is 12.1.0.1.0.

2. Unlock the OWBSYS and OWBSYS _AUDIT accounts if this has not already been done. 
Connect to the Sys User and execute the following commands:

ALTER USER OWBSYS IDENTIFIED BY OWBSYS ACCOUNT UNLOCK; ALTER USER
OWBSYS_AUDIT IDENTIFIED BY OWBSYS_AUDIT ACCOUNT UNLOCK;

3. Run the $OWB_HOME/owb/bin/unix/reposinst.sh command for UNIX from the 
database server. 
 
OR 
 
Invoke the repository assistant from Warehouse Builder > Administrator for Windows 
from the database server or client.

4. Provide the following information:

• Database connection details and click Next.

• Select Manage Warehouse Builder Workspaces and click Next.

• Select Create a new Warehouse Builder Workspace and click Next.

• Select Workspace with a new user as the workspace owner.

• Provide the system user password.

5. Check only Data Integrator Enterprise Edition on Enable Optional features, and then 
specify the following details:

• Workspace Owner's User Name: BIREPOWN

• Workspace Owner's Password: BIREPOWN

• Workspace Name: SPLBIREP

• Provide OWBSYS Password:

Note: Workspace name should be SPLBIREP. Do not change the workspace 
name.
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6. Execute <OWBHOME>/owb/UnifiedRepos /remote_owb_install.sql after logging in 
to the sys user. When prompted for Oracle Home for Remote Oracle Warehouse Builder 
software, provide the location of Oracle Warehouse Builder Oracle Home.

7. Provide the tablespace info for the Oracle Warehouse Builder workspace schema.

8. Select the Language (American Language).

9. Select the Target Schema (DWADM) and the Workflow Schema (OWFMGR) from the 
available Repository Users List and move them to Selected. This will register the DWADM 
and OWFMGR schemas with the workspace.

10. On the same page, click Create New User to create a new workspace user. Specify the 
following details:

• User Name: BIREPO 

• Password: BIREPO

11. Review the information, and then click Finish to complete the workspace configuration.

12. Modify the contents of the <owb-home>/owb/bin/admin/Runtime.properties file 
from the following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 
= DISABLED 
property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
DISABLED 
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint 
=DISABLED

To

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint 
= NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.Shell.security_constrai
nt = NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constr
aint = NATIVE_JAVA

13. Connect to the OWBSYS user, and execute the <owb-home>/owb/rtp/sql/
stop_service.sql.

14. Connect to the OWBSYS user, and execute the <owb-home>/owb/rtp/sql/
start_service.sql.

15. Connect to the database with the sys user, and execute the following procedures:

Note: Before executing these procedures, modify <SMTP SERVER> and 
<SMTP PORT> to appropriate values.

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml','ACL for 
Control Center','OWBSYS', TRUE, 'connect'); 

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<SMPT SERVER>, 
<SMPT PORT>); 
COMMIT;

16. Execute the following: 

SELECT
acl,host, 

DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,'OWBSYS', 
'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege

FROM dba_network_acls ;
Oracle Utilities Analytics Initial Installation 5-50 
Oracle Utilities Analytics Installation Guide



You will see the following:

/sys/acls/acl_for_owb_cc.xml
<SMPT SERVER> GRANTED

17. Connect to the BIREPOWN user, and run the spl_exec_wf_prc.sql located in../BI251/
Scripts.

18. Connect to the database with the sys user, and execute the owb_grants_synonyms.sql 
located in../BI251/Scripts.

Note: Ignore errors that are caused when trying to drop synonyms that these 
do not exist.

Oracle Utilities Analytics ETL Component based on Oracle Warehouse Builder 
Package Installation Steps

Important Note: During the Oracle Warehouse Builder installation, if the 
target DB is 12c, Oracle Warehouse Builder based ETL component should be 
installed in a separate Oracle Utilities Analytics environment (do not use the 
Oracle Utilities Analytics environment where Oracle Data Integrator based 
ELT component and Dashboard component are installed). During 
configuration of Oracle Warehouse Builder component, provide Oracle 
Warehouse Builder home as the DB home. This is needed for the owbdeploy 
script to pick the Oracle Warehouse Builder executables from the right 
location. If the target DB is 11g, there are no such restrictions. Oracle 
Warehouse Builder can be installed in the same Oracle Utilities Analytics 
environment as other components (Oracle Data Integrator based ELT 
component and Dashboard component). In this case, provide 11g DB home 
during the Oracle Warehouse Builder configuration.

After performing the above outlined steps, follow these steps to install the Oracle Utilities 
Analytics ETL Component based on the Oracle Warehouse Builder package:

1. Change the current directory to <TEMPDIR>/BI.OWB.V2.5.1.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl. It is required 
to run the installer (steps mentioned in point 4 below).

3. Make sure that the user with which Oracle Database Enterprise Edition 11.2.0.3 /12.1.0.1.0 
was installed, is used to install the Oracle Utilities Analytics ETL component based on Oracle 
Warehouse Builder package.

4. Execute the following script: 

For Unix: 

Perform the following steps: 

• export Oracle_CLIENT_HOME=<OWB_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run the ksh ./install.sh

Note: Ensure that you have the required execute permission on install.sh.

For Windows: 

Perform the following steps: 

• set ORACLE_CLIENT_HOME=<OWB_HOME> 

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl 

• set PATH=%PERL_HOME%\bin;%PATH% 
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• Run install.cmd

5. The Oracle Utilities Analytics specific menu appears.

6. Select each menu item to configure the values. For the detailed description of the values, see 
Configuration Worksheet for ETL Component based on Oracle Warehouse Builder 
Installation.

Note: All the schema names must be entered in the upper case.

Environment Installation Options: 

1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point: 
Environment Name: 
Web Java Home Directory: 

For successful installation, each item in the above list should be configured. Choose any menu 
option (1, 2 <P> Process, <X> Exit).

Environment Configurations:

1. Environment Description 
Environment Description:

2. Database Configuration 
OWB WorkSpace Owner: 
OWB WorkSpace Owner Password: Database Name: 
Database Server: Database Port:

3. Design Repository Configuration 
OWB WorkSpace User: 
OWB Workspace user Password:  
OWB WorkSpace Name: 
DWADM SCHEMA NAME: 
DWADM SCHEMA Password:  
WORKFLOW MANAGER SCHEMA NAME: 
WORKFLOW MANAGER SCHEMA Password:

4. Database character set configuration 
Database Character set: AL32UTF8

5. Editing process flow configuration 
Repository Operating System:  
Perl Compiler location: 
Data and control files location:  
Separator to be used: 
File Manager location:

6. Email Configuration 
Email ID of Sender: 
Email ID for Reply-To address: 
Email ID of Receiver:  
SMTP server: 
SMTP server port:

7. Control Centre Configuration 
Repository Control Center Name:

8. External Data Source Configuration  
Path of the External Datasource: 
Path of the External Datasource LOG: 
File Processor Daemon Execution Switch: 1 
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File Processor Extract Max Load: 5 
File Processor Scheduler Poll Duration: 60

For successful installation, each item in the above list should be configured. Choose any menu 
option (1, 2, 3, 4, 5, 6, 7, 8 <P> Process, <X> Exit).

After completing the parameter setup, proceed with the option P. Write to the configure file.

Once installation is successful, execute the post-installation steps as described in the section Post-
installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying the ETL Workflows on Oracle Warehouse Builder

• Deploying the Materialized Views

• Executing the Init Package

• Starting the File Processor

• Generating the Security

• Generating the Database Statistics

Deploying the ETL Workflows on Oracle Warehouse Builder
Deploy the ETL workflows to the target BI database configured in Oracle Utilities Analytics 
package installation. In UNIX, you may get a Java heap space error while importing the MDL file. 

To resolve this error, you are required to make changes in the OMBPlus.sh file, located at: 
$OWB_HOME/owb/bin/ unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M 
- DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import. 

Perform the following task:

Review the parallel-* .txt files located under the $SPLEBASE/etc folder to set the degree of 
parallelism. The files are in the parallel*.txt format to change the <Degree> of parallelism.

parallel-tables.txt file format: <Object_name>:<Degree> 
parallel-mvs.txt file format: : <MV_Name>:<Fact_Table>:<Degree>  
parallel-maps.txt file format:<Object_name>:<Table_Name>:<Degree> 

Note: The script may take several minutes to complete.

For UNIX:

Perform the following: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./Owbdeploy.sh.
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For Windows:

Perform the following:

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the Owbdeploy.cmd.

Deploying the Materialized Views
Perform the following: 

For UNIX: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE\bin.

4. Run the ksh ./installViews.sh.

5. Once the deployment is complete, remove the content inside this directory $SPLEBASE/
tmp to ensure that all files are removed.

For Windows:

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the installViews.cmd.

5. Once the deployment is complete, remove the content inside this directory 
%SPLEBASE%\tmp to ensure that all files are removed.

Executing the Init Package
Perform the following steps:

1. Login to the Oracle Warehouse Builder repository.

2. Navigate to Tools > Control Center Manager >SPL_BI_WF_LOC >SPL_BI_WF 
>INIT_PKG. 

3. Right-click on each workflow in INIT_PKG, except OUBIWF_PURGE_RT_AUDIT and 
click the Start option. 

For example, right-click LOAD_DATE and click Start. 

Starting the File Processor
Perform the following steps:

For UNIX: 

cd $SPLEBASE/bin 
nohup ksh ./startFileprocessordaemon.sh >&1 &

For Windows:

startFileprocessordaemon.cmd

Note: Go to <SPLEBASE>/logs/system to view the file processor log.
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Generating the Security
Edit the database name with the name of your database in OraGenSec.bat after completing the 
Oracle Warehouse Builder deployment and run it from BI251/DWADM/Security folder.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Installing Oracle Utilities Analytics Dashboard Component
Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics Dashboard component that is used to install all the 
prerequisite software. Refer to the section Prerequisite Software for Oracle 
Utilities Analytics Dashboard Component.

This section describes how to install the database component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Oracle Utilities Analytics Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing the Install Media
The Oracle Utilities Analytics Dashboard Component installation file is delivered in zip format for 
both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities Analytics 
environments operated by different Oracle Utilities Administrator User IDs, you must complete 
each of the following installation steps for each Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.1Dashboard Component part (Oracle Utilities 
Analytics V2.5.1Dashboard Component Multiplatform.zip) from the Oracle Software 
Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise 
Edition11.1.1.7.1 software is installed) as the Oracle Utilities Analytics Administrator User ID 
(default cases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred in the step 3 
below as <TEMPDIR>). This directory must be located outside any current working Oracle 
Utilities application environment. All files placed in this directory as a part of the installation 
procedure can be deleted after completing a successful installation.

4. Copy the file BI.OBIEE.V2.5.1-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

5. Decompress the file:

cd <TEMPDIR>

jar -xvf BI.OBIEE.V2.5.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/
index.html

A sub-directory named “BI.OBIEE.V2.5.1” is created. It contains the 
installation software for the Oracle Utilities Analytics Dashboard component.
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Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On the UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.1directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, it is recommended that you take a backup prior to 
the installation process. The installation utility does not create a backup of the existing 
environment.

Oracle Utilities Analytics Dashboard Package Installation Steps
Note: Before installing verify that the steps in Prerequisite Software for 
Oracle Utilities Analytics Dashboard Component are followed.

To install the Oracle Utilities Analytics Dashboard package, follow these steps. 

1. Change the current directory to <TEMPDIR>/BI.OBIEE.V2.5.1.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl. It is required 
to run the installer.

For UNIX:

Perform the following steps: 

• export ORACLE_CLIENT_HOME=<ORACLE_HOME>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run the ksh ./install.sh

Note: Ensure that you have the proper execute permission on install.sh.

For Windows:

Perform the following steps: 

• set ORACLE_CLIENT_HOME=<oracle_client_home>

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH%

• Run the Install.cmd

• The Oracle Utilities Analytics specific menu appears.

• Select each menu item to configure the values. For the detailed description of the values, 
see Configuration Worksheet for Dashboard Component Installation.
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Environment Installation Options 

1. Oracle Client Home Directory:                                                   

2. Environment Mount Point: 
Log Files Mount Point:  
Environment Name:  
Web Java Home Directory:                           

For successful installation, each item in the above list should be configured. Choose any menu 
option (1, 2, <P> Process, <X> Exit).

For the detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

Note: All the schema names must be entered in the upper case.

Environment Configuration 

1. Environment Description 
Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home 
Oracle BI Home 
Oracle BI Domain Home 
Weblogic Domain Console User Name 
Weblogic Domain Console Host: 
Weblogic Domain Console Port  
Number:

3. Target Database Details 
Target Database Name:  
Target Database Host:  
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: 

For a successful installation, each item in the above list should be configured. Choose any menu 
option (1, 2, 3 <P> Process, <X> Exit).

After completing the parameter setup, proceed with option P. 

Once installation is completed successfully, execute the post-installation steps outlined in the 
section Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Deploying the Write Back

• Enabling the Analytics Help

• Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise 
Edition 11.1.1.7.1
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Deploying the Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the Oracle Utilities Analytics Dashboard Package installation directory. This RPD 
file should be copied to the Windows machine on which Oracle Business Intelligence Enterprise 
Edition 11.1.1.7.1 is installed.

To deploy the repository (RPD) file, follow these steps:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should have been installed on the 
Windows machine before proceeding with the steps below.

2. Launch the Administration Tool from the Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.

5. Edit the connection pools as shown below by double-clicking on them.
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6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password

9. In the MDM Database Connection group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following:

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following:

Datasource name = BI database name

User name = DWREAD
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Password = DWREAD User password

12. Click Save.

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the OBIEE Enterprise Manager.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.

The repository text box is enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password as “oracle123”. Click Apply.

18. Activate the changes, and then restart the Oracle Utilities Analytics services.

Note: All the above databases set in the connection pool should be updated in 
the tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.
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Deploying the Web Catalog
To deploy the web catalog, follow these steps:

1. Go to the <Catalog location>/root/shared and delete the existing catalogs that were 
delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any 
catalog added by you can be retained.

2. Go to the <Catalog location>/root/system, and remove spatial metadata and 
spatialmetadata.atr contents.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the command:

 ./splenviron.sh -e <envname> 

3. cd $SPLEBASE/bin.

4. Run the ksh ./deploycatalog.sh.

5. Enter the location of the physical catalogs configured in Enterprise Manager.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

Note: Make sure that the following environment variables are set:

ORACLE_INSTANCE

COMPONENT_NAME

Verify catalog location is referring to the correct location:

$ORACLE_INSTANCE\bifoundation\OracleBIPresentationServicesCompo
nent\$COMPONENT_NAME\catalog\OracleBIApps

For Windows:

Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deploycatalog.cmd.

5. Enter the location of the physical catalogs configured in the Enterprise Manager. 

Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Note: Make sure that the following Environment variables are set:

ORACLE_INSTANCE

COMPONENT_NAME
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Verify catalog location is referring to the correct location:

%ORACLE_INSTANCE%\bifoundation\OracleBIPresentationServicesComp
onent\%COMPONENT_NAME%\catalog\OracleBIApps

Configuring and Deploying the MapViewer
To configure and deploy the MapViewer, follow these steps:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

Configuring the MapViewer
To configure the MapViewer, follow these steps:

1. Update the mapViewerConfig file with the below mentioned tags:

File location: < OBIEE_INSTALL_DIR >/Oracle_BI1/bifoundation/jee/mapviewer.ear/
web.war/WEB-INF/conf/

File: mapViewerConfig.xml

If there is proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,de.tiles.weatherbug.com
</proxy_enabled_hosts>

2. Add the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

3. Add the current map_tile_server with the following map_tile_server node.

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

4. Add the following with appropriate values:

<map_data_source name="MAPCONN"
jdbc_host="<DB_HOST>"
jdbc_sid="<SID of the Database>"
jdbc_port="<DB_PORT>"
jdbc_user="DWADM"
jdbc_password="!<DWADM PASSWORD>" jdbc_mode="thin"
number_of_mappers="32" allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted.

Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1
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For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesComponent\coreapplication_obips1
Perform the following changes to instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags:

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Write Back
The purpose of the write back templates is to allow the user to configure Administrative 
dashboards. This is mandatory for the Admin Dashboard functionality to work.

To deploy the write back feature, follow these steps:

For UNIX: 
Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deploywriteback.sh.

5. Log into Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database. 

6. Click Denied:Authenticated User and select Granted.
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For Windows: 
Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run the deploywriteback.cmd.

5. Log into Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database. 

6. Click Denied:Authenticated User and select Granted.

Enabling the Analytics Help
To enable the Analytics' Help, follow these steps:

1. Download Oracle Utilities Analytics v2.5.1 User's Guide from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.1 User's Guide, change the name of the 
OUA_UserGuide_2.5.1.pdf file to OUASA Help.pdf.

3.  Now, place the Help file in the $SPLEBASE/Skin/res directory.

4. Run the following commands:

For UNIX: 
Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployanalyticsear.sh.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows: 
Perform the following steps: 

1. Navigate to the <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run the deployanalyticsear.cmd.

5. Enter the WebLogic Domain Console Password. For example, weblogic123

6. Restart the Analytics core services.

7. Restart the WebLogic and all the Analytics services after the Oracle Business Intelligence 
Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Perform the following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services.

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start and stop the admin server, 
managed server and opmn services.
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2. Log into the Analytics (http://<Server>:<port>/analytics).

3. Click on the Weblogic User (top-right of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON and click OK.
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Chapter 6 
Upgrading Oracle Utilities Analytics 

This chapter provides an overview of upgrading Oracle Utilities Analytics v2.5.1 from an earlier 
version:

• Supported Upgrade Paths

• Key Points for Oracle Utilities Network Management System’s Users

• Upgrading Oracle Utilities Analytics

• Post-installation Checklist

Supported Upgrade Paths
The direct upgrade to Oracle Utilities Analytics v2.5.1 is supported from the following version: 
Oracle Utilities Analytics v2.5.0.0.1 / or v2.5.0.0.2

Important Note: For upgrading from a version not supported by direct 
upgrade path, the product must be first upgraded to Oracle Utilities Analytics 
v2.5.0.0.1, and then upgraded to Oracle Utilities Analytics v2.5.1.

Key Points for Oracle Utilities Network Management System’s 
Users

Here are a few points which an Oracle Utilities Network Management System’s user should 
remember: 

1. Oracle Utilities Network Management System (NMS) will not be supported with Oracle 
Warehouse Builder starting with Oracle Utilities Analytics 2.5.1.

2. Before upgrading Oracle Utilities Network Management System instance to 1.12.0.1 or 
Oracle Utilities Analytics to 2.5.1, ensure that the final extracts have been generated and 
loaded to the warehouse database. Once final extracts have been loaded, ensure that no one 
accesses the Oracle Utilities Network Management System application until Oracle Utilities 
Analytics ELT component based on the Oracle Data Integrator is set up. 

3. While loading the final extracts or upgrading the Oracle Utilities Network Management 
System application, you can install the software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics ELT Component based on Oracle 
Data Integrator on the target database in parallel.
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4. Once Oracle Utilities Network Management application has been upgraded to 1.12.0.1, 
follow the steps to configure the Oracle Utilities Network Management application with 
Oracle Data Integrator mentioned in the section “Upgrading Oracle Utilities Analytics 
Database Component” and “Installing Oracle Utilities Analytics ELT Component 
based on Oracle Data Integrator”

After executing the steps mentioned in the section “Installing Oracle Utilities Analytics 
ELT Component based on Oracle Data Integrator”, note the timestamp using the query 
given below on the target database:

alter session set nls_datE_format ='DD-MON-YYYY HH24:MI:SS';
select max(COMPLETED_ON) from <Context code>REP.CDC_SYNC_LOG;

where <Context code> is the context Code with which NMS instance is 
configured.

After noting the timestamp, Oracle Utilities Network Management System application 
can be released to the end users.

5. If any customizations have been done previously on the Oracle Utilities Network 
Management System extractors to populate the UDX columns for any of the facts or 
dimensions, the same needs to be copied in the new Oracle Data Integrator based ELT 
methodology.

For details, refer to the Chapter 5: Extending Oracle Utilities Analytics in 
Oracle Utilities Analytics Administration Guide.

6. Any change to the Oracle Data Integrator ELT metadata configuration must be done before 
starting the ELT jobs. These metadata configurations can be maintained using Oracle Utilities 
Analytics Administration Tool.

Specifically refer to the following pages in the Oracle Utilities Analytics Administration Tool:

• Target Entity (for scheduling related configuration)

• Global Configuration (for global settings of the Oracle Utilities Analytics product)

The details about these pages can be found in Appendix B of the Oracle Utilities Analytics 
Administration Guide. The chapter 3 of this guide has detailed information on how to configure 
the Oracle Utilities Analytics product completely.

7. The ELT jobs for the existing facts and dimensions of Oracle Utilities Network Management 
System should be updated to start the data load after the timestamp of the last set of data 
loaded via the Oracle Warehouse Builder based ETL as mentioned in the step 2.

update MDADM.B1_JOB_CONFIG
set SLICE_START_DTTM = <timestamp from Step 7>
where PROD_FLG = 'NMS'
and TARGET_ENTITY_ID in (
select TARGET_ENTITY_ID from MDADM.B1_TARGET_ENTITY
where ENTITY_NAME in
('CD_ACCT', 'CD_ADDR', 'CD_CALL_INFO', 'CD_CITY', 'CD_CREW', 

'CD_CTRL_ZONE', 'CD_DEVICE', 'CD_EVENT', 'CD_EVENT_STATUS', 
'CD_FEEDER', 'CD_METER', 'CD_PER', 'CD_PHASE', 'CD_PREM', 'CD_SNL', 
'CD_STORM', 'CD_STORM_OUTAGE_TYPE','CD_SW_PLAN','CD_SW_PLAN_STATE', 

'CD_USER', 'CF_CUST_RECENT_OUTG', 'CF_CUST_RST_OUTG', 
'CF_RECENT_CALL','CF_RECENT_CREW', 'CF_RECENT_JOB', 'CF_RST_CALL', 
'CF_RST_CREW', 'CF_RST_JOB', 'CF_SW_PLAN', 'CF_SW_PLAN_STATE'));

For the Snapshot fact ETL jobs alone, the timestamp should be updated on the first / second 
of the next month. For example, if the last sync timestamp in the step 7 is "12-NOV-2013 
04:02:30", then the arrears ETL job should have the timestamp as "01-DEC-2013 00:00:00".

Use the below query on the target database to update the timestamp on the ETL jobs. Derive 
the timestamp to be used based on the timestamp from the step 7.
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update MDADM.B1_JOB_CONFIG
set SLICE_START_DTTM = <First second of next month to load>
where PROD_FLG = 'NMS' 
and TARGET_ENTITY_ID in 
(select TARGET_ENTITY_ID from MDADM.B1_TARGET_ENTITY
where ENTITY_NAME in 

('CF_FEEDER_DLVRD_LOAD','CF_OUTG','CF_CTRL_ZONE_OUTG','CF_CITY_OUTG'))
;

Note: The above queries will not update the timestamp for the ELT jobs of the 
new Oracle Utilities Network Management System dimensions. This is because 
these tables are loaded from the start. Hence, the default slice timestamp 
populated on these jobs will be left as is.

8. Start the Oracle Data Integrator ELT jobs using the Oracle Utilities Analytics Administration 
tool.

Note: Refer to the Configuring the Jobs section in the Appendix B of Oracle 
Utilities Analytics Administration Guide. The Enable Jobs page helps to mass 
enable the ELT jobs for a specific source product instance.

Upgrading Oracle Utilities Analytics
Note: During the upgrade, it must be noted that the transition from Oracle 
Warehouse Builder based ETL to Oracle Data Integrator based ELT also 
happens. If there were any customizations done on the source product Oracle 
Utilities Network Management System Extractors or on the Oracle Warehouse 
Builder workflows in the Oracle Utilities Analytics product, then similar 
functional customizations will have to be done again in the Oracle Data 
Integrator based ELT.

For additional details on how to customize the Oracle Utilities Analytics, refer 
to the Chapter 5: Extending Oracle Utilities Analytics in Oracle Utilities 
Analytics Administration Guide.

To upgrade to Oracle Utilities Analytics v2.5.1, users must upgrade to Oracle Utilities Analytics 
2.5.0.0.1 if it is on different version of product.

Note: If any source application is configured with Oracle Data 
Integrator to Oracle Utilities Analytics application, sync Oracle 
GoldenGate first to ensure that all the changes done on the source side 
have been replicated to the replication schema, and then bring down the 
source application to make sure that no one is accessing the application 
until the upgrade steps are completed. And also, make sure to release the 
source application to the end user after completing all the upgrade steps.

This section describes the procedure to upgrade Oracle Utilities Analytics v2.5.1:

• Upgrading Oracle Utilities Analytics Database Component

• Installing Oracle Utilities Analytics ELT Component based on Oracle Data 
Integrator 
(applicable only if you have installed Oracle Utilities Network Management System, Oracle 
Utilities Operational Device Management, or Oracle Utilities Customer Care and Billing).

• Upgrading Oracle Utilities Analytics ETL Component based on Oracle Warehouse 
Builder 
(applicable only if you have installed Oracle Utilities Work and Asset Management, Oracle 
Utilities Mobile Workforce Management, or Oracle Utilities Meter Data Management).

• Upgrading Oracle Utilities Analytics Dashboard Component

• Installing Oracle Utilities Analytics Admin Tool Component 
(applicable only if you use Oracle Data Integrator based ELT).
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Upgrading Oracle Utilities Analytics Database Component 
This section describes the upgrade installation of the database. The following topics are discussed 
in this section:

• Preinstallation Tasks

• Upgrading the Database Software Version

• Copying and Decompressing the Install Media

• Creating the Users and the Tablespaces

• Installing the RELADM Schema

• Installing the MDADM Schema

• Upgrading the DWADM Schema

• Post-Installation

• Configuring the Spatial Data

Preinstallation Tasks
Perform the following tasks:

• Copy the DuplicateRecordCheck.sql file from the BI251\DWADM\Pre-Installation 
directory to the database server under ../<Temp> directory.

• Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

Note: If it displays no rows selected, it is good to proceed. If it displays some 
data, then contact support team and do not proceed with the installation. It is 
recommended to wait until you get the data fix script.

Upgrading the Database Software Version
Oracle Utilities Analytics version 2.5.1 supports both 11.2.0.3 and 12.1.0.1.0 versions of Oracle 
database server.

If a source application uses Oracle Data Integrator based ELT and is on 11g database, then there 
is no need to upgrade the database software.

Oracle Utilities Analytics supports Oracle Data Integrator based ELT from the source database on 
11g to the target database on 11g and the source database on 12c to the target database on 12c. It 
means that the source and the target database versions must match.

If the source application is upgraded to 12c, upgrade your Oracle Utilities Analytics database to 
12c. It is recommended to upgrade the database software and Oracle Warehouse Builder version 
to 12.1.0.1.0, and not to delete the old Oracle home until all the upgrade steps are executed.

Copying and Decompressing the Install Media
To copy and then decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics version 2.5.1Oracle Database part (Oracle Utilities 
Analytics V2.5.1Oracle Database Multiplatform.zip) from the Oracle Software Delivery 
Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.1Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.
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4. Unzip the zip file <TEMPDIR>/OUA-V2.5.1-Database-Multiplatform.zip using any zip 
utility.

Creating the Users and the Tablespaces
The following are the steps to be followed for creating users and tablespaces required:

1. Ensure to create users in the database with the following names: DWADM, DWUSER, 
DWREAD, MDADM, RELADM, SPLADM, SPLUSER, SPLREAD, MASTER_REPO, 
WORK_REPO and DWSTAGE if these do not exist already, without giving specific roles.

2. Ensure to create roles with the following names: DW_USER, DW_READ, 
DW_REPLICATE, SPL_USER and SPL_READ roles if these do not exist already.

3. Connect to the sys user, execute the Usersgrants.sql in BI251/Scripts/Usersgrants.sql. This 
SQL provides the required grants to the users created above.

Installing the RELADM Schema
The RELADM schema is a metadata schema that consists of database objects used for storing the 
product version and the component installation information.

This section describes the initial installation of the RELADM schema, including:

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package).

Java Home. For example: C:\Java\jdk1.6.0_20.

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI251\RELADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the RELADM 
user do not have quota on CISTS_01 tablespace, you must edit the 
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tablespace name in Storage.par to tablespace name on which the 
RELADM has quota.

Installation Steps
Perform the following steps to install the RELADM schema:

Note: Ensure the CDXDBI.exe (in the step below) is run from a Windows 
desktop that has the Oracle 11.2.0.3 +32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

1. Run the CDXDBI.exe from ..\BI251\RELADM\Install-Upgrade. Run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database:<DB NAME>

• The password for the system user account in the database (in silent mode)

• The name of the owner of the database schema: RELADM

• The location of the Java home: <..\jdk1.6.0_20>

• The location of TUGBU Jar files: <..\BI251\RELADM\Jarfiles>

• The password for the user (in silent mode): <RELADM user password>

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
metadata of Oracle Utilities Analytics. For example ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes the initial installation of the MDADM schema, including:

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics 

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide value: MDADM.
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• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package).

 Java Home. For example: C:\Java\jdk1.6.0_20.

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI251\MDADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the MDADM 
user do not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in the Storage.par file to tablespace name on which the 
MDADM has quota.

Installation Steps
Perform the following steps to install the MDADM schema:

Note: Ensure the CDXDBI.exe (in the step below) is run from a Windows 
desktop that has the Oracle 11.2.0.3 +32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

1. Run the CDXDBI.exe from ..\BI251\ MDADM\Install-Upgrade. Run the utility from the 
command prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>

• The password for the system user account in the database (in silent mode)

• The name of the owner of the database schema: MDADM

• The location of Java home: <..\jdk1.6.0_20>

• The location of TUGBU Jar files: <..\BI251\MDADM\Jarfiles>

• The password for the user (in silent mode): <MDADM user password>

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.
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• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Upgrading the DWADM Schema
The DWADM schema contains the star schema objects, such as facts and dimensions that contain 
all the data of the data warehouse. Follow these steps before upgrading the DWADM schema:

• Copy the …\Pre-Installation\PreInstallAddColumns.sql and …\Pre-Installation 
\PreIndexCreation.sql scripts to the database server under ../<Temp> directory.

• Change the current directory to ../<Temp>.

• Connect to the DWADM schema and execute the PreInstallAddColumns.sql.

• Connect to the DWADM schema and execute the PreIndexCreation.sql.

This section describes how to upgrade an existing Oracle Utilities Analytics target schema to 
Oracle Utilities Analytics v2.5.1, including:

• Reviewing the Storage.par File

• Upgrade Steps

• Generating the Database Statistics

The upgrade process prompts you for the names of three database users:

• A user who owns the application schema. For example, DWADM.

• A user with the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.

• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The upgrade process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. The application will access the database as. For example, the 
DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• The location for jar files. (The Jar files are bundled with the database package.).

Java Home. For example, C:\Java\jdk1.6.0_20
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Reviewing the Storage.par File
The storage.par file (that comes with the product and is in location ..\BI251\DWADM\Install- 
Upgrade) allocates all base tables and indexes to the default tablespace CISTS_01. If you decide to 
allocate some tables or indexes outside of the default tablespace, then this has to be reflected in 
the storage.par file by changing the tablespace name from the default value to a custom value, 
according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a 
table, or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace, or the DWADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
tablespace name in Storage.par file to tablespace name on which 
DWADM has quota.

Upgrade Steps
To upgrade the Oracle database, perform the following steps:

Note: Ensure the CDXDBI.exe (in the step below) is run from a Windows 
desktop that has the Oracle 11.2.0.3 + 32 bit client and Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for target. 

1. Run the CDXDBI.exe from..\BI251\DWADM\Install-Upgrade. Run this utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>

• The password for the SYSTEM user account in the database (in silent mode) 

• The name of the owner of the database schema: DWADM

• The location of Java home: <..\jdk1.6.0_20>

• The location of TUGBU Jar files: <..\BI251\DWADM\Jarfiles> 

• The password for the user (in silent mode): <DWADM user password>

• The Oracle user with the read-write privileges to the database schema: DWUSER

• The Oracle user with the read-only privileges to the database schema: DWREAD

• The Oracle database role with the read-write privileges to the database schema: 
DW_USER 

• The Oracle database role with the read-only privileges to the database schema: 
DW_READ

2. If you chose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

Generating the Database Statistics
During an install process, the new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Post-Installation
Connect to DWADM schema of Oracle Utilities Analytics database and execute the following:

...\BI251\DWADM\Post-Upgrade\ControlZoneUpdate.sql 
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Configuring the Spatial Data
Note: See Spatial Configuration to configure the spatial data if application is 
not already configured.

This section describes how to load the spatial metadata in the USER_SDO* tables for Oracle 
Utilities Analytics. If spatial data is already configured in application, follow the steps mentioned 
below. 

Use the following procedure to load the spatial metadata in the target database:

Loading the Spatial Metadata in the Target Database

1. Create the dump_dir directory in the database and copy user_sdo.dmp file from ../BI251/ 
Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command: 

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile= 

impdp_user_sdo.log schemas=DWADM 
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from the database server.

Note: Make sure to change the tablespace_name to the tablespace name on 
which the DWADM has the quota. If the DWADM tablespace has quota on 
cists_01 tablespace, then exclude whole remap_tablespace clause from the 
command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts in the command prompt from ../
BI251/Spatial-Metadata folder:

• sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

• sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files. 

Additional Steps to be followed for a SSL Based Configuration
1. Login to the DWADM schema.

2. Execute the below commands to ensure that map reports will use the secure https connection 
to fetch map tile data.

-- Take a backup of the existing record

insert into USER_SDO_CACHED_MAPS 
select 'CM_WORLD_MAP_BACKUP', DESCRIPTION, TILES_TABLE, IS_ONLINE, 

IS_INTERNAL, DEFINITION, BASE_MAP, MAP_ADAPTER 
from USER_SDO_CACHED_MAPS 
where NAME='B1_WORLD_MAP';

-- Update elocation map to specify https in the url
update USER_SDO_CACHED_MAPS 
set DEFINITION = replace(DEFINITION, 'url="http://', 'url="https://

') 
where NAME='B1_WORLD_MAP';

select DEFINITION from USER_SDO_CACHED_MAPS where 
NAME='B1_WORLD_MAP';

-- Verify the update and commit
commit;
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Installing Oracle Utilities Analytics ELT Component based on Oracle Data 
Integrator

Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ETL component that is used to install all the related 
software. Refer to the section Prerequisite Software.

Note: You must install the Oracle Utilities Analytics ELT component based on 
Oracle Data Integrator (ODI) only if you are using Oracle Utilities Network 
Management System, Oracle Utilities Operational Device Management or 
Oracle Utilities Customer Care and Billing as the source applications.

Note: Oracle Utilities Network Management System, Oracle Utilities 
Operational Device Management or Oracle Utilities Customer Care and Billing 
application set up is a prerequisite in order to install Oracle Data Integrator 
based ELT component. The source applications should be setup with the 
required configurations before proceeding with the Oracle Data Integrator 
based ELT component installation in order to successfully extract data from 
them to Oracle Utilities Analytics.

Refer to the chapter Configuring Oracle Utilities Network Management 
System for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Network Management System Data Mapping Guide.

Refer to the chapter Configuring Oracle Utilities Operational Device 
Management for Business Intelligence in Oracle Utilities Extractors and 
Schema for Oracle Utilities Operational Device Management Data Mapping Guide.

Refer to the chapter Configuring Oracle Utilities Customer Care and 
Billing for Business Intelligence in Oracle Utilities Extractors and Schema for 
Oracle Utilities Customer Care and Billing Data Mapping Guide.

This section describes how to install the ELT component of Oracle Utilities Analytics. The section 
includes the following:

• Setting up Oracle GoldenGate

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Oracle Utilities Analytics ELT Component based on Oracle Data Integrator Package 
Installation Steps

• Post-installation Tasks

• Generating the Security and Starting the Oracle Data Integrator Schedule

Setting up Oracle GoldenGate 
Note: This section describes setups required in Oracle GoldenGate to work 
with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its 
installation document.

Note: You should install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator (ODI) only if you are using Oracle Utilities 
Operational Device Management or Oracle Utilities Customer Care and Billing 
as the source application.

Download Oracle GoldenGate 12.1.2.0.0 from the Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers:

• Setting up Oracle GoldenGate on the Source Database Server

• Setting up Oracle GoldenGate on the Target Database Server
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Setting up Oracle GoldenGate on the Source Database Server
Bring down the source application to ensure that no one is accessing the application.

Note: If you have 11g instance of Oracle GoldenGate for Oracle Utilities 
Analytics already running, stop all the Oracle GoldenGate processes on 
the source database server, install the 12c Oracle GoldenGate software in 
the new home and start the manager process on the same port used for 
11g Oracle GoldenGate manager process.

Perform the following steps to stop 11g Oracle GoldenGate processes:

1. Log into the 11g Oracle GoldenGate prompt by executing ggsci. 
Info all will show running GG processes.

2. dblogin userid <GG owner>@<hostname>:<port no>/<DB Service name>,password  
<GG owner password>

3. stop <GG process name>

4. stop mgr

5. info all  
Check the status of Oracle GoldenGate processes. It shows that the processes are stopped.

Perform the below steps for setting up the source database server for Oracle GoldenGate: 

1. Create a directory on the source database server.  
For example:  ../GoldenGateHome. Oracle GoldenGate should be installed in this directory. 
This will be the Oracle GoldenGate home (OGG_Home) on the source database server.

Important Note: Make a note of this directory location; it will be used during 
Oracle Utilities Analytics installation.

2. Open a Command window and set the source ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

3. In the Command window, change the directory to GoldenGate home directory and execute 
the command as shown below:

For Unix:

./ggsci

For Windows:

ggsci

This opens the Oracle GoldenGate prompt.

4. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

5. On the Oracle GoldenGate prompt, execute the EDIT PARAMS mgr command. This 
command opens the editor.

6. Copy the below contents: 

• PORT 7830

• DYNAMICPORTLIST 7830-7880
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Note: Make sure that the mentioned port range (7830-7880) is not in use. If 
they are in use, provide another available port range.

Note: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings such as Purge.

7. On the Oracle GoldenGate prompt, execute the start mgr command to start the 
GoldenGate manager process.

8. On the Oracle GoldenGate prompt, execute the info all - command to view the manager 
process is running. Exit Oracle GoldenGate by executing the exit command.             

9. Ensure that source database is in the archivelog mode.

10. Connect to the source database as the sys user and execute the alter database add 
supplemental log data (primary key) columns command.

11. Go to the Oracle GoldenGate home (OGG_Home) directory.

12. Connect to the database as sys user using SQL*Plus (OGG_Home should be the current 
directory while invoking SQL*Plus).

13. Create a new user only if the source database does not have Oracle GoldenGate owner 
already created, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and 
make sure to assign a tablespace to this user that is not assigned to any other user.

Important Note: Make a note of the Oracle GoldenGate Owner Username; it 
will be used during Oracle Utilities Analytics installation.

14. Execute Grant connect,resource,dba to <GoldenGate owner user created in the step 
mentioned above>.

15. Connect to the source application ADM schema such as CISADM and execute the below 
commands:

For Oracle Utilities Customer Care and Billing source database, execute following 
grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above >

Grant select on F1_BKT_CONFIG to < GoldenGate owner user created in the step 
mentioned above >

Grant select on F1_BKT_CONFIG_VAL to < GoldenGate owner user created in the 
step mentioned above >

For Oracle Utilities Operational Device Management source database, execute 
following grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above>

Note: While executing the SQL commands in steps 16, 17 and 18, provide the 
GoldenGate owner user if prompted for.

Note: Skip the steps 16,17 and 18 if the source database already has 
GoldenGate owner created. The steps 16, 17 and 18 need to be executed only 
when the GoldeGate owner is created for the first time in the source database.
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16. Run the command from OGG_HOME if you are setting up Oracle Data Integrator 
components first: 
@marker_setup.sql

17. Run the command from OGG_HOME if you are setting up Oracle Data Integrator 
components first: 
@ddl_setup.sql

18. Run the command below from OGG_HOME if you are setting up Oracle Data Integrator 
components first: 
@role_setup.sql

19. Exit the SQL*Plus login and create a directory named diroby inside the OGG_Home 
directory.

Setting up Oracle GoldenGate on the Target Database Server
Note: It is recommended to use the same port for the 12c manager 
process that is used for 11g Oracle GoldenGate manager process if 11g 
Oracle GoldenGate is set up on the target server. If 11g instance of 
Oracle GoldenGate is running on the target server, stop the source 
application specific replicate Oracle GoldenGate processes.

Perform the following steps to stop 11g Oracle GoldenGate processes:

1. Connect to the 11g Oracle GoldenGate prompt. 
Info all shows the processes information.

2. dblogin userid MDADM@<hostname>:<port no>/<DB Service name>,password  
<MDADM password>.

3. stop <Source application specific GG process>.

4. delete <Source application specific GG process>.

5. stop mgr

Perform the following steps to setup the target database server for Oracle GoldenGate: 

1. Create a directory on the target database server.  
For example: ../GoldenGateHome. Oracle GoldenGate should be installed in this directory. 
This will be the Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities 
Analytics database server.

Important Note: Make a note of this directory location; it will be used during 
Oracle Utilities Analytics installation.

2. Open a Command window and set the target ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
3. In the Command window, change the directory to GoldenGate home directory and execute 

the command shown below:

For Unix:

./ggsci

For Windows:

ggsci
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This opens the Oracle GoldenGate prompt.

4. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

5. On the Oracle GoldenGate prompt, execute the EDIT PARAMS mgr. It opens an editor.

6. Copy the below contents:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

Note: Make sure that the mentioned port range (7830-7880) is not in use. If 
they are in use, provide another available port range.

Note: Make a note of the range start and end ports numbers; it will be used 
during Oracle Utilities Analytics installation.

Note: Refer to Oracle GoldenGate documentation if you would like to 
configure other settings such as Purge.

7. On the Oracle GoldenGate prompt, execute the start mgr command to start the 
GoldenGate Manager process.

8. On the Oracle GoldenGate prompt, execute the info all -command to view the manager 
process is running.

9. Exit the Oracle GoldenGate login by executing the exit command and create a directory 
named diroby inside the OGG_Home directory.

Copying and Decompressing the Install Media
The Oracle Utilities Analytics ETL component based on Oracle Utilities Analytics installation file 
is delivered in the zip format for both UNIX and Windows platforms. If you plan to install 
multiple Oracle Utilities Analytics environments operated by different Oracle Utilities 
Administrator User IDs, you must complete each of the following installation steps for each 
Administrator User ID.

1. Download the Oracle Utilities Analytics version 2.5.1ELT component based on Oracle Data 
Integrator part (Oracle Utilities Analytics V2.5.1ETL component based on ODI 
Multiplatform.zip) the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics administrator user ID.

3. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

4. Unzip Oracle Utilities Analytics V2.5.1ETL component based on ODI 
Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.5.1-MultiPlatform.jar as follows:

•   cd <TEMPDIR>

•  jar -xvf BI.ODI.V2.5.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ELT component based on Oracle Data Integrator 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub- 
directory named “BI.ODI.V2.5.1” is created. It contains the installation software for the Oracle 
Utilities Analytics ELT component based on Oracle Data Integrator.
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Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On the UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab table.

The install utility checks permissions, and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/ BI.ODI.V2.5.1directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before 
continuing with the installation process. The script initializes the cistab file in /etc directory (if it is 
the first Oracle Utilities Analytics application environment on the server) and registers a new 
environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case. If you plan to upgrade an existing 
environment, you must ensure to take a backup prior to the installation process. The installation 
utility does not create a backup of existing environment.

Oracle Utilities Analytics ELT Component based on Oracle Data Integrator 
Package Installation Steps

This section includes: 

• Prerequisites

• Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator

Prerequisites 
Before installing the Oracle Data Integrator package, ensure that you have already installed the 
below-mentioned software products. These software products should be installed on the database 
server: 

Also, note the locations of these software products:

• JDK 1.6.0 update 20 to 35 (JAVA_HOME) on the database server

• Oracle Database Home (ORACLE_HOME)

• WebLogic 10.3.6 (WL_HOME)

• Oracle Data Integrator 11.1.1.6 with Java EE Installation (ODI_HOME)

• Oracle GoldenGate 12.1.2.0.0 software on the source database server and the target database 
server (OGG_HOME) 
Download the Oracle GoldenGate 12.1.2.0.0 software from Oracle Software Delivery Cloud 
(https:// edelivery.oracle.com)

Now, follow the below instructions to install the Oracle Utilities Analytics ELT component based 
on Oracle Data Integrator.

Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator
There are two scenarios: 

• Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator 
(ODI) If You Are Using the 12c Database or Setting Up ODI Based ELT Component 
for the First Time

• Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator If 
You Are Using 11g Database or Had Already Set Up ODI Based ELT Component in 
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the Previous Release

Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator (ODI) If You 
Are Using the 12c Database or Setting Up ODI Based ELT Component for the First Time

If you are using the 12c database, follow these steps to install the Oracle Utilities Analytics ELT 
component based on Oracle Data Integrator after performing the steps to deploy the ELT 
component objects as described in the section above:

1. Change the current directory to <TEMPDIR>/ BI.ODI.V2.5.1.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl. It is required 
to run the installer.

3. Make sure that the user with which Oracle Database Enterprise Edition 12.1.0.1.0 was 
installed and all other prerequisite software products were installed, is used to install the 
Oracle Utilities Analytics ELT component based on Oracle Data Integrator package.

4. Execute the following script for UNIX/Windows:

For UNIX:

Run the following commands:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

Note: Ensure that you have the required execute permission on the install.sh.

For Windows: 

Run the following commands:

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH% 

• Install.cmd

5. The Oracle Utilities Analytics specific menu is displayed.

6. Select each menu item to configure the values.  
For the detailed description of the values, see Configuration Worksheet for ELT 
Component based on Oracle Data Integrator Installation.

Note: For parameter 'Target GoldenGate Shared Secret', follow the below 
instructions.

Note: All schema names must be entered in the upper case.

a. Go to the Oracle GoldenGate prompt and run the command:

encrypt password <password of MDADM user>, encryptkey DEFAULT

b.   Copy the encrypted password returned by the above command and provide it as the 
value for Target GoldenGate Shared Secret.
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Environment Installation Options

1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point:        
Environment Name:        
Web Java Home Directory:

Configure all the following items to guarantee a successful installation.  
Choose any option from the menu (1, 2 <P> Process, <X> Exit).

Environment Configurations

1. Environment Description 
Environment Description:

2. ODI Environment Configuration: 
WEBLOGIC HOME: 
ODI HOME: 
ODI SUPERVISOR USER: SUPERVISOR 
ODI SUPERVISOR Password: sunopsis123 
Target Database Name: 
Target Database Host:  
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password: <DWADM Password> 
ODI Master Schema Name: MASTER_REPO 
ODI Master Schema Password: < MASTER_REPO Password> 
ODI Work Schema Name:  
ODI Work Schema Password: 
ODI Master Repository ID: 601 
ODI Work Repository ID: 602 
MDADM Schema Name: MDADM 
MDADM Schema Password: <MDADM Password>

3. ODI Agent Configuration 
ODI Weblogic Agent Host: 
ODI Weblogic Agent Port:

4. Target GoldenGate Configuration 
Target GoldenGate Manager Port: 
Target GoldenGate Dynamic Minimum Port: 
Target GoldenGate Dynamic Maximum Port: 
Target GoldenGate Algorithm: 
Target GoldenGate Encryptkey: 
Target GoldenGate Shared Secret: 
Target Database Home: 
Target GoldenGate Home:

Configure the items of the above list to guarantee a successful installation. Choose any option 
from the menu item: (1, 2, 3, 4 <P> Process, <X> Exit).

After finishing the parameter setup, proceed with the option P. 

Once the installation is completed successfully, execute the post-installation steps outlined in the 
section Post-installation Tasks, and then the steps outlined in the section Starting ODI jobs.
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Installing Oracle Utilities Analytics ELT Component on Oracle Data Integrator If You Are 
Using 11g Database or Had Already Set Up ODI Based ELT Component in the Previous 
Release

If you are using Oracle Utilities Analytics components based on Oracle Data Integrator and 11g of 
the database, follow these steps to install the Oracle Utilities Analytics ELT component based on 
Oracle Data Integrator:

1. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred 
to<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

2. Unzip Oracle Utilities Analytics V2.5.1ETL component based on ODI Multiplatform.zip to 
<TEMPDIR>.

3. Decompress the file BI.ODI.V2.5.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.ODI.V2.5.1-MultiPlatform.jar

To set the Oracle Data Integrator environment, follow the below steps.

1. Connect to the RELADM schema and execute query "select server_name,env_dir from 
B1_INSTALL_COMPONENTS where comp_cd='BI_ODI'; " to get the server and Oracle 
Data Integrator environment directory details where Oracle Data Integrator environment is 
set up.

2. Login to the server and change the directory to <ODI environment directory>/etc and open 
the ENVIRON.INI file.

3. The value of SPLENVIRON variable is the Oracle Data Integrator environment name. Note 
down the Oracle Data Integrator environment name.

4. cd <ODI environment directory>/bin and execute ksh ./splenviron.sh -e <ODI 
environment name>.

5. Change the current directory to <TEMPDIR>/ BI.ODI.V2.5.1.

• Run the ksh ./install.sh

When prompted whether you want to upgrade existing installation, enter Y.

6. Select the option 4 to change the Oracle GoldenGate related parameter such as Oracle 
GoldenGate home, port if changed. 
After making all necessary configuration changes, enter P to proceed.

7. Run the ksh initialSetup.sh

Post-installation Tasks
The following are the sequential deployment steps to setup the successful deployment.

• Deleting the Oracle Data Integrator Metadata

• Deploying the ELT Component based on Oracle Data Integrator

• Generating the Views (Global)

• Configuring the Source

• Executing the Knowledge Modules (KMs)

• Generating the Views (For Source Context)

• Executing the B1_CLEANUP_STAG Scenario

• Creating the WebLogic Domain for Oracle Data Integrator Agent
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• Starting the WebLogic Admin Server

• Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting 
the Managed Server

Important Note: Before performing the post-installation tasks, a database 
directory ‘B1_DATA_DUMP_DIR’ should be created on the target database. 
This directory is used for logging the export import task used during the initial 
ELT load. The following is a sample SQL that creates the database directory 
pointing to the file system path /scratch/file_data:

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/
file_data';

Deleting the Oracle Data Integrator Metadata
Note: This section is applicable to you if you have installed Oracle Utilities 
Analytics component based on the Oracle Data Integrator and upgrading to 
Oracle Utilities Analytics 2.5.1. If you are setting up Oracle Data Integrator 
component from the scratch, this step is not required.

To delete the Oracle Data Integrator metadata, perform the following steps:

1. Stop the scheduler.

2. Bring down the Oracle Data Integrator Admin and Manage servers.

3. Log into Oracle Data Integrator console.

4. Navigate to Designer >Projects > Oracle Utilities BI. 

5. Right-click and select Delete. 

6. Connect to the MDADM schema and execute “select max(global_cfg_id) from 
b1_global_cfg;” to get the maximum value.

7. Advance the B1_GLOBAL_CFG_SEQ sequence to value returned by previous query.

Deploying the ELT Component based on Oracle Data Integrator 
In the Oracle Data Integrator (ODI) deployment step, the script creates the master and work 
repositories, and imports Oracle Data Integrator metadata. Run the following script. Note that the 
script may take several minutes to complete.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./deployodi.sh. 

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the deployodi.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log.
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Generating the Views (Global)
This step creates global views based on Oracle Data Integrator metadata.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./ runviewGenerator.sh.

For Windows:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run runviewGenerator.cmd.

Verify the log at the location: <SPLEBASE>/logs/system/deployodi.log. 

Configuring the Source
If you have already configured source instance and upgrading to Oracle Utilities Analytics 2.5.1, 
follow the below steps:

1. Run configureSourceDB.sh/cmd for each source instance configured  
ksh ./configureSourceDB.sh/smd  -c <Source context name> -u <GG owner> -p <GG 
Owner Password>  -s <Application Adm schema>  -r <Source application url>.

Choose any option (1, <P> Process, <X> Exit): 1.

2. Change the Oracle GoldenGate parameter such as GG home,ports if changed. If the source 
database is upgraded to 12c, then change the source database home parameter as well.

3. Press P.

If you are configuring the source instance for the first time, follow these steps.

Note: This step inserts each source instance and instance name into 
b1_prod_instance table. This step has to be repeated for each source 
instance that will be used. 

This step also creates replication schema in the target database corresponding to each source 
application. $SPLEBASE/bin/obiu.properties file is read to assign the default tablespace to 
replication user.

By default, this file has obiu.repository.default.tablespace = CISTS_01 entry where CISTS_01 
is tablespace name. If you want to assign this tablespace as default tablespace to replication 
schema, make sure to create CISTS_01 tablespace in the target database if it does not exist.

Make sure to edit obiu.repository.default.tablespace parameter in $SPLEBASE/bin /
obiu.properties file to another tablespace name, which exists in the database and it is considered 
the default tablespace for the replication schema. This entry should be changed as follows:

obiu.repository.default.tablespace = <Name of tablespace to use>

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.
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2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin

4. Run configureSourceDB.cmd -c <Source instance> -u < Source Golden gate owner schema 
name> -p <Source Golden gate owner Schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL>.

For Windows:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin

4. Run configureSourceDB.cmd -c <Source instance> -u <Source Golden gate owner schema 
name> -p <Source Golden gate owner Schema password> -s <Source Application Schema> 
-r <Source Application Drill Back URL>.

where,

• Source instance = Name for the source instance being added

For Oracle Utilities Operational Device Management source application, the valid values are 
ODM1,ODM2……..ODM9. Provide any of these values, which is already not configured. 
Make a note of these parameters; it will be used in the next deployment steps.

For Oracle Utilities Customer Care & Billing application, the valid values are 
CCB1,CCB2…….CCB9. Provide any of these values, which is already not configured.

For Oracle Utilities Customer Care & Billing application, the valid values are 
NMS1,NMS2…….NMS9. Provide any of these values, which is already not configured.

• Source Schema User = <GoldenGate owner created in the source database> For example: 
ODM01SRC.

• Source schema user password = GoldenGate owner password.

• Source application schema = source application schema (For example, CISADM).

• Source application drill back URL = source application URL (http://<Host>:<Port>/ouaf/
).

This opens a source configuration menu as shown below. Select each menu item to configure the 
values.

For the detailed description of the values, refer to the Configuration Worksheet for ELT 
Component based on Oracle Data Integrator Installation.

Note: For parameter 'Source GoldenGate Shared Secret', follow the below 
instructions.

a. Go to the Oracle GoldenGate prompt and run the command:

encrypt password <password of source GoldenGate owner user>, 
encryptkey DEFAULT

b. Copy the encrypted password returned by the above command and provide it as the 
value for Source GoldenGate Shared Secret.

Source GoldenGate Configuration 
Source Instance Name: 
Source GoldenGate Manager Port: 
Source GoldenGate Dynamic Minimum Port: 
Source GoldenGate Dynamic Maximum Port:   
Source GoldenGate Algorithm: 
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Source GoldenGate Encryptkey:  
Source GoldenGate Shared Secret: Source Database Name: 
Source Database Host:  
Source Database Port:  
Source Database Home:  
Source GoldenGate Home:

Each item in the above list should be configured for a successful install. Choose any option (1, 
<P> Process, <X> Exit).

Once the parameter setup is completed, proceed with option P. 

Executing the Knowledge Modules (KMs)
This step is run to reverse engineered source tables, set up the Journalizing Setup, and 
create the Oracle GoldenGate scripts. This step has to be repeated for each source 
instance configured in previous step.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./initiateSetup.sh -c <Source instance>.

Where source instance = Instance name given to the source in the Configure Source step 
mentioned above. For example: ODM1

5. In $SPLEBASE/GGScriptsGen, you will find a folder created starting with the instance 
name.

One or more directories may be created and the naming convention will be <contextcode> 
followed by two alphabets.

For example: ODM1AA.

6. Go to the folder that has name starting with the instance name.

For example: $SPLEBASE/GGScriptsGen/ODM1AA

Note: Refer to the ReadMe.txt generated in the above-mentioned directory 
for the detailed instructions on how to run the Oracle GoldenGate scripts and 
how to start the initial and the incremental loads.

Note: Ensure that ORACLE_SID and, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and the target database servers.

Note: During the Oracle GoldenGate script execution, you might get an error 
message (ERROR: OCI Error ORA-00955: name is already used by an existing 
object (status = 955)) related to the B1_CHECKPOINT table. It should be 
ignored.

Note: When using Oracle Database 12c, if the Oracle GoldenGate processes 
fails, verify the logs to check whether it is because of a DDL replication error. If 
it is due to DDL replication error, restart the Oracle GoldenGate process until 
it succeeds.

Note: The generated Oracle GoldenGate scripts need minor modifications 
when using Oracle Automatic Storage Management (ASM). Refer to Oracle 
GoldenGate installation documentation for more details.
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For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the initiateSetup.cmd.

Where Source instance = Instance name given to the source in the Configure Source step 
mentioned above. For example: ODM1

5. In %SPLEBASE%/GGScriptsGen directory, you will find the folder created starting with 
instance name. 

For example, ODM1AA.

6. Go to the folder that has name starting with the instance name.

For example, go to %SPLEBASE%/GGScriptsGen/ODM1AA

Refer to the ReadMe.txt generated in the above-mentioned directory for the 
detailed instructions on how to run the Oracle GoldenGate scripts and how to 
start the initial and the incremental loads.

Note: Ensure that ORACLE_SID, ORACLE_HOME and 
LD_LIBRARY_PATH are set before running the Oracle GoldenGate scripts 
on both the source and target database servers.

Note: During the Oracle GoldenGate script execution, you might get an error 
message (ERROR: OCI Error ORA-00955: name is already used by an existing 
object (status = 955)) related to the B1_CHECKPOINT table. It should be 
ignored.

Note: When using Oracle Database 12c, if the Oracle GoldenGate processes 
fails, verify the logs to check whether it is because of a DDL replication error. If 
it is due to DDL replication error, restart the Oracle GoldenGate process until 
it succeeds.

Note: The generated Oracle GoldenGate scripts need minor modifications 
when using Oracle Automatic Storage Management (ASM). Refer to Oracle 
GoldenGate installation documentation for more details.

Once Oracle GoldenGate scripts are executed, the source application can be released to the end 
users.

Generating the Views (For Source Context)
This step creates the views for a given source instance. These views are used for replication. This 
step needs to be executed once for each source configured.

For UNIX:

Perform the following steps:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run runviewGenerator.sh -c <Source Instance>.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.
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2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run ruvviewGenerator.cmd -c <Source Instance>.

Where source instance = instance name given to the source in the Configure Source step 
mentioned above. For example: ODM1

Note: After the completion of the Oracle Utilities Analytics deployment, if there are any 
changes done to the source configuration, the above script has to be executed for that source 
context to get them applied to Oracle Utilities Analytics.

Executing the B1_CLEANUP_STAG Scenario
Perform the following steps:

1. Login to Oracle Data Integrator console.

2. Navigate to Topology > Contexts.

3. Double-click on each context, except Global >Schemas. Check if the staging logical schema 
is mapped to B1.DWSTAGE physical schema. If staging logical schema is not mapped, then 
map it to B1.DWSTAGE, and click on some other mapping and save. Close and reopen to 
verify that the mapping has been saved.

4. Navigate to Designer >Load Plans and Scenarios > Framework > Data Fix > 
B1_CLEANUP_STAG.

5. Right click and execute. 

6. Select the context as Global and Logical agent as Local(no agent). And, check operator logs 
for completion.

Creating the WebLogic Domain for Oracle Data Integrator Agent
If you have already Oracle Data Integrator component installed and upgrading to Oracle Utilities 
Analytics 2.5.1, then start the Oracle Data Integrator Admin and Manage servers.

If you are installing Oracle Data Integrator components from the scratch, follow the below steps.

Create the WebLogic Domain for the WebLogic Agent (ODI Agent). Follow the below steps to 
bring up WebLogic ODI Agent, which is created in the step 1 Deploying the ELT Component 
based on Oracle Data Integrator. 

1. Go to the installed location for ODI: <MW_HOME>/Oracle_ODI1\common\bin, and 
then run the below commands for Unix and Windows. Provide the masterschema and 
workschema provided in the configuration.

For UNIX:

• Run /Config.sh

For Windows:

• Run config.cmd
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2. Create a new WebLogic domain.

Click Next. 

3. Generate a domain configured automatically to support the following products, select the 
checkboxes the below plugins mentioned. When you select these plugins, there are some 
automatic plugins that get selected.

• Oracle Enterprise Manager Plugin for Oracle Data Integrator -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0

Then, click Next to proceed.

4. Specify the Domain Name and Location.

Provide the name: odi_domain 
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Location will be default.

Click Next to proceed.

5. Configure Admin UserName and password for WebLogic. 
Provide the WebLogic password

Click Next. 

6. Configure Server StartUp Mode and JDK.

Select Production Mode.
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Provide the JDK 1.6.0_20.

7. Configure JDBC Component Schema.  
Select the checkbox ODI Master Schema and provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the checkbox ODI Master Schema. 

9. Select the checkbox ODI Work Schema. Provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO
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• Schema Password: WORK _REPO Password

Click Next to proceed.

10. Test JDBC Component Schema by selecting Select All and Test Connections. 

Click Next to proceed. 

11. On the Select Optional Configuration page, select the following checkboxes: 

• Administration Server 
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• Managed Server, Clusters and Machines

Click Next to proceed.

12. Configure the Administration server: 

Provide the listening port, which is not in use.

Click Next to proceed.

13. Configure the Managed servers by providing the following details: 

Name: odi_server1

Listen Address: All Local Addresses
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Port: <Provide the port>, which is configured in the Menu configuration of installation> 
ODI Agent Configuration >ODI WebLogic Agent Port>.

Configure Cluster.  
Click Next to proceed.

14. Configure Machines.  
Click Next to proceed

15. Assign Servers to Machines. 
Click Next to proceed.

16. Configuration Summary. 
Click Create to create the domain ODI_DOMAIN.

17. After the domain is created, go to Domain Location, create boot.properties file for 
WebLogic login.

18. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security folder if it was not created earlier.

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties with the below values:

username=weblogic

password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security folder if it is not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security, 
and then create boot.properties with the below values:

username=weblogic

password=Weblogic password
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Starting the WebLogic Admin Server 
Perform the following steps: 

1. In the command shell, change directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin

2. Execute the startweblogic command.

For Unix:

• nohup ./ startWebLogic.sh > startWebLogic.log &

For Windows:

• Run startWebLogic.cmd.

Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting the 
Managed Server

Perform the following steps: 

1. Go to <MW_HOME>/oracle_common/common/bin.

2. Execute the following command:

For Unix:

./wlst.sh

For Windows:

wlst.cmd

3. To connect to the running Admin server, execute the following command:

 connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')  

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for Oracle Data 
Integrator Supervisor: 

createCred (map="oracle.odi.credmap", key="SUPERVISOR", 
user="SUPERVISOR", password="<SUPERVISOR Password>", desc="ODI 
SUPERVISOR Credential")

5. To exit WebLogic Scripting Tool (WLST), execute the exit() command.

To start the managed server odi_server1

Perform the following steps: 

1. Change directory to WLS Home -<MW_HOME>/user_projects/domains/odi_domain/bin 
and execute the below commands:

For Unix:

nohup ./startManagedWebLogic.sh  odi_server1 > 
StartManagedWeblogic.log &

For Windows:

Run StartManagedWeblogic.cmd odi_server1

2. From the Oracle Data Integrator Studio, navigate to Topology > Agents> 
OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of 
configured Oracle Data Integrator Java EE agent.
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Generating the Security and Starting the Oracle Data Integrator Schedule
Perform the following steps: 

1. Edit the database name with the name of your database in OraGenSec.bat and run it from 
BI251/DWADM/Security folder.

2. Log into the Oracle Data Integrator studio and navigate to Designer > Load Plans and 
Scenarios > Framework.

3. Right-click B1_INITIAL_SETUP_PKG Version 001 and execute.

4. Select context global and WLS_AGENT as logical agent, and then click OK. 

5. Go to Operator and view the logs for successful execution of package.

6. In Oracle Data Integrator Studio, navigate to Designer > Load Plans and Scenarios > 
Framework > B1_RUN_ALL Version 001 > Scheduling. 

7. Right-click on Scheduling and select New Scheduling option.

8. Select the context global, agent as WLS_AGENT and log level as 1.

9. To specify how often the scheduler should run, navigate to the Execution Cycle tab of the 
Scheduler and select the 'Many Times' radio button. Set the interval between repetitions.

10. Navigate to the Topology > Agents > OracleDIAgent.

11. Right-click on the OracleDIAgent and click on Update Schedule.

Upgrading Oracle Utilities Analytics ETL Component based on Oracle 
Warehouse Builder 

This section describes the Oracle Warehouse Builder based ETL component installation: 

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Configuring and Upgrading the Oracle Warehouse Builder Workspace

• Post-upgrade Tasks

Copying and Decompressing the Install Media
The Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder installation 
file is delivered in zip format for both UNIX and Windows platforms. If you plan to install 
multiple Oracle Utilities Analytics environments operated by different Oracle Utilities 
Administrator user IDs, you must complete each of the following installation steps for each 
Administrator user ID.

Perform the following Steps: 

1. Download the Oracle Utilities Analytics V2.5.1ETL Component Based on Oracle Warehouse 
Builder part (Oracle Utilities Analytics V2.5.1ETL Component Based on OWB 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the database server host as the Oracle Utilities Analytics Administrator User ID 
(default cases).

3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory can be deleted after 
successful installation.

4. Unzip Oracle Utilities Analytics V2.5.1ETL Component Based on OWB 
Multiplatform.zip to <TEMPDIR>.
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5. Decompress the file BI.OWB.V2.5.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.5.1-MultiPlatform.jar 

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics ETL component based on Oracle Warehouse Builder 
installation package. Install the JDK that is supported for the install on your 
platform to be able to use the jar command. 
The Java packages are located at: http://java.sun.com/products/archive/
index.html. A sub-directory named "BI.OWB.V2.5.1" is created. It contains 
the installation software for the Oracle Utilities Analytics ETL component 
based on Oracle Warehouse Builder.

Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has write 
permissions to the /etc directory. Since the installation process is run by the Oracle Administrator 
User ID, this user ID may not be able to write to /etc/ cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.5.1directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
Administrator User ID so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, there is no need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every step in each specific case.

If you are planning to upgrade an existing environment, ensure that you have taken a backup prior 
to the initiating the installation process. The installation utility by itself does not create a backup of 
the existing environment.

Configuring and Upgrading the Oracle Warehouse Builder Workspace
This section describes how to configure the Oracle Warehouse Builder workspace:

• Upgrading Oracle Utilities Analytics If You Are Using 11g Database

• Upgrading Oracle Utilities Analytics ETL Component Based on Oracle Warehouse 
Builder If You Have Upgraded Oracle Database Server from 11.2.0.3 to 12.1.0.1.0

Upgrading Oracle Utilities Analytics If You Are Using 11g Database

Perform the following steps:

1. Back up the database using the backup strategy employed at your site.

2. Set the Oracle Warehouse Builder environment. To set the Oracle Warehouse Builder 
environment, follow the below steps:

• Connect to the RELADM schema and execute the query "select server_name,env_dir 
from B1_INSTALL_COMPONENTS where comp_cd='BI_OWB'; " to get the server 
and Oracle Warehouse Builder environment directory details where Oracle Warehouse 
Builder environment is set up.

• cd <OWB environment directory>/etc and open the ENVIRON.INI file.
Upgrading Oracle Utilities Analytics 6-100 
Oracle Utilities Analytics Installation Guide



• The value of the SPLENVIRON variable is the Oracle Warehouse Builder environment 
name. Note down the Oracle Warehouse Builder environment name.

• cd <OWB environment directory>/bin and execute ksh ./splenviron.sh -e <OWB 
environment name>.

Delete location.mdl and project.mdl files from $SPLEBASE/OWB/MetadataFiles 
directory if they are present.

3. Change the current directory to <TEMPDIR>/BI.OWB.V2.5.1.

4. Run ksh ./install.sh.  
Do you want to reinstall or Upgrade it? (Y/N):Y.  
Choose any option (1,2,3,4,5,6,7,8, <P> Process, <X> Exit): P.

5. cd $SPLEBASE/tmp.

6. Remove all the content from the tmp folder. Execute rm -rf *.

7. cd $SPLEBASE/bin.

8. Run ksh ./stopFileprocessordaemon.sh. It is recommended to wait until the file processor 
stops. It can be verified by executing "ps -ef|grep File" command.

Upgrading Oracle Utilities Analytics ETL Component Based on Oracle Warehouse 
Builder If You Have Upgraded Oracle Database Server from 11.2.0.3 to 12.1.0.1.0

Note: During Oracle Warehouse Builder installation, if the target DB is 12c, 
Oracle Warehouse Builder based ETL component should be installed in a 
separate Oracle Utilities Analytics environment (do not use the Oracle Utilities 
Analytics environment where Oracle Data Integrator based ELT component 
and Dashboard component are installed). During configuration of Oracle 
Warehouse Builder component, provide Oracle Warehouse Builder home as 
the DB home. This is needed for the owbdeploy script to pick the Oracle 
Warehouse Builder executables from the right location. If target DB is 11g, 
there are no such restrictions. Oracle Warehouse Builder can be installed in the 
same Oracle Utilities Analytics environment as other components (Oracle Data 
Integrator based ELT component and Dashboard component). In this case, 
provide 11g DB home during Oracle Warehouse Builder configuration.

Before upgrading, perform the following:

1. Verify that the prerequisite software products mentioned in the section Prerequisite 
Software for Oracle Utilities Analytics ETL Component based on Oracle Warehouse 
Builder are installed.

2. Ensure that 11.2.0.3 standalone Oracle Warehouse Builder is installed on the database server. 
This will be your new OWB_HOME.

3. Copy the entire owb/bin/admin directory from the old 11g installation to the new OWB 
_HOME/bin/admin directory.

4. Apply the patch 16568042 to new OWB home.

5. sqlplus OWBSYS/<OWBSYS_PASSWORD>.

6. Execute OWB_HOME/owb/UnifiedRepos/reset_owbcc_home.sql.

7. Provide the new OWB_HOME as input.

After performing the above steps, proceed with upgrading Oracle Utilities Analytics ETL 
component based on Oracle Warehouse Builder Package steps:

1. Set the Oracle Warehouse Builder environment. To set the Oracle Warehouse Builder 
environment, follow the below steps:

• Connect to the RELADM schema and execute the query "select server_name,env_dir from 
B1_INSTALL_COMPONENTS where comp_cd='BI_OWB'; " to get the server and Oracle 
Upgrading Oracle Utilities Analytics 6-101
Oracle Utilities Analytics Installation Guide



Warehouse Builder environment directory details where Oracle Warehouse Builder 
environment is set up.

• Create temp directory on the server where Oracle Warehouse Builder environment is set up.

• Copy the BI.OWB.V2.5.1-MultiPlatform.jar inside temp directory and execute jar -xvf 
BI.OWB.V2.5.1-MultiPlatform.jar.

Note: BI.OWB.V2.5.1-MultiPlatform.jar is inside Oracle Utilities Analytics 
V2.5.1 ETL Component Based on OWB Multiplatform directory.

• cd <OWB environment directory>/etc and open the ENVIRON.INI file.

• The value of SPLENVIRON variable is the Oracle Warehouse Builder environment name. 
Note down the Oracle Warehouse Builder environment name.

• cd <OWB environment directory>/bin and execute ksh ./splenviron.sh -e <OWB 
environment name>.

2. cd $SPLEBASE/bin. 

3. Run ksh ./stopFileprocessordaemon.sh. It is recommended to wait until the file processor 
stops. It can be verified by executing "ps -ef|grep File" command.

4. Open the new terminal/window and navigate to downloaded package.

Now, proceed with the installation of Oracle Utilities Analytics 2.5.1

Go to the current directory <TEMPDIR>/BI.OWB.V2.5.1.

5. Execute the following script on both UNIX and Windows:  
Make sure to provide the new OWB_HOME path.

For UNIX:

• export ORACLE_CLIENT_HOME=<OWB_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

For Windows:

• set ORACLE_CLIENT_HOME=<OWB_HOME> 

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH% 

• Run Install.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

6. The Oracle Utilities Analytics specific menu appears.

7. Select each menu item to configure the values.  
For the detailed description of the values, see Configuration Worksheet for ETL 
Component based on Oracle Warehouse Builder Installation.

Note: All the schema names must be entered in the upper case.

8. After the configuring the values, press P to continue the installation.
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9. Connect to database with the sys user and execute the below command:

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml','ACL for 
Control Center','OWBSYS', TRUE, 'connect'); 

EXECUTE 
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml','internal-mail-
router.oracle.com', 25);

COMMIT;
SELECT
acl,host, 

DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,'OWBSYS', 
'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege

FROM dba_network_acls ;
It shows the result as: 

ACL
------------------------------------------------------------------

--------------
HOST
------------------------------------------------------------------

--------------
PRIVILE
-------
/sys/acls/acl_for_owb_cc.xml
internal-mail-router.oracle.com
GRANTED

10. Modify the contents of the <owb-home>/owb/bin/admin/Runtime.properties file 
from the following to the contents mentioned:

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint
= DISABLED
property.RuntimePlatform.0.NativeExecution.Shell.security_constrai

nt =
DISABLED
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constr

aint
=DISABLED
To
property.RuntimePlatform.0.NativeExecution.FTP.security_constraint
= NATIVE_JAVA
property.RuntimePlatform.0.NativeExecution.Shell.security_constrai
nt = NATIVE_JAVA
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constr
aint = NATIVE_JAVA

11. Connect to the OWBSYS user and execute the <owb-home>/owb/rtp/sql/stop_service.sql.

12. Connect to the OWBSYS user and execute the <owb-home>/owb/rtp/sql/start_service.sql.

13. Log in to Oracle Warehouse Builder Design Center. Select Tools > Preferences >OWB 
Click on Security parameters. You will find a property called “Persist location password in 
metadata”. Select the check box, and then click OK to exit.

14. Navigate to Locations> Locations >Database.

Expand Oracle tab.

Double- click the SPL_BI_TGT_LOC location. Enter the password, test connection and 
Click OK.

15. Navigate to Locations > Locations >Process Flow and Schedules.

Expand Oracle Workflow.
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Double click the SPL_BI_WF_LOC locvation.Enter the password, test connection and click 
OK.

Environment Installation Options

1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name: 
Web Java Home Directory: 

Configure each item in the above list for successful installation. Choose any option from the menu 
items: (1, 2 <P> Process, <X> Exit).

Environment Configuration

1. Environment Description 
Environment Description:

2. Database Configuration 
OWB WorkSpace Owner: 
OWB WorkSpace Owner Password:  
Database Name: 
Database Server: 
Database Port:

3. Design repository configuration 

OWB WorkSpace User: 
OWB Workspace user Password:  
OWB WorkSpace Name:  
DWADM SCHEMA NAME: 
DWADM SCHEMA Password: 
WORKFLOW MANAGER SCHEMA NAME:  
WORKFLOW MANAGER SCHEMA Password:

4. Database character set configuration  
Database Character set: AL32UTF8

5. Editing process flow configuration 
Repository Operating System: 
Perl Compiler location: 
Data and control files location:  
Separator to be used: 
File Manager location:

6. Email configuration  
Email ID of Sender: 
Email ID for Reply-To address:  
Email ID of Receiver: 
SMTP server:  
SMTP server port:

7. Control Centre Configuration  
Repository Control Center Name:

8. External data source configuration 
Path of the External Datasource: 
Path of the External Datasource LOG: 
File Processor Daemon Execution Switch: 
File Processor Extract Max Load: 
File Processor Scheduler Poll Duration:60
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Configure each item in the above list for successful installation. Choose the any option from 
the menu items (1, 2, 3, 4, 5, 6, 7, 8 <P> Process, <X> Exit).

After completing the parameter setup steps, proceed with the option P. Write Configure file.

Once the install is completed successfully, execute the post-upgrade steps as described in the 
section Post-upgrade Tasks.

Post-upgrade Tasks
The post-upgrade tasks involve the following:

• Cleaning up Unused Oracle Warehouse Builder Objects from Oracle Warehouse 
Builder

• Deploying the ETL Workflows on Oracle Warehouse Builder

• Deploying the Oracle Warehouse Builder Workflows

• Deploying the Materialized Views

• Starting the File Processor

• Generating the Security

• Generating the Database Statistics

Cleaning up Unused Oracle Warehouse Builder Objects from Oracle Warehouse Builder
For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./drop_unused_owb_objects.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the drop_unused_owb_objects.cmd.

After running drop_unused_owb_objects.sh/cmd, connect to the target database as 
DWADM user and execute the command:

DROP package spl_oms_snapshot_pkg;

Deploying the ETL Workflows on Oracle Warehouse Builder
In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you need to make changes in the OMBPlus.sh file, located at: $OWB_HOME/owb/bin/ unix/
OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M 
- DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

You need to make this value larger than 1024MB (1GB) depending on the size of the import: 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*.
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Deploying the Oracle Warehouse Builder Workflows
This procedure needs to be performed if changes are made to the parallel settings on external 
tables, materialized views, or mappings on an existing installation and needs to be retained during 
the upgrade process.

Run the following command to generate a report on the parallel settings that is currently set in the 
customer repository on external tables, materialized views and mappings.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./parallelSetup.sh analyze.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin. 

4. Run the parallelSetup.cmd analyze.

5. This generates files under <SPLEBASE>/etc folder. 

6. Review the generated files for the existing settings and make modifications if necessary. Once 
the files are reviewed, perform the following steps to merge the existing settings with the 
default settings.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./parallelSetup.sh merge.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run parallelSetup.cmd merge.

5. Review the following files under <SPLEBASE>/etc and verify that the existing values have 
been merged correctly before proceeding:

cm-parallel-tables.txt  
cm-parallel-mvs.txt  
cm-parallel-maps.txt

6. Below is the format of parallel*.txt to change the <Degree> of parallelism in above-listed 
files: 

parallel-tables.txt file format: <Object_name>:<Degree> 
parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree> 
parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree> 

Run the following script. Note that the script may take several minutes to complete.
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For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run the ksh ./Owbdeploy.sh.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run the owbdeploy.cmd.

If you encounter below issue during deployment:

2014/09/09:23:39  <OMB_SUCCESS>  OMB05608: Connection to a Control 
Center has not been made.

2014/09/09:23:39  <ERROR>  OMB05608: Connection to a Control Center 
has not been made.

2014/09/09:23:39  <ERROR>  Unable to unregister Location 
SPL_BI_TGT_LOC

2014/09/09:23:39  <INFO>  See the Log at /scratch/bi_oradata_01/
QABlds/OUA_251_12c_OWB_ENV/bin/scripts/../../logs/system/
log_OWBDeployment_20140909_2338.txt

2014/09/09:23:39  <ERROR>  An error occured .Do you want continue 
?(Y/N): N

Follow the below steps and re-run the Owbdeploy.sh/ Owbdeploy.cmd script.

1. Log into Oracle Warehouse Builder client.

2. Navigate to SPL_BI>Configurations.  
Double-click on the DEFAULT_CONFIGURATION.  
Navigate to Control Center. Select the correct control center from drop-down that is 
configured while setting up the Oracle Warehouse Builder environment and click OK.  
Click Save.

3. Run the Owbdeploy.sh/ Owbdeploy.cmd script again.

Deploying the Materialized Views
Run the following commands for deploying materialized views. 

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

3. Run the below script for upgrading the materialized views:

• cd $PLEBASE\bin

• Run the ksh ./upgradeViews.sh

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

3. Run the below script for upgrading the materialized views.

• cd %SPLEBASE%\bin
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• Run upgradeViews.cmd

4. Once deployment is complete, remove the <SPLEBASE>/tmp content to ensure all the 
complete files are removed:

Starting the File Processor
For UNIX: 

cd $SPLEBASE/bin 

nohup ksh ./startFileprocessordaemon.sh >&1 & 

For Windows:

startFileprocessordaemon.cmd
Note: Go to <SPLEBASE>/logs/system to view the file processor log.

Generating the Security
Edit database-name with the name of your database in OraGenSec.bat after completing the 
Oracle Warehouse Builder deployment and run it from BI251/DWADM/Security folder.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Upgrading Oracle Utilities Analytics Dashboard Component
This section describes the dashboard component installation and includes the following:

• Prerequisite to the Dashboard Component Upgrade

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Oracle Utilities Analytics Dashboard Package Upgrade Steps

• Merging the RPD Files

• Post-upgrade Tasks

Prerequisite to the Dashboard Component Upgrade
Oracle Utilities Analytics Dashboard component v2.5.1 requires Oracle Business Intelligence 
Enterprise Edition version 11.1.1.7.1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 
should be installed in a new Middleware Home before proceeding with Oracle Utilities Analytics 
Dashboard component upgrade. Refer to Oracle Business Intelligence Enterprise Edition 
documentation for the details of installing 11.1.1.7.1.

Copying and Decompressing the Install Media
The Oracle Utilities Analytics Dashboard component installation file is delivered in a zip format 
for both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities Analytics 
environments operated by different Oracle Utilities Administrator user IDs, you must complete 
each of the following installation steps for each Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.1Dashboard Component part (Oracle Utilities 
Analytics V2.5.1Dashboard Component Multiplatform.zip) from the Oracle Software 
Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1 software is installed) as the Oracle Utilities Analytics Administrator User ID 
(default ceases).
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3. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred as 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory can be deleted after 
successful installation.

4. Unzip the Oracle Utilities Analytics V2.5.1Dashboard Component Multiplatform.zip 
to <TEMPDIR>.

5. Decompress the file BI.OBIEE.V2.5.1-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.5.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
Oracle Utilities Analytics dashboard component installation package. Install the 
JDK that is supported for the install on your platform to be able to use the jar 
command.  
 
The Java packages are located at: http://java.sun.com/products/archive/
index.html.

A sub-directory named “BI.OBIEE.V2.5.1” is created. It contains the 
installation software for the Oracle Utilities Analytics Dashboard component.

Setting Permissions for the Cistab File in UNIX
Note: Every Oracle Utilities Analytics environment installed on a server must 
be registered in the /etc/cistab file located on that server.

On UNIX servers, generally only the root user ID has write permissions to the /etc directory. 
Since the installation process is run by the Oracle administrator user ID, this user ID may not be 
able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.1directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Analytics application environment on the server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
administrator user ID, so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every step in each specific case.

To upgrade an existing environment, it is recommended that a backup be taken before initiating 
the installation process. The installation utility by itself does not create a backup of the existing 
environment.

Oracle Utilities Analytics Dashboard Package Upgrade Steps
Before upgrading, verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics Dashboard Component are installed.

To upgrade the Oracle Utilities Analytics Dashboard package, follow these steps.

1. Set the Dashboard environment. To set the Dashboard environment, follow the below steps.

• Connect to the RELADM schema and execute the query "select server_name,env_dir from 
B1_INSTALL_COMPONENTS where comp_cd='BI_OBIEE'; " to get the server and 
Dashboard environment directory details where Dashboard environment is set up.
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• cd <Dashboard environment directory>/etc and open the ENVIRON.INI file.

• The value of SPLENVIRON variable is the Dashboard environment name. Note down the 
Dashboard environment name.

• cd <Dashboard environment directory>/bin and execute ksh ./splenviron.sh -e <Dashboard 
environment name>

2. Change the current directory to <TEMPDIR>/BI.OBIEE.V2.5.1.

3. Run the ksh ./install.sh. 
Do you want to reinstall or Upgrade it? (Y/N): Y 
Choose any option (1,2,3, <P> Process, <X> Exit): P

Merging the RPD Files
If you have made custom changes to deployed RPD, follow the Oracle Business Intelligence 
Enterprise Edition documentation for merging.

Post-upgrade Tasks
Post-upgrade tasks involve the following:

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Deploying the Write Back

• Enabling the Analytics Help

• Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise 
Edition 11.1.1.7.1

Deploying the Repository (RPD) File
If you have not made any changes to the deployed RPD, then take the RPD file from the following 
location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where <install_dir> is the 
Oracle Utilities Analytics Dashboard Package installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should be installed on the 
Windows machine before proceeding with the below steps.

2. Launch the Administration Tool from the Start menu. 
Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...
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4. Provide the RPD password. The default password is "oracle123".

5. Edit the Connection Pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

9. In the MDM Database Connection group, provide the following (only for MDM): 

Datasource name = MDM database name
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User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

12. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit. 
The repository text box will be enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password “oracle123”, and then click Apply.

18. Activate the changes and then restart Oracle Utilities Analytics services.
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Note: All the above-mentioned database sets of the connection pool should be 
updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/
Oracle_BI1/network/admin.

Deploying the Web Catalog
To deploy the web catalogs, follow these steps: 

1. Go to <Catalog location>/root/shared and delete the existing catalogs that were delivered 
out-of-box with the Oracle Utilities Analytics product in the previous release. Any catalog 
added by you can be retained.

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager.  
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in the Enterprise Manager. 
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

Configuring the MapViewer
1. Update the mapViewerConfig file with the below-mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml
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If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node:

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,de.tiles.weatherbug.com
</proxy_enabled_hosts>

2. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

3. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

4. Add the following with the appropriate values:

<map_data_source name="MAPCONN"
 jdbc_host="<DB_HOST>" 
jdbc_sid="<SID of the Database>" 
jdbc_port="<DB_PORT>" 
jdbc_user="DWADM"
jdbc_password="!<DWADM PASSWORD>" jdbc_mode="thin" 

number_of_mappers="32" allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted.

Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of the location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>
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3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Write Back
For deploying the Write Back, perform the following steps:

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploywriteback.sh.

5.  Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

6. Click Denied:Authenticated User and select the permission Granted.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. Run deploywriteback.cmd.

5.  Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

6. Click Denied:Authenticated User and select the permission Granted.

Enabling the Analytics Help
To enable the Analytics’ Help, perform these steps: 

1. Download Oracle Utilities Analytics v2.5.1 User's Guide from Oracle Software Delivery Cloud 
(https:// edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.1 User's Guide, change the name of the 
OUA_UserGuide_2.5.1.pdf file to OUASA Help.pdf.

3. Place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Package installation directory.

4. Run the following commands: 
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For UNIX: 
Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deployanalyticsear.sh.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. deployanalyticsear.cmd.

5. Enter the WebLogic Domain Console password. For example, weblogic123.

6.   Restart the Oracle Utilities Analytics core services.

7.    Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the 
following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services. 

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start, stop admin server, managed server 
and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).

3. Click on the WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON, and click OK.

Installing Oracle Utilities Analytics Admin Tool Component
This is only applicable for users installing Oracle Data Integrator based ELT. Oracle Utilities 
Analytics Admin Tool is based on Oracle Application Express.

For the detailed instructions on how to set up the Admin Tool, refer to the chapter Installing the 
Oracle Utilities Analytics Admin Tool for the complete details.

Also, refer to Oracle Utilities Analytics Administrator’s Guide for details. 
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Post-installation Checklist
After the installation, perform the following steps: 

1. Verify the Install and Deploy logs.

• MDL Import Logs 
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 
<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB Deploy Logs 
<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt

• Custom Mapviewer deploy Logs 
INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack Logs 
<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon Logs 
<INSTALL_DIR>/bin/FileProcessorDaemon.log

2. Log into the Oracle Business Intelligence Enterprise Edition Analytics link. The 
Dashboard displays data with no errors.
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Chapter 7 
Demo Installation Procedure 

This chapter provides instructions for installing the demo database. 

Note: The demo installation does not support ETL functionality. The ETL 
Job Control dashboard accesses the Oracle Warehouse Builder and Oracle 
Data Integrator tables, and the demo dump does not have Oracle Warehouse 
Builder or Oracle Data Integrator objects. Hence, the ETL dashboard is not 
supported in the demo installation. 

The chapter includes the following topics: 

• Installing Oracle Utilities Analytics Demo Database Component

• Installing Oracle Utilities Analytics Dashboard Component

• Post-installation Checklist

Installing Oracle Utilities Analytics Demo Database Component
This section describes how to install the demo component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Creating the Database and Importing the Dump File

• Configuring the Security

• Configuring the Spatial Data

Copying and Decompressing the Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics V2.5.1Demo Data part (Oracle Utilities Analytics 
V2.5.1Demo Data.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.1Demo Data.zip to <TEMPDIR>. 
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Creating the Database and Importing the Dump File
This section describes how to create the demo database with AL32UTF8 character set using the 
database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows), including:

• UNIX Database Creation Utility

• Windows Database Creation Utility

• Importing Demo Data Manually

• Post-Import Tasks

Note: Ensure that Oracle Database Server Enterprise Edition 11.2.0.3 or 
12.1.0.1.0 is already installed on the machine in order to create the database. 

Note: The UNIX and Windows database creation utilities creates an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01.

Note: If you get the following error messages while importing demo data, it is 
recommended to ignore:

ORA-31684: Object type USER:"MDADM" already exists
ORA-31684: Object type USER:"RELADM" already exists
ORA-31684: Object type USER:"DWADM" already exists

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT EXECUTE ON "MDADM"."B1_TEXT_ARRAY" TO "CCB1REP"

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT SELECT ON "MDADM"."B1_PROD_INSTANCE" TO "CCB1REP"
Job "SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 5 error(s) 

UNIX Database Creation Utility
The files are located in BI251/DatabaseCreation/Unix to create the database.

1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command: 
perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO

ORACLE_BASE: The directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: The folder where the current version of Oracle software is installed (/
orasw/app/oracle/product/):

ORACLE_DATA: The directory where the data files for the database will be created (/db05/
oradata):

Character set for the database (AL32UTF8):
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5. Enter the values based on the settings of your database server. You can also accept the default 
values displayed if they match your database server settings. You will be prompted to confirm 
the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select Y to import the Demo Install data.

For the demo installation use the dump file exp_demo.dmp.

Do you want to import a demo database dump into this database (Y/N)? Y

Enter the name of the dump file (exp_demo.dmp):

Enter the name of the dump file directory (data_pump_dir):

Enter the name of the log file (exp_demo.log):

Note: The dump_dir must exist in the created database before continuing with the import. 
You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the 
exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in ..\BI251\Demo 
directory.

Update the oratab file for the new database, and then check the connectivity to this database 
from another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility
The files are located in ..\BI251\DatabaseCreation\Windows. You should be logged in as a user 
who is a member of local ORA_DBA group on that server. The ORA_DBA group should have 
“Administrator” privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump

C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select the option C to create an empty database on your machine and provide the below 
inputs:

• Provide the instance name (DEMO): <DB Name> e.g BIDEMO

• Enter the character set of the database (AL32UTF8) : AL32UTF8

• Enter ORACLE_BASE: The directory where the setup files for the database will be 
created (c:\oracle) : <Oracle_Base> e.g. C:\app\oracle
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• Enter ORACLE_HOME: The folder where the current version of Oracle software is 
installed (c:\oracle\product\11.1.0.6\Db_1) :<Oracle_Home> e.g 
c:\app\oracle\db_home

• Enter ORACLE_DATA: The directory where the data files for the database will be 
created (C:\app\oracle\oradata) :<Directory where data files will be created>

3. Once the database has been created, select the R - Refresh a schema option with a database 
dump file to load the demo install data.

• Select an option: R

• Enter the instance name (DEMO): <DB name>

• Is it a LOCAL database (exists on the same machine) (Y/N): < provide Y or N>

• Enter the name of the Oracle account that owns that application schema (spladm): 
DWADM

• Enter the password for DWADM (spladm): DWADM

• Enter the character set of the database (AL32UTF8): AL32UTF8

• Enter the name of data pump directory (DATA_PUMP_DIR): DATA_PUMP_DIR

• Enter the name of the dump file (expDWADM.dmp):exp_demo.dmp

• Enter the name of the log file (impDWADM.log):exp_demo.log

The option R causes the utility to drop all the objects from the schema and import the 
schema from a database dump file.

For the demo installation, use the exp_demo.dmp dump file.

Note: The dump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the dump_dir. Uncompress the exp_demo.dmp.gz file to extract the 
exp_demo.dmp file. This file is in the ..\BI251\Demo directory.

Check the connectivity to this database from another server and from your desktop after 
updating the local tnsnames.ora file.

Importing Demo Data Manually
The demo data can also be imported by using the below command after successful database 
creation.

Note: Run this command from the database server:

Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM, RELADM and MDADM have the quota. If DWADM, 
RELADM and MDADM users have quota on cists_01 tablespace, then exclude 
whole remap_tablespace clause from the command.

1. Set the correct ORACLE_SID and ORACLE_HOME first, and then run below command to 
import demo dump.

impdp directory= dump_dir dumpfile= exp_demo.dmp logfile=    
exp_demo.log schemas=DWADM,RELADM,MDADM 
remap_tablespace=cists_01:<tablespace_name>

2. Provide the system as the user and system user's password when prompted.
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Post-Import Tasks
Connect to MDADM schema, and execute the below commands:

create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;

grant select on B1_TARGET_ENTITY to public;
grant select on B1_PROD_INSTANCE to public;
grant select on B1_JOB_CONFIG to public;

Configuring the Security 
For configuring the security, perform the following steps: 

1. Navigate to the ..\BI251\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run OraGenSec.bat from a Windows desktop that has the 
Oracle 11.2.0.3+ 32 bit client installed. Your database should already be listed 
in the local file tnsnames.ora.

The script executes as the following:

oragensec -d DWADM,<DWADM password>,database_name -r 
DW_READ,DW_USER - a A -u DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from the command prompt.

Configuring the Spatial Data
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
BI251/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server.

Note: Make sure to change the tablespace_name to tablespace name on which 
DWADM has the quota. If DWADM user have quota on cists_01 tablespace, 
then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI251/Spatial-Metadata 
folder:

- sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.
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 Installing Oracle Utilities Analytics Dashboard Component
This section describes how to install the dashboard component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Setting Permissions for the Cistab File in UNIX

• Oracle Utilities Analytics Demo Database Component Installation Dashboard 
Package Installation Steps

• Post-installation Tasks

Copying and Decompressing the Install Media
The Oracle Utilities Analytics Dashboard Component installation file is delivered in the zip 
format for both UNIX and Windows platforms. If you plan to install multiple Oracle Utilities 
Analytics environments operated by different Oracle Utilities Administrator User IDs, you must 
complete each of the following installation steps for each Administrator User ID.

1. Download the Oracle Utilities Analytics V2.5.1Dashboard Component part (Oracle 
Utilities Analytics V2.5.1Dashboard Component Multiplatform.zip) from the Oracle 
Software Delivery Cloud (https://edelivery.oracle.com).

2. Log into the application server host (where Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1 software is installed) as the Oracle Utilities Analytics Administrator User ID 
(default ceases).

3. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred as 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All the files that are placed in this directory, can be deleted 
after a successful installation.

4. Unzip the Oracle Utilities Analytics V2.5.1Dashboard Component Multiplatform.zip 
to <TEMPDIR>.

5. Decompress the file BI.OBIEE.V2.5.1-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.5.1-MultiPlatform.jar

You should have Java JDK installed on the machine used to (un)jar the Oracle Utilities Analytics 
dashboard component installation package. Install the JDK that is supported for the install on 
your platform to be able to use the jar command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html.

A sub-directory named “BI.OBIEE.V2.5.1” is created. It contains the installation software for the 
Oracle Utilities Analytics Dashboard component.

Setting Permissions for the Cistab File in UNIX
Every Oracle Utilities Analytics environment installed on a server must be registered in the /etc/
cistab file located on that server. On UNIX servers, generally only the root user ID has the write 
permissions to the /etc directory. Since the installation process is run by the Oracle administrator 
User ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.5.1directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before 
continuing with the installation process. The script initializes the cistab file in /etc directory (if it is 
Demo Installation Procedure 7-124 
Oracle Utilities Analytics Installation Guide



the first Oracle Utilities Analytics application environment on the server) and registers a new 
environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Analytics 
administrator User ID so that the next time a new environment is created by the same Oracle 
Utilities Analytics Administrator User ID, you do not need to run the generated script with the 
root user ID. Instead, the install utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, take a backup prior to the installation process. 
The installation utility does not create a backup of the existing environment.

Oracle Utilities Analytics Demo Database Component Installation Dashboard 
Package Installation Steps

Before you install verify that the steps mentioned in Prerequisite Software for Oracle Utilities 
Analytics Dashboard Component are followed. 

To install the Oracle Utilities Analytics Dashboard package, perform these steps. 

1. Change the current directory to <TEMPDIR>/BI.OBIEE.V2.5.1.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl. It is required 
to run the installer.

3. Execute the following script: 
For UNIX: 
Perform the following steps: 

• export ORACLE_CLIENT_HOME=<oracle_client_home>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

       For Windows: 
       Perform the following steps: 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME>

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH%

• Run Install.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

4. The Oracle Utilities Analytics specific menu appears.

5. Select each Menu Item to configure the values. For the detailed description of the values, see 
the Configuration Worksheet for Dashboard Component Installation.

Environment Installation Options 

1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name:  
Web Java Home Directory: 
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Configure each item in the above list for successful installation. Choose any option from the menu 
item (1, 2 <P> Process, <X> Exit).

Note: For the detailed description of these values, see Configuration 
Worksheet for Dashboard Component Installation.

Note: All the schema names must be entered in the upper case.

Environment Configuration 

1. Environment Description 
Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home: 
Oracle BI Home: 
Oracle BI Domain Home: 
Weblogic Domain Console User Name: 
Weblogic Domain Console Host: 
Weblogic Domain Console Port Number

3. Target Database Details 
Target Database Name:   
Target Database Host:   
Target Database Port: 1521 
DWADM Schema Name: DWADM 
DWADM Schema Password:                            

Configure each item in the above list for a successful installation. Choose any option from the 
menu item (1, 2, 3 <P> Process, <X> Exit).

When you are finished with the parameter setup, proceed with option P. Write to the Configure 
file.

Once installation is successful, execute the post-installation steps as described in the section Post-
installation Tasks.

Post-installation Tasks
Following topics are discussed in this section: 

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Deploying the Write Back

• Enabling the Analytics Help

• Enabling the Auto Complete feature on Oracle Business Intelligence Enterprise 
Edition 11.1.7.1

Deploying the Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the Oracle Utilities Analytics Dashboard Package installation directory.

This RPD file should be copied to the Windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 is installed.

To deploy the RPD file, perform these steps:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should have been installed on the 
Windows machine before proceeding with the steps below.
Demo Installation Procedure 7-126 
Oracle Utilities Analytics Installation Guide



2. Launch the Administration Tool from the Start menu from the Windows machine. This is 
only available in the Windows.

Start > Programs > Oracle Business Intelligence > BI Administration.

3. Open the RPD in the offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.

5. Edit the connection pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM):

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following (only for MDM):

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password
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9. In the Materialized Views Connection group, enter the following:

 Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password

10. In the ODIDEV Connection Pool group, provide the following:

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following:

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

12. Click Save.

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the OBIEE Enterprise Manager console.

14. Navigate to BI Instance >Coreapplication>Deployment.

15. Lock and edit.

The repository text box is enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password “oracle123”. Click Apply.
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18. Activate the changes, and then restart the Oracle Utilities Analytics services.

Note: All the above-mentioned database sets in the connection pool should be 
updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/
Oracle_BI1/network/admin.

Deploying the Web Catalog
To deploy the catalogs, follow these steps:

1. Go to <Catalog location>/root/shared and delete the existing catalogs that were delivered 
out-of-box with the Oracle Utilities Analytics product in the previous release. Any catalog 
added by you can be retained.

2. Go to <Catalog location>/root/system, and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager. 

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see catalog location.

For Windows:

Perform the following steps: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the physical catalogs location configured in the Enterprise Manager.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

Configuring the MapViewer
To configure and deploy the MapViewer, perform the following steps: 

1. Update the mapViewerConfig file with below-mentioned tags:
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File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/mapviewer.ear/
web.war/WEB-INF/conf/

File: mapViewerConfig.xml

If there is proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,de.tiles.weatherbug.com
</proxy_enabled_hosts>

2. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

3. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

4. Add the below content with the appropriate values:

<map_data_source name="MAPCONN" jdbc_host="<DB_HOST>" 
jdbc_sid="<SID of the Database>" jdbc_port="<DB_PORT>" 
jdbc_user="DWADM"

jdbc_password="!<DWADM PASSWORD>" jdbc_mode="thin"
number_of_mappers="32" allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted.

Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1
For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:
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<LightWriteback>true</LightWriteback>

3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags: 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</

AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Write Back
To deploy Write Back, perform the following:

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. ksh ./deploywriteback.sh.

5. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

6. Click Denied:Authenticated User and select the permission Granted.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%/bin.

4. deploywriteback.cmd.

5. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

6. Click Denied:Authenticated User and select the permission Granted.

Enabling the Analytics Help
To enable the Analytics' help, follow these steps:

1. Download Oracle Utilities Analytics v2.5.1 User's Guide from the Oracle Software Delivery Cloud 
(https:// edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.1 User's Guide, change the name of the 
OUA_UserGuide_2.5.1.pdf file to OUASA Help.pdf. 
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle 
Utilities Analytics Dashboard Package installation directory.
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3. Run the following commands:

For UNIX:

• cd $SPLEBASE/bin.

• ksh ./deployanalyticsear.sh.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows:

• cd %SPLEBASE%/bin.

• deployanalyticsear.cmd.

• Enter the WebLogic Domain Console Password. For example, weblogic123.

4. Restart the Oracle Utilities Analytics core services.

5. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete feature on Oracle Business Intelligence Enter-
prise Edition 11.1.7.1

Perform the following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services.

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start, stop the admin server, managed 
server and opmn services.

2. Log into the Analytics: http://<Server>:<port>/analytics.

3. Click on the WebLogic User (top-right pane of page). 

4. From the drop-down menu, select My Account. 

5. Set the prompt Auto Complete to ON. and click OK.

Post-installation Checklist
After the installation, perform the following: 

1. Verify the install and deploy logs.

• Custom Mapviewer deploy logs:

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack logs:

<INSTALL_DIR>/logs/system/Writeback.log

2. Log into the Oracle Business Intelligence Enterprise Edition Analytics link that is 
pointing to the demo database. The dashboard displays the data with no errors.
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Chapter 8 
Configuring Your Applications

This chapter provides instructions for configuring additional applications for use with Oracle 
Utilities Analytics. It covers the following topics:

• Spatial Configuration

• Oracle Business Intelligence Enterprise Edition (OBIEE) Configuration

Spatial Configuration
This section contains information related to configuring Oracle Utilities Outage Analytics and 
how to set up the spatial data and its corresponding metadata. The mapping between the spatial 
columns and the dimensional columns, such as the State from the Address dimension is defined in 
the map metadata, which is available as a part of the WebCatalog. Using the spatial data and the 
map metadata, users can view the transactional data on the map view.

As an example, steps to setup the data for United States (US) are mentioned below:

• Installing US State Spatial Data

• Installing US City Spatial Data

• Installing US Zip Code Spatial Data

• Installing US County Spatial Data

• Configuring Oracle Utilities Network Management System Device Spatial Data

• Loading the Spatial Metadata

• Improving Performance by Prefetching the Map Tiles

Installing US State Spatial Data
The spatial data can be loaded from the various sources. One of the approaches is to use the world 
sample data given by NAVTEQ. There is a pointer to the dataset from the Oracle Utilities 
Analytic's OTN (Oracle Technology Network) page for downloading the partner data:

http://www.oracle.com/technetwork/database-options/spatialandgraph/downloads/index.html

There are various versions of the world sample dataset. These instructions assume that you are 
using the version with a world_sample2010.dmp file. If you have a different version, then these 
instructions may not work and you should refer to the README.txt included in the downloaded 
world_sample.zip file.

These instructions also assume that the sample data will be loaded into the DWADM schema, 
used for the data warehouse. If you want to follow the instructions in the world sample 
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ReadMe.txt file instead, then the data will be loaded into a WORLD_SAMPLE account and the 
steps will need to be changed to use that account instead of DWADM.

Use the following procedure to install the world sample data.

1. Create a work directory on your machine for the data and change directory to the new 
directory. For example: 

mkdir NAVTEQ 
cd NAVTEQ

2. Unzip the world_sample.zip file you downloaded to the new directory. For example: 

unzip world_sample.zip 

3. Connect to SQLPLUS using the DWADM, and remove the old tables (if present). For 
example: 

sqlplus dwadm/dwadm@database @cln_sample_data.sql 

4. Import the world sample dump file into the DWADM schema. For example: 

imp dwadm/dwadm@database file=world_sample2010.dmp 
 log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using 
the following Insert statements: 

sqlplus  dwadm/dwadm@database
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the States Spatial table by following the steps mentioned below. This assumes that the 
eLocation website is being used as the base map, for which the SRID (Spatial Reference 
System Identifier) is 54004. The SRID is a unique value used to identify the coordinate 
system used in a Geographic Information System (GIS) application. If some other base map 
is used, then the transform parameter specifies the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table q1_states54004 (

      feature_id number,
      feature_name varchar2(255),
      area_id number,
      name_langcode varchar2(35),
      feature_type varchar2(30),
      country_code_3 varchar2(5),
      geometry SDO_GEOMETRY,
      carto_id number(10,0));

The table name should be 'q1_states54004' irrespective of the coordinate system that is used, 
since the default themes in Oracle Utilities Analytics are based on this table. If you need to 
change the default theme, create a new theme with the new table as the base, and then use it 
for the maps.

7. Insert the state data into the newly created States table. Below is an example of insert 
statement to load USA state information to the States table assuming that the SRID is 54004. 

insert into q1_states54004
select null, name, null, lang_code, feature_type,

       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id

FROM wom_area
WHERE feature_type = 909996

  and iso_country_code = 'USA';
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8. Update the spatial metadata view to reflect the dimensional information for the areas. The 
parameters for the insert statement are table name, geometry column name, and X and Y 
boundaries (the latitude and the longitude) based on the data and the tolerance value. Here is 
an example: 

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_STATES54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

9. Create an index on the geometry column of the table. 

create index q1_STATES54004_sdx 
    on q1_STATES54004(geometry) 
    indextype is mdsys.spatial_index;

Installing US City Spatial Data
US City shape data is available in the world sample dataset, however, only the three hundred 
largest cities are available there. To find additional sample data for each US State from the US 
Census Bureau, visit and search within the Census site:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load city data for other US states.

1. Click the Ohio zip code in the Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip or decompress the pl39_d00_shp.zip file to the NAVTEQ directory. 

3. Download standalone MapBuilder from this location:  
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html 

4. Start MapBuilder. This is installed when MapViewer is installed. On windows it can be 
started by running:  
java -jar mapbuilder.jar 

Refer to the MapViewer documentation for instructions on installing and running 
MapBuilder from this location: 
http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html  

5. If a connection is not created, then select File -> New Connection, and create a connection 
to the DWADM schema in the Oracle Utilities Analytics Data Warehouse database. 

6. Select Tools -> Import Shapefile, and click Next. 

7. Click Shapefile. 

8. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open. 

9. Click Next. 

Note: Ensure that the name of the geometry table is set to pl39_d00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name. 

10. Ensure the Create Predefined Theme box is unchecked, and click Next. 
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11. Review the summary information and click Finish. 

12. Create the Q1_CITY54004 table to store all the required information related to cities using 
the following SQL statement. This assumes that the eLocation website is being used as the 
base map, for which the SRID is 54004. If some other base map is used, then the transform 
parameter will need to specify the SRID of the base map being used. However, the table 
name should remain the same as mentioned below.

sqlplus  dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From pl39_d00
Where lsad_trans in ( 'city', 'village' );

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_CITY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index Q1_CITY54004_sdx 
    on Q1_CITY54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: This fixes any problems with the input geometry and returns a valid 
geometry.

Installing US Zip Code Spatial Data
Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load zip code data for other US states.

1. Click the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 
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2. Unzip the zt39_d00_shp.zip file to the NAVTEQ directory. 

3. Start the MapBuilder. This is installed when MapViewer is installed. 

Refer to the MapViewer documentation for instructions on installing and 
running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM schema in the Oracle Utilities Analytics Data Warehouse database. 

5. Point Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Navigate to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to ZT39_D00. If this is not 
the desired name for the spatial table, then the Select statement below will need 
to be changed to use the entered name.  

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the summary information and click Finish. 

11. Create the Q1_USZIP54004 table for all the required postal codes using the following SQL 
statement. This assumes that the eLocation website is being used as the base map, for which 
the SRID is 54004. If some other base map is used, then the transform parameter will need to 
specify the SRID of the base map being used. However, the table name should remain the 
same as mentioned below.

sqlplus  dwadm/dwadm@database

create table q1_USZIP54004 as

select zcta ZCTA5CE,
       sdo_cs.transform(geometry, 54004) geom

From ZT39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_USZIP54004','GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_USZIP54004_sdx 
    on q1_USZIP54004 (geom) 
    indextype is mdsys.spatial_index;

UPDATE q1_uszip54004
  SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);

Installing US County Spatial Data
Sample shape files for US Counties can be found at the following location:

 http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load county data for other US states.

1. Click on the Ohio County in the Shapefile format and download the co39_d00_shp.zip file 
to the NAVTEQ directory created in the previous procedure. 

2. Unzip the co39_d00_shp.zip file to the NAVTEQ directory. 

3. Start the MapBuilder. This is installed when MapViewer is installed.
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Note: Refer to MapViewer documentation for instructions on installing and 
running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM schema in the Oracle Utilities Analytics Data Warehouse database. 

5. Select Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to CO39_D00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name.

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the summary information, and click Finish. 

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that 
the eLocation website is being used as the base map, for which the SRID is 54004. If some 
other base map is used, then the transform parameter will need to specify the SRID of the 
base map being used. However, the table name should remain the same as mentioned below.

sqlplus  dwadm/dwadm@database

create table q1_COUNTY54004 as
select name FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From CO39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_COUNTY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);
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create index q1_COUNTY54004_sdx 
    on q1_county54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_county54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: No predefined reports make use of the county data, so if county spatial 
reports are desired, the Q1_COUNTY_54004 theme will need to be used in 
new requests and maps.

Configuring Oracle Utilities Network Management System Device Spatial Data
To implement the Oracle Utilities Network Management System Network Model on the spatial 
analytics, Oracle Utilities Analytics reports need Oracle Utilities Network Management System 
geometry data. The steps from this section are required to view data in the spatial reports of 
Oracle Utilities Outage Analytics. There are several ways that the geometry data in the 
DIAGRAM_OBJECTS NMS device table can be accessed by the Oracle Utilities Analytics 
mapping reports. 

This section describes the following methods:

• Replicating the DIAGRAM_OBJECTS Table

• Accessing the Oracle Utilities Network Management System Spatial Data Using a 
Database Link

Replicating the DIAGRAM_OBJECTS Table
The easiest option is to replicate the DIAGRAM_OBJECTS table into the Oracle Utilities 
Analytics database. However, a suitable mechanism needs to be built to refresh this table with the 
latest data from Oracle Utilities Network Management System whenever there are changes in the 
model.

If this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps will 
setup the Oracle Utilities Analytics dashboards to use the data in this replicated table.

1. Create the required spatial metadata:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
        SDO_DIM_ELEMENT('X', -20037508, 20037508, .05),
        SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)
), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work 
without changes with the eLocation base map:

create index q1_DIAGRAM_OBJECTS_sdx 
    on diagram_objects (ll_geometry) 
    indextype is mdsys.spatial_index;

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow 
the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute "create 
table Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;"

2. INSERT INTO user_sdo_geom_metadata 
VALUES ( 'Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
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MDSYS.SDO_DIM_ARRAY(SDO_DIM_ELEMENT('X', -20037508, 20037508, 
.05),SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)), 54004);

3. Create index q1_DIAGRAM_OBJECTS_sdx_54004 on Q1_DIAGRAM_OBJECTS_54004 
(ll_geometry) indextype is mdsys.spatial_index;

Accessing the Oracle Utilities Network Management System Spatial Data 
Using a Database Link

If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing Oracle Utilities 
Network Management System geometry theme can be used, then it is possible to access the 
DIAGRAM_OBJECTS table in the Oracle Utilities Analytics database using a database link. 

To access the DIAGRAM_OBJECTS table in the Oracle Utilities Analytics database using a 
database link:

1. Create a database link in the Oracle Utilities Analytics database pointing to the Oracle Utilities 
Network Management System database.

2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the Oracle 
Utilities Network Management System database.

3. Update the mapViewerConfig.xml to add another datasource, pointing to the Oracle 
Utilities Network Management System database, just like the Oracle Utilities Analytics 
datasource was added earlier in the install documentation.

4. Restart WebLogic to make the Oracle Utilities Network Management System database 
available.

5. Create the required spatial metadata in the Oracle Utilities Analytics database:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
   MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
   MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
), 54004);

Loading the Spatial Metadata
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy the user_sdo.dmp file from ../BI251/
Spatial-Metadata folder to that location. 

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=  
   impdp_user_sdo.log  schemas=DWADM

remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server:

Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM has the quota. If the DWADM tablespace has quota on 
cists_01 tablespace, then exclude whole remap_tablespace clause from the 
command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run following SQL scripts from the ../BI251/Spatial-Metadata 
folder:
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 - sqlplus dwadm/<dwadm user password>@database-name 
@copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name 
@clean_sdo_release_tbls.sql

5. Review the log files.

Flushing the Map Cache
If there are any changes to the themes, styles or base maps, you must flush the map cache for the 
changes to reflect by following these steps:

1. In the MapViewer Console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. Click Management, select Manage MapViewer, and then select Datasources.

3. Click Purge cached metadata.

4. Delete the 'cacheduserinfo' files in the following path to remove any cache:

<OBIEE_INSTALL_DIR>\instances\instance2\bifoundation\OracleBIPresentationServi
cesComponent\coreapplication_obips1\catalog\SampleAppLite\root\users\weblogic2
\_prefs

5. To verify the map changes, go to the map zone that references the modified base map.

Improving Performance by Prefetching the Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this, you may consider 
prefetching tiles by issuing an admin request to MapViewer on a non-production server or when 
the server is not under load. When MapViewer receives a prefetching request, it issues many 
concurrent map tile requests to itself, which are basically XML map requests, and stores them in 
the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles. These instructions are for MapViewer 
11.1.1.7.1 version. If you are using a different version, refer to the MapViewer documentation for 
instructions. 

1. In the MapViewer console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. In the Admin Console page, click Management > Manage Map Tile Layers.

3. Select the required online map tile and click View map/Manage Tiles.
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The Prefetching wizard opens:

4. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click 
Show Map. 

To prefetch map images, enter the latitude and longitude values. You need to know the 
latitude and longitude values of the center of the location in interest. The SRID is a unique 
value used to identify the coordinate system used in a GIS application. 

The X and Y axis used in the following example is for Ohio:

5. When you see the map, turn on the Area Selection tool and select the area on the map for 
which you want to prefetch the tiles.

6. Select one or more zoom-levels for which you want to prefetch the tiles.

7. Under Tile Operations, click on Prefetch Tiles. Here is a snapshot of the area selection and 
the tile operation. 
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This process will take some time, depending upon the hardware configuration of the system and 
the amount of data to be prefetched. To check the current status of the operation, click Refresh 
under the Operation Status. The status will change to “Finished” when the operation is done.

Oracle Business Intelligence Enterprise Edition (OBIEE) Configu-
ration

This section contains information about configuring Oracle Business Intelligence Enterprise 
Edition (OBIEE) for use with Oracle Utilities Analytics. The following topics are discussed: 

• Setting Up and Configuring the User Security

• Managing Content in the Presentation Catalog

Setting Up and Configuring the User Security
Note: Refer to the Oracle Business Intelligence Enterprise Edition (OBIEE) 
documentation for details on configuring user security.

Managing Content in the Presentation Catalog
Oracle Utilities Analytics v2.5.1 Presentation Catalog has a different folder for each of the 
analytics.

The following folders are available on the Shared Folders:

• About

• Administration

• Common

• Credit & Collections Analytics

• Customer analytics

• Distribution Analytics
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• Meter Data Analytics

• Mobile Workforce Analytics

• Outage Analytics

• Revenue Analytics

• Shared Objects

• Work & Asset Analytics

• Operational Device Analytics

Note: For more information on User Security and Managing Catalog objects, 
refer to Oracle Business Intelligence Presentation Services Administration Guide.

Managing Folders and Content 
New folders can be created you if new answers or modifications to existing ones are needed.

To create new folders (or Development Folders), log onto the Presentation Services as an 
Administrator and access:

Catalog > New Folder

Once a new folder is created, set the following values:

• Properties

• Name 

• Delete

• Permissions

• Copy/Move

You can save new answers onto the development folders, thereby leaving the out-of-box folders as 
is. Once the answer is created, the report is written and the unit testing is complete, the request 
can be moved to the common folder.

The default folders are loaded during the install of Oracle Business Intelligence Enterprise 
Edition. These folders, such as 00 Overview, 01 Ranks & Toppers, or 02 History & Benching can 
be removed from view by navigating to catalog, and then deleting the dashboards that you do not 
want displayed from the list.

Editing Names and Descriptions of Objects 
To edit names and descriptions of objects, log on to the Presentation Services as an 
administrator and access the following:

Catalog > Shared Folders
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Chapter 9 
Installing the Oracle Utilities Analytics Admin 

Tool

Oracle Utilities Analytics Admin Tool is an Oracle Application Express (APEX) based 
configuration tool that can be used to configure Oracle Utilities Analytics.

This chapter describes how to install the Admin Tool for the Oracle Data Integrator (ODI) 
configuration and change the default password of the Admin user.

• Installing the Admin Tool

• Changing the Default Password of the Admin User

Installing the Admin Tool
Perform the steps mentioned below to install APEX run time and deploy the Admin Tool for 
Oracle Data Integrator configuration: 

If you have already installed the Admin Tool and upgrading to OUA 2.5.1.0.0, follow the below 
steps.

1. Download the patch 17966818 from My Oracle Support (http://support.oracle.com).

2. Copy it to the database server under …/<Temp> directory.

3. Unzip the file.

4. Change the current directory to ../<Temp>/patch.

5. Connect to the database as the sys user.

EXEC DBMS_XDB.SETHTTPPORT(0);
@apxpatch.sql
@apxldimg.sql    …/<Temp>/patch

6. Start the XML DB run:

EXEC DBMS_XDB.SETHTTPPORT(<not in use port>);
For example, EXEC DBMS_XDB.SETHTTPPORT(8080);

7. Restart the database.

8. Import the Admin Tool for Oracle Data Integrator configuration:

• Oracle Utilities Analytics V2.5.1ETL Component Based on ODI Multiplatform.zip file 
has a folder called AdminTool.

• Unzip this file and copy the AdminTool directory contents.

• Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory.
Installing the Oracle Utilities Analytics Admin Tool 9-145
Oracle Utilities Analytics Installation Guide



• Go to the ../AdminTool directory, i.e., cd ../AdminTool

• Connect as the system user and execute the following scripts:

• Import application:

• @DeployAdminApp.sql

• Deploy supporting objects:

• @DeploySupportingObjects.sql

If you are installing the Admin Tool from the scratch, follow the below steps.

1. Download apex_4.2.5.zip file from: 
http://www.oracle.com/technology/products/database/application_express/
download.html

2. Unzip apex_4.2.5.zip to the directory <APEX_UNZIPPEDPATH> and copy to the 
database server.

3. Change the directory to <APEX_UNZIPPEDPATH>/apex after unzipping apex_4.2.5.zip 
file.

4. Logon using sqlplus as the sys user and run the SQL file apxrtins.sql with the parameters as 
shown below:

@apxrtins <Tablespace Name for apex> <Tablespace Name for apex> 
<Temporary tablespace name> /i/

Note: If you are using 12C version of the database, run the apxremov.sql after 
connecting to the sys user before running the @apxrtins script.

5. Change the password of admin account by running the following SQL command: 

@apxchpwd

6. Restart the database.

7. Configure the embedded PL/SQL gateway. Logon as sys user and run. 

@apex_epg_config  <APEX_UNZIPPEDPATH>

8. Unlock the anonymous account: 

ALTER USER ANONYMOUS ACCOUNT UNLOCK;

9. Start the XML DB run:

EXEC DBMS_XDB.SETHTTPPORT(<not in use port>);

e.g EXEC DBMS_XDB.SETHTTPPORT(8080);

10. Verify using: 

SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

11. Import the Admin Tool for Oracle Data Integrator configuration:

• Oracle Utilities Analytics V2.5.1ETL Component Based on ODI Multiplatform.zip file 
has a folder called AdminTool.

• Unzip this file and copy the AdminTool directory contents.

• Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory.

• Go to the ../AdminTool directory, i.e., cd ../AdminTool

• Connect as the system user and execute the following scripts:
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• Create the workspace and configure the users: 

• @CreateAppWorkspace.sql

• Import application: 

• @DeployAdminApp.sql

• Deploy supporting objects:

• @DeploySupportingObjects.sql

12. The Admin Tool for Oracle Data Integrator configuration can be accessed using the URL 
http://<hostname>:8080/apex/f?p=104

The username to access the Admin Tool is Admin. The default password is 
Admin_123. 

Note: For a complete description of the Admin Tool, refer to Oracle Utilities 
Analytics Administration Guide.

Changing the Default Password of the Admin User
The following APEX API can be used to change the password of the admin user. This script 
should be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for the admin account 
before running the script. 

begin
  

wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_a
pplication_install.get_workspace_id,2090606133849294));

end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Important Note: It is strongly recommended that you should the default 
password after logging in.
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Appendix A
Data Warehouse Implementation Guidelines

This chapter provides guidelines for implementing the data warehouse setup for Oracle Utilities 
Analytics. 

The following sections are discussed in the detail:

• Init.ora Settings

• Oracle Partitioning

Init.ora Settings
Internal performance testing for a large Business Intelligence (BI) database installation has 
identified the following parameter settings that resulted in a fast load and materialized view refresh 
for a fact table with over 100,000,000 records.

Note: The settings mentioned in the below table were noticed for an Oracle 
10.2 database running on an IBM AIX 5.2 machine with 8 CPUs and 15 GB of 
memory; hence, some of these values may not apply for the different hardware 
or software settings.

Parameter Value

db_file_multiblock_read_count 32

db_cache_size 0M

shared_pool_size 0M

large_pool_size 0M

Java_pool_size 0M

parallel_max_servers 8

parallel_execution_message_size 65535

log_buffer 64554432

Pga_aggregate_target 2000M

session_cached_cursors 60

optimizer_index_caching 80

optimizer_index_cost_adj 30
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Oracle Partitioning
As the primary keys for all tables are sequential, it is possible to partition any table based on the 
primary key field. However, the fact tables should be partitioned based on one of the Date Keys 
present in the table. Some of the date keys are optional; hence, it is important to pick a date key 
field that will always have a non-zero value.

Note: As the Recent fact table needs to be purged daily, it does not require to 
be partitioned. Also, partitioning should be done only when materialized views 
do not prove sufficient enough to achieve the desired performance. 

For details on partitioning, refer to Oracle Utilities Analytics Administration Guide.

Sga_max_size 4000M

Sga_target 2000M

shared_pool_reserved_size 64M

workarea_size_policy AUTO

db_writer_processes 8

timed_statistics False

cursor_space_for_time True

Disk_asynch_io True

Parameter Value
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Appendix B
Installation Menu Functionality

This chapter provides the functionality details regarding the installation menu for installing Oracle 
Utilities Analytics application. 

The following sections are discussed here:

• Overview of the Installation Menu Functionality

• Details of the Installation Menu Functionality

Overview of the Installation Menu Functionality
The main configuration menu is structured so that the related variables and/or options are 
grouped together and are associated by a menu item number. To access a particular group of 
variables and options, enter the menu item number associated with that group. Each option within 
a group is displayed in turn on the page along with a prompt so that you can type the desired value 
for the option, if it is not the same as the default or current value.

When performing the initial installation, go through all the menu options. The menu options may 
have a default value, a list of the valid values, and a validation check.

On each option prompt, you can keep the current value by simply leaving the input line empty. In 
order to erase a variable value, enter a single dot ("."). The leading spaces are trimmed out on each 
values that are entered.

Note: While working with the menu, you will notice the following:

• Valid Values [ALFANUM]: This indicates to enter an alphanumeric value in the prompt.

• Valid Values [NUM]: This indicates to enter an numeric value in the prompt.

When all the menu options are set, type <P> at the main menu prompt option. The option values 
selected throughout the configuration are saved. 

During this processing, the global variables are validated and the configuration file 
<SPLEBASE>/etc/ENVIRON.INI is created or updated. This file contains all the entered and 
calculated variables. These are required by the next part of the installation process.

To exit the configuration utility without saving any of the values entered, type <X> and click 
Enter. 
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Details of the Installation Menu Functionality 
The Environment Installation Utility requires that Oracle Client Home is set in the path for the 
user performing the installation. Prior to running the installation utility, you must review the 
supported platforms document to ensure that you have all the required third-party software 
installed at your end. In the Installation menu if the variables are set prior to execution, then these 
variable values will be defaulted by the installation utility during installation.

When installation completes successfully, the values will be written to an ENVIRON.INI file. 
When splenviron.sh / cmd is executed, it reads from the ENVIRON.INI file to set the 
environment variables.

In the worksheets, there are three different types of values given:

• Default Values: Values, which can be defaulted while running the installation utility.

• Security Values: Values, which should be changed when in production.

• Example Values: Values, which can be used for a default installation.

Note: The production environment should not be run with default values.

Refer to Server Administration Guide for additional information about configuring these values.

When you enter passwords, you cannot see password characters on the screen as they are entered 
in the silent mode. The passwords are encrypted when the values are entered by a user.

Install the Oracle client software specified in the Chapter 3: System Requirements and 
Supported Platforms prior to running any installation utilities. 

The following prompt appears when executing the installation utility:

Enter Oracle Client Home Directory (<ENTER> quit):

Note: If the environmental variable ORACLE_CLIENT_HOME is set, then 
the install script validates the variable. If it passes the validation, you will not be 
prompted for it. This is needed in order to run Perl installation utilities.
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Appendix C
Installation and Configuration Worksheets

This chapter provides the installation and configuration worksheets for Oracle Utilities Analytics. 

The following topics are discussed: 

• Configuration Worksheet for ETL Component based on Oracle Warehouse Builder 
Installation

• Configuration Worksheet for ELT Component based on Oracle Data Integrator 
Installation

• Configuration Worksheet for Dashboard Component Installation

Configuration Worksheet for ETL Component based on Oracle 
Warehouse Builder Installation

The environment installation options are as shown below:

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client 
Home Directory

ORACLE_CLIENT_H 
OME

The home directory of the 
Oracle client. The 
application uses the Perl 
included under this Oracle 
client.

Example Location:
/oracle/client/product/
11.2.0.3
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Environment 
Mount Point

<SPLDIR> The mount point into 
which the application is 
installed. 
The local directory where 
the components are to be 
installed.

For example:
/OUA for UNIX and 
C:\OUA for Windows 

This mount point must 
exist and the 
Administrator User ID 
writes to this directory. 
(This is the user ID, 
created specifically to 
administer the 
environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory).

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount 
Point

<SPLDIROUT> A mount point that 
contains any application 
output or application logs. 

For example, the value is /
OUA/sploutput for 
UNIX installation or 
C:\OUA\sploutput for 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point
<SPLDIR> and an 
environment descriptor. 
This value typically 
identifies the purpose of 
the environment. 

For example, DEV01 or 
CONV

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value
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Environment Configuration Options
The following options are discussed in this section: 

• Environment Description

• Database Configuration

• Design Repository Configuration

• Database Character Set Configuration

• Editing Process Flow Configuration

• Email Configuration

• Control Center Configuration

• External Data Source Configuration

Environment Description

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Environment 
Description

DESC This is the text field 
to describe the 
purpose of the 
environment.

Database Configuration

Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is installed. 

For example,
$ORACLE_BI_HOME/
jdk

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

OWB WorkSpace 
Owner

OWB_WS_OWNER Oracle Warehouse Builder 
workspace owner created 
in the section Creating 
and Configuring the 
Oracle Warehouse 
Builder Workspace.

BIREPOWN
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Design Repository Configuration

OWB WorkSpace 
Owner Password

OWB_WS_OWNER_
PASS

Oracle Warehouse Builder 
workspace owner 
password created in the 
section Creating and 
Configuring the Oracle 
Warehouse Builder 
Workspace.

The password to login to 
Oracle Warehouse Builder 
design center.

This is a security value.

BIREPOWN 
user password

Database Name OBIEE_DBNAME The name of the database 
instance that the 
application is connecting 
to.

BI Database 
Name

Database Server OBIEE_DBSERVER The host name of the 
server where the database 
resides.

BI Database 
Server

Database Port OBIEE_DBPORT The database port number 
on the database server 
used for connecting to the 
database.

BI Database 
PORT

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

OWB WorkSpace 
User

OWB_WS_USER Oracle Warehouse Builder 
workspace user created in the 
section Creating and 
Configuring the Oracle 
Warehouse Builder 
Workspace.

The User to login to Oracle 
Warehouse Builder Design 
Control Center.

BIREPO
Installation and Configuration Worksheets C-4 
Oracle Utilities Analytics Installation Guide



Database Character Set Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Database Character set DBCS The database character 
set to used to create the 
database.

AL32UTF8

OWB Workspace 
user Password

OWB_WS_PASS Oracle Warehouse Builder 
workspace User Password 
created in the section 
Creating and Configuring 
the Oracle Warehouse 
Builder Workspace.

The password to login to 
Oracle Warehouse Builder 
Design Control Center.

This is a security value.

BIREPO user 
password

OWB WorkSpace 
Name

OWB_WS_NAM
E

The name of the workspace 
created using the Repository 
Assistant.

SPLBIREP

DWADM 
SCHEMA NAME

DWADM_SCHE
MA

The user ID to register 
Oracle Warehouse Builder 
locations.

DWADM

DWADM 
SCHEMA 
Password

DWADM_PASS The password to register 
Oracle Warehouse Builder 
locations.

DWADM user 
password

WORKFLOW 
MANAGER 
SCHEMA NAME

OWFMGR_SCHE
MA

The user ID to register 
Oracle Warehouse Builder 
locations.

OWFMGR

WORKFLOW 
MANAGER 
SCHEMA 
Password

OWFMGR_PASS The password to register 
Oracle Warehouse Builder 
locations.

OWFMGR 
user password

Menu Option Name Used In 
Documentation Usage Customer 

Install Value
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Editing Process Flow Configuration

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Repository Operating 
System

REPOPSYS The database operating 
system. 

For example, Win or 
Linux (any other 
platform)

The valid values are as 
listed: 
Win: windows
Linux: for any non 
windows platforms

Perl Compiler location PERLCMD The Perl compiler set in 
the database. 

For example:
/usr/bin/perl

<ORACLE
_HOME>
/perl/bin/
perl

Data and control files 
location

CTLFOLDER The data and the control 
file extracts location, 
where the flat files 
placed to pickup by the 
file processor.

For example: user 
location

Separator to be used FILESEP The separator to be used 
for Oracle Warehouse 
Builder deployment, 
where the database 
resides.

For example: For 
Windows \\ and for 
Linux /

For Unix: 
Use 
forward 
slash (/)

For 
Windows: 
Use 
backslashes 
(\\)

File Manager location FILEMGR The File Manager 
location on the database 
server. Copy the 
splfilemanager.plx file 
from the BI251/Scripts 
directory to this 
location.
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Email Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Email ID of Sender EMAILIDSEN The Email ID of the 
sender to be configured in 
Oracle Warehouse Builder 
in the deployment

For example: 
OWB@oracle.com

Email ID for Reply-
To address

EMAILIDRPL The Email ID of the Reply 
TO to be configured in 
Oracle Warehouse Builder 
in the deployment.

Email ID of 
Receiver

EMAILIDREC The Email ID of the 
receiver to be configured 
in Oracle Warehouse 
Builder while in 
deployment.

SMTP server SMTPSRV The host name of the 
server where the SMTP 
service configured.

SMTP server port SMTPPORT The port number on the 
server where the SMTP 
service configured.

Control Center Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Repository 
Control Center 
Name

CCNAME The Oracle Warehouse 
Builder Repository Control 
Center to be created or used 
to deploy the Oracle 
Warehouse Builder objects.

External Data Source Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Path of the External 
Datasource

EXTERNAMEDS The path of the 
extracts location.

Must be the same as 
the value of 'data 
and control files 
location'.
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Configuration Worksheet for ELT Component based on Oracle 
Data Integrator Installation

Environment installation options are as shown in the section below:

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

Path of the External 
Datasource LOG

EXTERNAMEDS_
LOG

The path of the 
extracts log location.

Must be same as the 
value of 'Data and 
control files 
location'.

File Processor 
Daemon Execution 
Switch

FPDEXECUTION
_SWITH

The file processor 
execution switch.

1

File Processor 
Extract Max Load

FPDEXTRACT_M
AXLOAD

The file processor 
to pick up the 
extractor to load.

5

File Processor 
Scheduler Poll 
Duration

SCHEDULER_PO
LL_DURATION

The file processor 
scheduler poll 
duration.

60

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Menu Option Name Used in 
Documentation Usage Customer 

Install Value

Oracle Client 
Home Directory

ORACLE_CLIEN
T_HOME

The home directory of the 
Oracle client. The application 
uses the Perl included under 
this Oracle client. The user 
used to install the Oracle client 
should be used to install ELT 
component based on Oracle 
Data Integrator.
Example Location: 
/oracle/client/product/
11.2.0.3
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Environment Configuration Options
The Following options are discussed in this section: 

• Environment Description

• Oracle Data Integrator Environment Configuration

• Oracle Data Integrator Agent Configuration

• Target GoldenGate Configuration

• Source GoldenGate Configuration

Environment 
Mount Point

<SPLDIR> The mount point into which 
the application is installed.
The local directory where 
components to be installed.
For example:/OUA for UNIX 
and C:\OUA for Windows
This mount point must exist 
and the administrator user ID 
writes to this directory. (This is 
the user ID, created specifically 
to administer the 
environments; the installation 
sets permissions on all the 
subdirectories installed under 
this directory.
See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log Files Mount 
Point

<SPLDIROUT> A mount point that contains 
any application output or 
application logs.
For example, the value is / 
OUA/sploutput for the UNIX 
installation, or 
C:\OUA\sploutput for the 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be used 
as both a directory name under 
the mount point 
<SPLDIR> and an 
environment descriptor. This 
value typically identifies the 
purpose of the environment. 
For example, DEV01 or 
CONV

Web Java Home
Directory

JAVA_HOME The location on the disk where 
Java 1.6 is installed.
For example: 
$ORACLE_BI_HOME/jdk

Menu Option Name Used in 
Documentation Usage Customer 

Install Value
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Environment Description
Environment description details are as shown in the table below:

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Environment 
Description

DESC This is a free form text field to 
describe the purpose of the 
environment.

Oracle Data Integrator Environment Configuration
Oracle Data Integrator environment configuration details are as shown in the table below:

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

WEBLOGIC 
HOME

WLS_HOME The directory where 
WebLogic to be used for 
Oracle Data Integrator 
has been installed.
For example: 
/WLS_HOME/ 
wlserver_10.3

ODI HOME ODI_HOME The directory where 
Oracle Data Integrator 
(ODI) has been installed.

ODI 
SUPERVISOR  
USER

ODI_SUP_USER For example:  
/WLS_HOME/
Oracle_DI1

SUPERVISOR

 ODI 
SUPERVISOR 
Password

                 
ODI_SUP_PASS
WORD

Oracle Data Integrator 
Supervisor password.

SUPERVISOR 
user password

Target Database 
Name

OBIEE_DBNAM
E

The name of the database 
instance from which the 
application connects to. 

Target Database 
Host

OBIEE_DBSERV
ER

The host name of the 
server where the database 
resides.

Target Database 
Port

OBIEE_DBPOR
T

The database port 
number on the database 
server used for 
connecting to the 
database.

DWADM Schema 
Name

DWADM_SCHE
MA

The target schema user 
for the facts and the 
dimensions present.

DWADM

DWADM Schema 
Password

DWADM_PASS The password for 
DWADM.

DWADM user 
password
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Oracle Data Integrator Agent Configuration

ODI Master 
Schema Name

ODI_MASTER 
_SCHEMA

The Oracle Data 
Integrator Master 
Schema user where the 
Oracle Data Integrator 
master repository is 
created. 

MASTER_REPO

ODI Master 
Schema Password

ODI_MASTER_ 
SCHEMA_PASS

The Oracle Data 
Integrator Master 
Schema user password. 

MASTER_REPO 
user password

ODI Work Schema 
Name

ODI_WORK 
_SCHEMA

The Oracle Data 
Integrator Work Schema 
User where the Oracle 
Data Integrator Work 
Repository is getting 
created.
The default WORK 
REPO is OBIU.

WORK_REPO

ODI Work Schema 
Password

ODI_WORK_ 
SCHEMA_PASS

Oracle Data Integrator 
Work Schema User 
Password

WORK_REPO 
user password

ODI Master 
Repository ID

ODI_MASTER_R
EPO_ID

Oracle Data Integrator 
Master Repository ID
The default value is 601.

ODI Work 
Repository ID

ODI_WORK_RE
PO_ID

Oracle Data Integrator 
Work Repository ID
The default value is 602.

MDADM Schema 
Name

MDADM_SCHE
MA

The metadata user MDADM

MDADM Schema 
Password

MDADM_Pass The password for 
MDADM

MDADM user 
password

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

ODI 
WebLogic   
Agent Host

ODI_AGENT_HOST The host on which 
Oracle Data Integrator 
WebLogic Domain is 
created.

Database host 
name
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Target GoldenGate Configuration

ODI 
WebLogic 
Agent port

ODI_AGENT_PORT The port on which 
Oracle Data Integrator 
WebLogic agent is 
configured to run. This 
is the port of Oracle 
Data Integrator 
WebLogic Managed 
Server Port. 

Provide available 
port and make 
sure to use the 
same port while 
creating Oracle 
Data Integrator 
managed server.

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Target 
GoldenGate 
Manager Port

TRG_GG_MGR_PORT The port number 
on which Oracle 
GoldenGate 
Manager is 
running on the 
target database 
server.

Target 
GoldenGate 
Dynamic 
Minimum Port

TRG_GG_DYN_PORT_M
IN

This is the 
dynamic minimum 
port configured in 
Oracle 
GoldenGate on 
the target database 
server.

Provide the start 
range value set for 
the target 
GoldenGate 
manager process.

Target 
GoldenGate 
Dynamic 
Maximum 
Port.

TRG_GG_DYN_PORT_M
AX

This is the 
dynamic maximum 
port configured in 
Oracle 
GoldenGate on 
the target database 
server.

Provide the end 
range value set for 
the target 
GoldenGate 
manager process.

Target 
GoldenGate 
Algorithm

TRG_GG_ALGORITHM This is the 
algorithm 
configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 1. 
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Target 
GoldenGate 
Encryptkey

TRG_GG_ENCRYPTKEY This is the Encrypt 
Key configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 
“DEFAULT”.

Target 
GoldenGate 
Shared Secret

TRG_GG_ 
SHARED_SECRET

This is shared 
secret key 
configured in 
Oracle 
GoldenGate on 
the target database 
server. The default 
value is 
"DEFAULT”.

Go to the Oracle 
GoldenGate prompt 
and run the 
command: encrypt 
password <password 
of MDADM user>, 
encryptkey 
DEFAULT 
Provide the result of 
above command to 
this menu item.

Target 
Database 
Home

TRG_DB_HOME This database 
home is installed 
location on the 
target database 
server.
For example: 
/u00/oracle/app/
oracle/product/
11.2.0/dbhome_1 

Target 
GoldenGate 
Home

TRG_GG_HOME This is the Oracle 
GoldenGate 
installed location 
on the target 
database server.
For example:  
opt/local/
ggs_12.1.2.0.0

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value
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Source GoldenGate Configuration

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Source 
Instance 
Name

SRC_INST_NAME The source from 
which the data has 
to be extracted.

The valid values 
are 
ODM1,ODM2...O
DM9 for Oracle 
Utilities 
Operational 
Device 
Management 
application 
 
CCB1,CCB2...CC
B9 for Oracle 
Utilities Customer 
Care and Billing 
source application. 

NMS1,NMS2...N
MS9 for Oracle 
Utilities Network 
Management 
System source 
application. 

Provide the same 
value that is passed 
to -c option while 
running 
configureSourcedb 
script.

Source 
GoldenGate 
Manager Port

SRC_GG_MGR_PORT The port number 
on which Oracle 
GoldenGate 
Manager is 
running on the 
source database 
server.

Source 
GoldenGate 
Dynamic 
Minimum Port

SRC_GG_DYN_PORT_M
IN

This is the 
dynamic minimum 
port configured in 
Oracle 
GoldenGate on 
the source 
database server.

Provide the start 
range value set for 
the source 
GoldenGate 
manager process.
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Source 
GoldenGate 
Dynamic 
Maximum 
Port.

SRC_GG_DYN_MAX_PO
RT

This is the 
dynamic maximum 
port configured in 
Oracle 
GoldenGate on 
the source 
database server.

Provide the end 
range value set for 
the source 
GoldenGate 
manager process.

Source 
GoldenGate 
Algorithm

SRC_GG_ALGORITHM This is the 
algorithm 
configured in 
Oracle 
GoldenGate on 
the source 
database server. 
The default value 
is 1. 

Source 
GoldenGate 
Encryptkey

SRC_GG_ENCRYPTKEY This is the Encrypt 
Key configured in 
Oracle 
GoldenGate on 
the source 
database server. 
The default value 
is “DEFAULT”.

Source 
GoldenGate 
Shared Secret

SRC_GG_ 
SHARED_SECRET

This is the shared 
secret key 
configured in 
Oracle 
GoldenGate on 
the source 
database server. 
The default value 
is “DEFAULT”.

Go to the Oracle 
GoldenGate 
prompt and run 
the command: 
encrypt password 
<password of 
source golden gate 
owner user>, 
encryptkey 
DEFAULT 
Provide the result 
of above 
command to this 
menu item.

Source 
Database 
Name

SRC_DB_NAME This is the source 
database name, 
where Oracle Data 
Integrator 
connects to reverse 
engineer the 
source tables.

Source 
Database Host

SRC_DB_HOST This is source 
database server 
host.

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value
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Configuration Worksheet for Dashboard Component Installation
The following topics are included here: 

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

Source 
Database Port

SRC_DB_PORT This is source 
database port.

Source 
Database 
Home

SRC_GG_DB_HOME This is the source 
database home 
installed location.

Source 
GoldenGate 
Home

SRC_GG_HOME This is the Oracle 
GoldenGate 
installed location.

Menu Option Name Used in 
Documentation

Usage  Customer Install 
Value

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client 
Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of the 
Oracle client. The application 
uses the Perl included under this 
Oracle client.

Example location:
<ORACLE_BI_HOME>/
Oracle_BI1
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Environment 
Mount Point

<SPLDIR> The mount point into which the 
application is installed. 

For example:
/OUA for UNIX and C:\OUA 
for Windows 

This mount point must exist 
and the administrator user ID 
writes to this directory. (This is 
the user ID, created specifically 
to administer the environments; 
the installation sets permissions 
on all subdirectories installed 
under this directory).

See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log File 
Mount Point

<SPLDIROUT> A mount point contains any 
application output or 
application logs. 

For example, the value is /
OUA/sploutput for UNIX 
installation or 
C:\OUA\sploutput for 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be used 
as both a directory name under 
the mount point <SPLDIR> 
and an environment descriptor. 
This value typically identifies the 
purpose of the environment. 

For example, DEV01 or CONV

Web Java 
Home 
Directory

JAVA_HOME The location on the disk where 
Java 1.6 is installed. 

For example:
$ORACLE_BI_HOME/jdk

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value
Installation and Configuration Worksheets C-17 
Oracle Utilities Analytics Installation Guide



Environment Configuration Options 

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value

Oracle BI 
Instance Home

ORACLE_INSTANCE The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
instance home.

Example location for Oracle 
Database:
/orasw/Middleware/
instances/instance1

Oracle BI Home ORACLE_BI_HOME The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
Oracle_BI Home.

Example location for Oracle 
Database:
/orasw/Middleware/ 
Oracle_BI1

Oracle BI 
Domain Home

DOMAIN_HOME The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed 
Oracle_BI home.

Example location for Oracle 
Domain home:
/orasw/Middleware/ 
user_projects/domains/ 
bifoundation_domain

WebLogic 
Domain Console 
User Name

WLS_EM_USER WebLogic domain login user 
name.

You will be prompted for the 
password after installation.

WebLogic 
Domain Console 
Host

WLS_EM_HOST The host name on which the 
web application server resides.

Default value: <current server 
name>
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Target Database Details
The target database details are as listed in the below table: 

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Target Database Name OBIEE_DBNAME The name of the target 
database

Target Database Host OBIEE_DBSERVER The host on which 
database is created.

Target Database Port OBIEE_DBPORT This is the target 
database port.

DWADM Schema 
Name

DWADM_SCHEMA The schema name of 
the star schema.

DWADM

DWADM Schema 
Password

DWADM_PASS The password for 
DWADM

DWADM 
user 
password

WebLogic 
Domain Console 
Port Number

WLS_EM_PORT A unique port number within 
the system that is assigned to 
the HTTP port. This is the 
port number that is used as a 
part of the client URL request 
to connect to the host.
This is Oracle Business 
Intelligence Enterprise 
Edition WebLogic console 
admin port number.

Example value: 7001

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value
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Appendix D
Additional Resources

Contacting Oracle Support
To contact Oracle support, visit the Oracle Support website at:

http://www.oracle.com/support/index.html



Appendix E
Installing the NMS Business Intelligence 

Publisher Reports

This section describes the steps to be performed while installing the Oracle Utilities Analytics 
NMS IEEE outage reports:

1. Unzip the IEEE outage reports contained in OUA NMS BI Publisher reports.zip from the 
installation media to a temporary directory (ex. TEMPDIR) on the server where Oracle BI 
Publiser is installed.

2. Log into Oracle BI Publisher (http://<BI Publisher server name>:9704/xmlpserver/) as the 
Administrator from a browser that has access to the TEMPDIR folder from the step 1. 

3. Set up a database connection as follows:

a. Navigate to Oracle BI Publisher Administration > Data Sources > JDBC 
Connection.

b. Click Add Data Source.

c. In the Data Source Name field, enter NMS BI Publisher or a name of your choice.

d. Set the Driver Type to Oracle 9i/10g/11g. 

e. Set the Database Driver Class to oracle.jdbc.OracleDriver. 

f. Set the Connection string to:jdbc:oracle:thin:@<your machine>:<Port>:<the 
ORACLE_SID> 

g. Set the username and password to match your Oracle Utilities Analytics database login 
values. 

h. Click Test Connection and verify that it is properly configured. 

i. Click Apply. 

4. From the BI Publisher Catalog page, select Shared Folders from the folders tree. 

5. On top of the folders section, click the New drop-down list and select Folder from the list.

6. Enter NMS IEEE Reports as the folder name (or a name of your choice), then click Create. 
The new folder is added. You may have to click Refresh button to update the Folders list.

7. Select the NMS IEEE Reports folder in the folder list. 
Under the NMS IEEE Reports folder, create another new folder named NMS IEEE Data 
Models.

8. Select the NMS IEEE Data Models directory, and then click Upload in the Tasks section 
on the bottom left.
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a. Browse to the directory where the NMS IEEE BI Publisher reports exist (TEMPDIR 
from step 1).

b. Locate all of the data model files and upload them to the NMS IEEE Data Models 
directory. These files contain an extension of .xdmz and include the following files:

• CriticalCustomerOutages.xdmz

• DailyTroubleReport.xdmz

• DeviceOutageHistory.xdmz

• IEEEIndiceCalculations.xdmz

• IndicesByCity.xdmz

• OutageSummary.dxmz

• RecurringDeviceOutages.xdmz

• SustainedOutagesByCauseSummary.xdmz

• SustainedOutageSummary.xdmz

9. Select the NMS IEEE Reports directory, and then click Upload in the Tasks section on 
the bottom left

a. Browse to the directory where the OUA NMS IEEE BI Publisher reports exist 
(TEMPDIR from step 1). 

b. Locate all of the report files and upload them to the NMS IEEE Reports directory. 
These files contain an extension of .xdoz and include the following files:

• CriticalCustomerOutages.xdoz

• DailyTroubleReport.xdoz

• DeviceOutageHistory.xdoz

• IEEEIndiceCalculations.xdoz

• IndicesByCity.xdoz

• OutageSummary.xdoz

• RecurringDeviceOutages.xdoz

• SustainedOutagesByCauseSummary.xdoz

• SustainedOutageSummary.xdoz

10. Assign the appropriate JDBC connection to the imported data models.

a. Click Catalog. 

b. Select the NMS IEEE Data Models directory, and then select the 
CriticalCustomerOutages.xdmz data model.

c. Click Data Model on the top left. 

d. In the Properties frame on the right, make sure that Default Data Source points to the 
data source you created earlier. This defaults to NMS BI Publisher.

e. You must perform this step for all of the data models under the NMS IEEE Data 
Models directory.

11. Assign the appropriate data model to all the NMS IEEE Reports.

a. Click on Catalog. 

b. Select the NMS IEEE Reports directory, select the CriticalCustomerOutages.xdoz 
report and click Edit below the report.
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c. At the top left of the page, click Search.

d. Browse and select the appropriate data model file (will match the name of the report with 
an extension of .xdmz).

e. Save the current report by clicking Save on the top-right of the page.

You should now be able view the standard IEEE indices reports from BI Publisher by simply 
selecting the desired report from the NMS IEEE Reports directory under the Catalog.
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Appendix F
Installing Oracle Utilities Analyics 2.5.1 on 
Oracle Database 12c Pluggable Database

This chapter describes the additional steps to be performed while installing Oracle Utilities 
Analytics 2.5.1 on an Oracle Database 12c pluggable database.

When using a 12c pluggable database as the source, follow the below source side Oracle 
GoldenGate configuration steps instead of the step number 13 provided in the section Setting up 
Oracle GoldenGate on the Source Database Server:

Note: The other steps in the section Setting up Oracle GoldenGate on the 
Source Database Server remain the same for the pluggable databases.

1. Create the tablespace in all the pluggable database with the same name and make sure that 
this tablespace is not assigned to any user.

2. Connect to the root (container database) and create the Oracle GoldenGate owner with 
command.  
For example: 

 CREATE USER c##CCB01SRC
 IDENTIFIED BY <password>
 DEFAULT TABLESPACE <ggowner tablespace>
 CONTAINER = ALL;

3. Set the set streams_pool_size parameter in the database.

4. Connect to the required PDB. 
For example, alter session set container=CCBI24DE

5. Grant the connect, resource and dba privileges to the Oracle GoldenGate owner: 
For example, grant connect,resource,dba to c##CCB01SRC;



Appendix G
License and Copyright Notices

This chapter describes about licensing and optional features, including:

• Oracle Warehouse Builder Licensing and Optional Features

• Oracle Warehouse Builder Licensing and Optional Features

• Disabling the Optional Features in Oracle Warehouse Builder

• Oracle GoldenGate Licensing

Oracle Database Licensing and Optional Features
With Oracle Utilities Analytics release v2.5.1, the Standard Edition of Oracle database is now 
supported. Currently, this support is only for the customers using those Extractors and Schema 
products, which are based on Oracle Data Integrator (ODI) based extraction, and includes:

• Oracle Utilities Operational Device Management Extractors and Schema

• Oracle Utilities Customer Care and Billing Extractors and Schema

However, Oracle recommends to use the Enterprise Edition of the Oracle database for 
performance and scalability reasons, as the Oracle Utilities Analytics data warehouse is expected to 
handle large volumes of data. Oracle Utilities Analytics also supports the Oracle Partitioning 
feature, which is an extra cost option on the top of the Oracle Database Enterprise Edition. Using 
this feature, it is also recommended for the efficient data storage and retrieval by the Oracle 
Utilities Analytics product.

By default, the Enterprise Edition and the Partitioning features are turned off in the Oracle 
Utilities Analytics product. Once the appropriate licenses have been purchased, these features can 
be turned on in the Global Configuration settings using the Oracle Utilities Analytics 
Administration Tool described in the Appendix B of Oracle Utilities Analytics Administration Guide.

Oracle Warehouse Builder Licensing and Optional Features
Oracle Warehouse Builder (OWB) provides various optional features, which are not included in 
the basic Extraction, Transformation, and Loading (ETL) feature group. The basic ETL feature 
group is included in the Oracle Database Enterprise Edition license. Hence, there is no additional 
license cost required to use, or install the basic features. The standard ETL processes included in 
Oracle Utilities Analytics (OUA) uses only the features that are included in the basic ETL feature 
group.

In addition, the Oracle Warehouse Builder Code Generator does not create any code that requires 
the use of optional Oracle Warehouse Builder features. Hence, any additional Extraction, 
Transformation, and Loading (ETL) code created by an implementation using the Oracle 
Warehouse Builder Code Generator does not require any additional Oracle Warehouse Builder 
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license costs. However, if Oracle Warehouse Builder is used to create other ETL code outside of 
the Oracle Warehouse Builder Code Generator, then using some of these optional features may 
require additional Oracle Warehouse Builder licenses. 

Disabling the Optional Features in Oracle Warehouse Builder
In order to ensure that optional features are not used, Oracle Warehouse Builder (OWB) provides 
a means to disable the use of optional features. After starting the Warehouse Builder Repository 
Assistant, choose the “Manage optional features” operation, as shown in the following 
screenshot.

After entering the password for the OWBSYS user, deselect all of the licensed option names on 
the Enable Optional Features page.
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Once the options are deselected, the new selections will take effect for any new connections to 
Oracle Warehouse Builder, and if options are used that are not available, an error dialog is 
displayed. 

Note: For further details regarding the feature groups and licensing of Oracle 
Warehouse Builder, visit the Oracle Warehouse Builder page on the Oracle 
Technology Network (OTN) at this location: 

http://www.oracle.com/technetwork/developer-tools/warehouse

Oracle GoldenGate Licensing
The Oracle GoldenGate license purchased along with Oracle Utilities Analytics v2.5.1, can be 
used to replicate additional tables from the any of the source systems products whose ELT 
processes are based on Oracle Data Integrator (ODI), which includes:

• Oracle Utilities Operational Device Management

• Oracle Utilities Customer Care and Billing

For any other usage of the Oracle GoldenGate product, purchase a full license of the Oracle 
GoldenGate product. Contact Oracle Support for the details.
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